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1. Integrating Xpedition and PADS with
Teamcenter
Teamcenter Electronic Design Automation (EDA) integrates Siemens EDA ECAD applications with
Teamcenter so that ECAD designers can move design data into and out of Teamcenter and manage
the ECAD part library data in Teamcenter.

Teamcenter supports two types of EDA integrations:

• ECAD design integration

The Teamcenter EDA integration with Xpedition and PADS for design management enables ECAD
designers to manage ECAD design data in Teamcenter.

• ECAD part library integration

The Teamcenter EDA integration with Xpedition and PADS for part library management enables ECAD
designers and librarians to manage all the parts and part attributes in the ECAD libraries, as well as
manage the relationships between these objects. Teamcenter library data can be synchronized with
each individual ECAD tool’s local library on the workstation so that design team is up to date.

For the ECAD designers and library managers to work with the ECAD design and library parts, you as an
administrator must integrate Xpedition and PADS with Teamcenter by:

• Installing and setting up Teamcenter with Xpedition or PADs for design management.

• Installing and setting up Teamcenter with EDM for design management.

• Installing and setting up Teamcenter with Xpedition or PADS or EDM for part library management.
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Where do I go from here?

 ECAD Designer See Managing Xpedition or PADS Designs in
Teamcenter for instructions on how to manage
ECAD designs in Teamcenter.

 Library Administrator See Managing Xpedition or PADS Part Library in
Teamcenter for instructions on how to manage
ECAD part library data in Teamcenter.

 Administrator

How do I install and set up design integration
for Xpedition and PADS with Teamcenter?

Planning your deployment for design
management has information about the
appropriate components that must be installed
on the server (Teamcenter) and client machines
(ECAD workstation - Xpedition or PADS).

See the workflow for guidance on the steps to
integrate Xpedition and PADS with Teamcenter
for design management.

How do I install and set up design integration
for EDM with Teamcenter?

Planning your deployment for EDM design
management has information about the
appropriate components that must be installed
on the server (Teamcenter) and client machines
(ECAD workstation - Xpedition EDM).

1. Integrating Xpedition and PADS with Teamcenter
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See the workflow for guidance on the steps to
integrate Xpedition and PADS with Teamcenter
for EDM design management.

How do I install and set up library integration for
Xpedition, EDM, and PADS with Teamcenter?

Planning your deployment for part library
management has information about the
appropriate components that must be installed
on the server (Teamcenter) and client machines
(ECAD workstation - Xpedition or PADS).

See the workflow for guidance on the steps to
integrate Xpedition and PADS with Teamcenter
for part library management.

How can I perform additional customizations in
the EDA client operations for design and part
library integrations?

See Callbacks in Teamcenter EDA and
Teamcenter EDA Schema ─ Reference
documentation for information on additional
customizations.

Additionally, to customize the connector
integrations, refer to the Teamcenter EDA
Design Connector Integration ─ Reference,
Teamcenter EDA Library Connector Integration
─ Reference, and Teamcenter Gateway for EDA
Integration ─ Reference.

Where can I get a list of preferences that I need
to set for design and part library integrations?

There are several sources from which you can
retrieve a list of preferences. You can view the
list in Administration data report, Teamcenter
rich client, Teamcenter Active Workspace, and
raw XML file.

How do I install and configure the EDA Gateway
for (non-Siemens EDA) ECAD applications?

See the documentation on Teamcenter
EDA Gateway for (Non-Siemens EDA) ECAD
Applications.
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2. Teamcenter EDA architecture
The components of Teamcenter EDA and their interactions for design management and part library
management with ECAD tool, for example, Xpedition, are as follows:

The components of Teamcenter EDA and their interactions for design management and part library
management with ECAD tool, for example, EDM, are as follows:
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3. Integrating Xpedition or PADS or PADS
Professional with Teamcenter EDA for
design management
Planning your deployment for design management

For installing and integrating Teamcenter EDA with Xpedition or PADS or PADS Professional for design
management, you must plan your deployment and your environment setup. You can install the
Teamcenter EDA server and client components through Deployment Center or through TEM.

As an administrator, you must install the appropriate components on the server (Teamcenter) and client
machines (ECAD workstation) as per the site requirements as mentioned below:

Server components Requirements

Teamcenter server Teamcenter server is used to store and track the ECAD designs.

For information about the versions of operating systems, third-
party software, and Teamcenter software configurations that
are certified for the EDA platform, refer to the Hardware and
Software Certifications knowledge base article on Support
Center.

If you have an existing Teamcenter environment, you can
update it to support the latest EDA version.

Ensure that you download the compatible versions from
Support Center before starting your deployment.

EDA server support EDA server support is required to add ECAD data model to
the Teamcenter server environment. You must add EDA server
support on top of the Teamcenter environment.

As the EDA client is supported in a four-tier architecture, the
EDA Server Support feature (EDA data model) must also be
installed on a four-tier Teamcenter server.

Business Modeler IDE Business Modeler IDE is required to configure derived data for
EDA objects.

Before working with Teamcenter EDA objects in Business
Modeler IDE, you must install the EDA server support
features in Teamcenter Environment Manager (TEM). From
the Features panel, choose Extensions→Mechatronics Process
Management→EDA for Business Modeler IDE. You must also
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Server components Requirements

install the EDA Server Support template applicable to your
project.

Dispatcher Dispatcher is required for remote ECAD translations to translate
and save the design intermediate file into a viewable dataset in
Teamcenter.

If Dispatcher is already installed in your existing Teamcenter
environment, you can use the same instance. However, you
must modify it to include the translators that are specific to
ECAD translation.

Client components Requirements

Teamcenter EDA client The EDA client moves designs between Xpedition or PADS tools
and Teamcenter. The EDA client must be installed on the ECAD
workstation using the Teamcenter software kit.

Before installing the EDA client, check the Hardware and
Software Certifications knowledge base article on Support
Center to identify which versions of the Xpedition or PADS tools
are supported on which versions of Teamcenter EDA.

Siemens Digital Industries Software recommends that you first
perform the installation on a test system to verify the parameter
values required for the installation on the ECAD workstations.
Prerequisites and requirements before installing the EDA
client:

• Supported Operating System:

The EDA client framework is supported only on Windows.

• Supported Java version:

For information about the supported Java versions that
are certified for the EDA platform, see the Hardware and
Software Certifications knowledge base article on Support
Center.

• Software requirements specific to the ECAD tools on
which the EDA client should be installed:

• If you use PADS and select PADS Logic as the schematic
design tool, install PADS Logic or PADS Layout on your
client workstations.

3. Integrating Xpedition or PADS or PADS Professional with Teamcenter EDA for design management
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Client components Requirements

If you use PADS and select Xpedition Designer as the
schematic design tool, install Designer (PADS Flow) on the
client workstations.

• If you use Xpedition as the ECAD design tool, install
Designer and Xpedition PCB on the client workstations.

• Information required for EDA client installation from the
Teamcenter installation administrator:

• FMS client cache (FCC)

If the FMS client cache (FCC) exists, use the existing one or
specify a new one.

• The FCC parent information for the EDA client, including
the host and port values

The minimum information required is the host name and
the port value.

• The four-tier, middle-tier web application server URI and
the connection name for the EDA client

• Logon URL and the application ID to enable Teamcenter
Security Services

• Host name, port value, and license server mode of the
Siemens Digital Industries Software common license server

Note:

Teamcenter software kit contains the 64-bit installer
for Windows system. You can select Win32 applications
directly from TEM or DC along with the rest of
the Win64 applications from within the Teamcenter
software kit.

• Other installation considerations

• Only the English versions of ECAD tools are supported.

• Item ID, variant name, dataset name, reference designator
value, and mapped attribute names and values must
contain only ASCII characters. Mapped attributes include

Planning your deployment for design management
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Client components Requirements

CAD attribute mappings and component instance attribute
mappings.

• The staging directory and all file names must contain only
ASCII characters.

• PADS Logic does not support variants.

(Optional) ECAD viewer Install the ECAD viewer as a design-view tool and a markup tool.

Workflow to integrate your ECAD applications with Teamcenter for
design management

Scenarios to deploy the Teamcenter EDA server and client components for design management:

Using Deployment Center Using TEM

Install Teamcenter server
and the EDA client

Install Teamcenter server, Install
BMIDE, (Optional) Install Dispatcher

Set up Teamcenter
server for design management

Set up Teamcenter
server for design management

Set up the EDA
client for design management Install the EDA client

Perform additional configurations
and customizations required
for your ECAD applications

Set up the EDA
client for design management

Set up ECAD translation
Perform additional configurations

and customizations required
for your ECAD applications

(Optional) Install the ECAD viewer Set up ECAD translation

3. Integrating Xpedition or PADS or PADS Professional with Teamcenter EDA for design management
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(Optional) Install the ECAD viewer

Install Teamcenter EDA for design management using Deployment
Center

The following procedures assume that you are installing EDA on an existing Teamcenter and that you are
familiar with Deployment Center.

Procedure

1. Log on to Deployment Center and select the environment to which you want to add Teamcenter
EDA.

2. Go to the Applications task. Click Add or Remove Selected Applications .

3. In the Available Applications panel, use the web browser search to find the Electronic
Design Automation (EDA) application. Select the application, and then click Update Selected
Applications.

Deployment Center automatically selects any additional dependent applications.

4. In the Available Applications panel, under EDA Client, select the ECAD tool with which you are
integrating Teamcenter EDA for design management and other options as required on the ECAD
client machine:

• (Optional) Select EDA Translation.

• Mentor PADS

• Mentor Xpedition Designer and Layout

By default, all options under EDA Client are selected. Remove the tools and applications that are
not required for design integration and click Update Selected Applications.

Deployment Center automatically selects any additional dependent applications.

5. Go to the Components task.

6. In the Selected Components list of the Components task, note any remaining components whose
configuration status is not 100%. Select each incomplete component, enter required parameters,
and save component settings until all components in the environment show a configuration status
of 100%.

Install Teamcenter EDA for design management using Deployment Center
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When all components are fully configured, the Deploy task is enabled.

7. Go to the Deploy task. Click Generate Install Scripts to generate deployment scripts you will use
to update affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.

8. Locate deployment scripts, copy each script to its target machine, and then run each script on its
target machine.

For more information about running deployment scripts, see Run the deployment scripts in the
Deployment Center documentation.

You can also generate mini-kits for mass client deployment. Running the generateMiniSoftware
utility extracts only the necessary software from the full software kits and builds a smaller, more
portable software kit for the specific client deployment. For more information, see Generating mini
kits for mass client installations in Deployment Center ─ Usage on Support Center.

If you face any issues during the deployment, see Troubleshoot the deployment script in the
Deployment Center documentation.

Installing Teamcenter server for design management through TEM

Installing Teamcenter server

Install Teamcenter

To install Teamcenter EDA, you must first install Teamcenter. To install the Teamcenter corporate server,
refer to the Teamcenter Installation on Windows Using TEM help.

If you have an existing Teamcenter environment, you can update it to support the latest EDA version.

Refer to the Install patches on a Teamcenter server topic in the Teamcenter Installation on Windows
Using TEM help for instruction on installing Teamcenter patches.

Add EDA support on the Teamcenter server for design management

EDA server support adds the EDA data model to the existing Teamcenter data model.

Before installing the EDA server support, you must install the Teamcenter server.

1. From your Teamcenter environment, start Teamcenter Environment Manager (TEM).

2. Select the Configuration Manager option to perform maintenance on an existing installation and
click Next until the Select Features dialog box appears.

3. Integrating Xpedition or PADS or PADS Professional with Teamcenter EDA for design management
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3. In the Select Features dialog box:

a. Select the following options:

• Choose Extensions→Mechatronics Process Management and select EDA Server
Support.

• Choose Extensions→Mechatronics Process Management and select EMPS-Foundation.

• Choose Extensions→Mechatronics Process Management and select EDA for Business
Modeler IDE.

• Specify Active Workspace server extensions features for EDA. These are available in the
Features panel in Teamcenter Environment Manager (TEM), under Base Install→Active
Workspace→Server Extensions→EDA Server Support for Active Workspace.

• Specify Active Workspace client extensions features for EDA. These are available in the
Features panel in Teamcenter Environment Manager (TEM), under Base Install→Active
Workspace→Client→Electronic Design Automation for Active Workspace.

b. In the Installation Directory box, type the location where you want to install Teamcenter
(TC_ROOT).

c. Click Next.

4. Enter information as needed in the subsequent panes.

5. In the Confirm Selections dialog box, click Next.

The EDA server components are installed.

The Add/Remove Components dialog box confirms if the installation is successful. If the
installation is unsuccessful, click Show Details and proceed as needed.

6. Obtain the license file that includes EDA licensing and EDA library license (for library support) and
install it on the server.

After adding the EDA server support to your Teamcenter environment, you must verify your installation
by checking whether the EDA data types are added to Teamcenter.

Verify your installation

Verify the addition of the EDA data types to the server:

1. Run the Teamcenter rich client.

Verify your installation
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2. In My Teamcenter, choose File→New→Item.

The New Item dialog box is displayed.

3. Verify that the EDA, EDAComp, EDASchem, and EDACCABase item types are added to the list of
types you can create.

4. Select one of the EDA item types and create an instance.

5. Verify that the item instance is created.

Install BMIDE to configure derived data for EDA objects

You must install Business Modeler IDE to configure derived data for EDA objects and to import the
sample BMIDE EDA server support template.

You can install BMIDE either as a stand-alone application or place the BMIDE plug-ins in an existing
Eclipse environment.

For instructions on installing BMIDE, refer to the Install the Business Modeler IDE topic or the Add the
Business Modeler IDE to an existing Eclipse SDK environment topic in the BMIDE for Data Model Design
documentation on Support Center.

Install or update Dispatcher for setting up remote ECAD translation

Teamcenter viewers can only process neutral ECAD formats, and depending on the workflow of your
environment, you may need to translate native ECAD PCB and schematic data to this neutral file format.

With ECAD translation, the design intermediate file from the Xpedition or PADS tool is converted into a
neutral file format (XFATF for PCB designs and XSCH for schematic designs). The neutral file is saved as a
viewable dataset in Teamcenter.

The following translation modes are supported for ECAD translation:

• Local translation where the viewable file is generated locally.

• Remote translation where the Teamcenter integration initiates a remote translation of the
intermediate file into a viewable format.

You require Dispatcher for remote ECAD translations only. You can install Dispatcher as a standalone
instance or in an existing Teamcenter environment. If Dispatcher is already installed in your existing
Teamcenter environment, you must modify it to include the PcbToFatF ECAD translator.

For instructions on installing Dispatcher, refer to the Dispatcher ─ Deployment and Administration
documentation on Support Center. After installing and setting up the dispatcher you must enable the
PcbToFatf translator.
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Setting up Teamcenter server for design management

Overview of setting up and configuring Teamcenter server for design
management

Before you install and enable your design tools and perform client installations, you must perform the
following server setup configurations that are required for the integrations to work properly for design
management:

Configuration Why is it required?

Populate the Teamcenter database with ECAD
components

Any component that does not already exist in
Teamcenter is automatically created when saving
the BOM.

Modify the Active Workspace style sheet to
include EDA derived data relation

To allow EDA derived datasets to be displayed as
item revision attachments in Active Workspace,
the Awp0ItemRevisionSummary style sheet
must be modified.

Add EDA relations and EDA objects in the
Active Workspace Relation Browser

To traverse EDA relations and show EDA objects
in the Relations tab in Active Workspace, EDA
information must be included in the Relation
Browser configuration.

Map ECAD attributes with Teamcenter
properties

Using mapping definition files, the ECAD part
attributes can be stored in the Teamcenter
database and displayed and modified both in the
ECAD design tool and Teamcenter.

Configure derived data for ECAD design objects Derived data contains information that is derived
from an ECAD design and comprises derived
items and datasets. Derived items represent
parts, subassemblies, and tools. Derived datasets
manage data files created by ECAD applications.

Optionally, to change the behavior of the how the Teamcenter and the ECAD tool integration works, you
can modify the settings for other configurations as follows. These configurations are available OOTB with
set default values:

Configuration Why is it required?

Configure design variants To design and develop a product with several
variations, where each variation has different
options or capabilities, you create design variants.
Creating design variants avoids the need to
create a unique version of the design for each
variation. A variant uses the same base design,
but the PCB assembly is loaded with the set

Overview of setting up and configuring Teamcenter server for design management
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Configuration Why is it required?

of components specified by the variation. You
can then select a variation when generating the
design’s manufacturing output (BOM, Pick and
Place (P&P), assembly drawings), which will in
turn determine how the product is assembled.

Manage design files in local storage You can configure the default behavior of
removing design files in the local storage option
after you check in, check out, revise, or perform
a save as operation on the design files. The
Remove working files from local storage check
box allows you to remove associated design files
after you perform check in, check out, revise, or
save as action on the design.

Apply Teamcenter user's permission on the
network shared ECAD design folder

During any Teamcenter EDA operation on a
design in a network shared folder, the ECAD
users accessing the design will have viewing or
modifying rights on that shared folder based
on the access permissions set for that user in
Teamcenter.

Allow ECAD designers to assign a Teamcenter
project from the EDA client

While saving a new or an existing EDA design
from the EDA client to Teamcenter, the ECAD
designers can assign or remove a Teamcenter
project for that design. The projects assigned
to Printed Circuit Assembly (PCA) objects are
propagated to all ItemRevisions and Datasets
associated with the PCA object based on the
Teamcenter propagation rule defined for that
object. You can also modify the OOTB propagation
rules as per your requirements.

Set configurations based on the ECAD
applications used

You can configure which preference values should
be used for a specific preference based on the
connectors configured for your ECAD design tool.
This configuration allows all EDA preferences to
be overridden by application-specific preferences,
if set.

Configure EDA to access Active Workspace for
collaboration and issue management

You must enable EDA to access Active Workspace
for performing tasks related to the collaboration
and issue management functionalities. The tasks
can be completed using the Design Info and
Inbox commands from Active Workspace.

Allow users to view the PCB board
requirements in Active Workspace

By default, ECAD designers can view the PCB
board requirements specifications related to the
design revisions in the Requirements tab in
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Configuration Why is it required?

Active Workspace for the EDACCABase and
EDASchem object types, by default. Users can
configure the Requirements tab for other item
revisions.

Customize the acronyms used for ECAD design
objects in Teamcenter

If your ECAD designers use acronyms different
from the default acronyms provided, the
Teamcenter configurator can override the defaults
by creating custom acronyms used for ECAD
designs in Teamcenter.

Configure the EDA client to use the Teamcenter
EDA panels instead of Active Workspace

By default, the EDA client uses the Active
Workspace panels for user actions such as open
and save. You can use Teamcenter EDA panels
instead, if you prefer to or in case you do not have
Active Workspace installed.

Populate the Teamcenter database with ECAD components

Many companies control the ECAD component library items that can be used to create BOMs by
checking in the approved components for use to the database. Thereafter, you can create BOMs that
use these components.

You can configure how to:

• Control ECAD component library items for BOM creation.

To control component library items for BOM creation, when EDA is first installed, the
EDA_CheckComponentExistence is set to 1 (true). With this setting, you cannot save design BOMs
unless all the necessary components are already in Teamcenter.

• Populate the database with ECAD components before the designer can save designs and before
creating BOMs in Teamcenter using EDA.

You can initially populate the database with components by changing the
EDA_CheckComponentExistence preference to 0 (false). If this preference is set to 0, any
component that does not already exist in Teamcenter is automatically created when saving the BOM.

Caution:

Do not set this preference to 0 in a production environment.

1. Set the EDA_CheckComponentExistence preference:

a. Run the rich client on the Teamcenter server and log on as an administrator.

Populate the Teamcenter database with ECAD components
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b. In the My Teamcenter application, choose Edit→Options.

c. At the bottom of the Options dialog box, click Filters.

d. In the Preferences dialog box, search for the EDA_CheckComponentExistence preference.

e. Click Edit and change the value of the preference from 1 (true) to 0 (false).

f. Click Save to apply the changes.

2. Locate or create designs that use the approved library components. Use the EDA Save As
command to save the designs to the Teamcenter server and create BOMs. When the BOMs are
created, the components are automatically added to the database.

For information about using the Save As command, see Saving designs to Teamcenter in the
Xpedition and PADS Design Management documentation.

3. Reset the EDA_CheckComponentExistence preference to 1 (true) if you want to restrict users
to using only the approved (and checked-in) components. This is the recommended setting in
production environments.

However, if you wish to allow new components to be automatically placed in the database when
users create BOMs, leave the EDA_CheckComponentExistence preference as is, set to 0.

This action bypasses business processes for component evaluation and approval.

Add EDA relations and EDA objects in Active Workspace Relation Browser

To traverse EDA relations and show EDA objects from the Relations tab in Active Workspace, EDA
information must be included in the Relation Browser configuration. To do this, you must update the
RelationBrowserConf dataset in the RB_UIConfigure.xml file in the Teamcenter server configuration.

To enable the Relations tab to show relations between Teamcenter objects and objects in a remote
application, do the following:

1. In the Teamcenter rich client, search for the dataset RelationB*.

2. Right-click the RelationBrowserConf dataset and choose Check-InOut > Check-Out.

3. Right-click RelationBrowserConf dataset and choose Named References.

4. In the Named References dialog box, select RB_UIConfigure.xml and click Download.

5. Modify the RelationBrowserConf dataset in the locally downloaded RB_UIConfigure.xml file to
add EDA relations and EDA objects as follows.
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=====================================================================
==
            Filename: RB_UIConfigure.xml
       
            File used to configure control panel of relation browser.
=====================================================================
==

 -->
        <RelationBrowser>
          <OptionPanel>
            <view name="General">
              <ruleName>GenericRule</ruleName>
              <defaultLayout>IncrementalHierarchic</defaultLayout>
              <group name="relations">
                   
                <filter name="EDA" parameterSet="EDARelations" 
color="(204,51,0)"/>
              </group>
              <group name="objects">
                   
               <filter name="EDA" parameterSet="EDAObjects" 
color="(204,51,0)"/>
               <filter name="Other" parameterSet="WorkspaceObject" 
color="(238,236,225)"/>
              </group>
            </view>
            <view name="System"> 
                 
               <parameterSet name="EDAObjects">
                  <clipsfacts>
                    <fact>EDACCABase</fact>
                    <fact>EDACCABaseRevision</fact>
                    <fact>EDASchem</fact>
                    <fact>EDASchem Revision</fact>
                  </clipsfacts>
               </parameterSet>
                 <parameterSet name="EDARelations">
                   <clipsfacts>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasDerivedDataset,targetDirection=forward,inputTypes=ItemRevision
</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasDerivedItem,targetDirection=forward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasPWB,targetDirection=forward,inputTypes=ItemRevision</fact>

Add EDA relations and EDA objects in Active Workspace Relation Browser
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                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSchematic,targetDirection=forward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSchematic,targetDirection=backward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSublayout,targetDirection=forward,inputTypes=Dataset,outputTyp
es=Dataset</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasVariant,targetDirection=forward,inputTypes=ItemRevision</fact>
                     </clipsfacts>                     </
parameterSet> 
                 
            </view>
        </RelationBrowser>

6. Delete the original RB_UIConfigure.xml file from the Named References dialog box and import
the new RB_UIConfigure.xml file in Teamcenter.

7. Click Close.

8. Check in the RelationBrowserConf dataset.

Map ECAD attributes with Teamcenter properties

How are ECAD attributes mapped with Teamcenter properties

Using mapping definition files, the ECAD part attributes can be stored in the Teamcenter database and
displayed and modified both in the ECAD design tool and Teamcenter.

For the ECAD parts created in Xpedition or PADS, the ECAD design attributes can be mapped to
Teamcenter properties while saving the files in Teamcenter. When the designs are saved, the ECAD
attributes are added to the corresponding Teamcenter properties. When the designs are opened
from the Teamcenter menu in the Xpedition or PADS tool, the properties are mapped back to the
corresponding attributes in the ECAD tool.

For the ECAD design tool, choose entries for design, project, and variant attributes such that they apply
to the data types that represent the corresponding objects. Mapping definitions for variant objects must
be associated with the specific object type that represents the variant BOM.

For details on how to map ECAD attributes, see the Mapping attributes section in the Teamcenter
Integration for NX documentation.

To understand the correct syntax and symantics for mapping attributes to standard and custom item
types, see the Examples of Syntax and Symantics for Mapping Attributes topic in the Teamcenter
Integration for NX documentation.
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Customize ECAD attribute mapping

You can customize the ECAD attribute mappings in Teamcenter by exporting the attribute mappings to a
file, editing the file, and importing the file back into Teamcenter.

1. Open a Teamcenter command prompt.

2. Change to the bin directory within TC_ROOT (TC_ROOT is the installed location of Teamcenter).

3. Run the export_attr_mappings command to export the mappings to a file, for example:

export_attr_mappings –file=test_attribute_mapping –u=Tc-admin-user –p=password

4. Edit the mappings file to add EDA tool attributes. The format is
attr_from_ECADtool :attr_from_Tc /description=”desc”, where:

• attr_from_ECADtool is the name of the attribute from the ECAD library tool.

• attr_from_Tc is the attribute from Teamcenter.

• description is the information used to describe this attribute.

For example, adding the following text to the file defines mappings for your Siemens-EDA ECAD
tools:

{ Dataset type="EDADesMentor"
mgc_type : IM.user_data_1 /description="mgc_type"
design_name : IM.user_data_2 /description="design_name"
}

{ Dataset type="EDAComMentorBS"
GEOM : ItemRevision.ICS(-5488) /description="GEOM"
}

{ Dataset type="EDAComPADS”
Part Number: ItemRevision.ICS(-5485)/description=" Part Number"
Description : ItemRevision.ICS(-5486)/description="Description"
}

{ Dataset type="EDAComExpedition”
Value : ItemRevision.ICS(-6211) /description="Value"}
{Item type=EDAComPart"
Cost: Item.GRM(IMAN_master_form).object_desc /description="Cost"
}

{ Dataset type=" Epl0EDXPackage”
"Tolerance" : ItemRevision.GRM(IMAN_master_form).object_desc /

Customize ECAD attribute mapping
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description="Tolerance" 
}

5. Import the edited mapping file back into Teamcenter by running the import_attr_mappings
command, for example:

import_attr_mappings –file=test_attribute_mapping –u=Tc-admin-user –p=password

The attribute mapping import and export process uses the PLM XML import/export mechanism.
For more information, see the Tc XML and PLM XML Configuration for Data Import and Export
documentation.

For the attribute mappings to work correctly, you must also perform the client configurations for
mapping RDN attributes on your EDA client workstation.

Sample ECAD design attribute mapping definitions

The below example defines dataset attribute mappings and variant attribute mappings. In this mapping
definition, the Item level attribute mapping definition defines the ECAD variant attribute mappings and
it is part of the dataset level attribute mapping definition.

ECAD variant mapping for Xpedition tool:

{ Dataset type="EDADesExpBrd"
ORGNAME : Item.GRM(IMAN_master_form,Item Master).user_data_1
ORGADDR1 : Item.GRM(IMAN_master_form,Item Master).user_data_2
"DES_NAME" : ItemRevision.object_name
"DES_DESC" : ItemRevision.object_desc
Doc : Item.GRM(IMAN_master_form,Item Master).user_data_3

    { Item type="Item"
        "variant_def_list_tc_description" : ItemRevision.object_desc /
description="Variant Item Revision Description"
    }
} 

In above example, the attribute mappings are defined with respect to the dataset type EDADesExpBrd.
Using this dataset attribute mapping functionality, it is possible to map an ECAD design attribute to a
property with the Teamcenter object type. In this example, the ECAD attribute ORGNAME is mapped to
user_data_1 property of the item master form and ORGADDR1 is mapped to user_data_2 property of
the item master form in Teamcenter.

Similarly, the ECAD attribute DES_NAME is mapped to object_name property of ItemRevision and
DES_DESC is mapped to object_desc property of ItemRevision in Teamcenter.

3. Integrating Xpedition or PADS or PADS Professional with Teamcenter EDA for design management

3-16  Xpedition and PADS Integration With Teamcenter, Teamcenter 2412
© 2025 Siemens



In the last line of above example, the attribute mappings are defined for the item type Item. However,
these mappings are applicable only to the dataset type EDADesExpBrd. These mappings are not
applicable for other dataset types. To define the attribute mappings between the ECAD variant attributes
and the Teamcenter variant object properties, the attribute mappings must be defined on the Variant
Item type. In above example, the ECAD variant attribute variant_def_list_tc_description is mapped to
object_desc property on ItemRevision in Teamcenter.

Configure derived data for ECAD design objects

Understanding how derived data works

Derived data contains information that is derived from an ECAD design and comprises derived items and
datasets. Derived items represent parts, subassemblies, and tools. Derived datasets manage data files
created by ECAD applications.

You can configure how derived data is created in Teamcenter EDA by using the EDA Derived Data folder
in Business Modeler IDE, creating an EDA derived data configuration, and configuring how derived data
files are named in Teamcenter. For example, a configuration can specify that when a schematic design
is saved in Teamcenter EDA, a schematic drawing can be automatically generated from the schematic
design and saved along with the schematic item

EDA business objects define the different types of derived data you can generate. To locate EDA business
objects, use the Find button in the BMIDE view to search for all business objects containing the EDA
string.

The following item types are children of the EDA business object:

Item Types Description

EDACCABase Represents the common electrical CAD (ECAD)
design data that is shared between variant circuit
card assemblies (CCAs). It is used only for multiple
CCA representations.

EDAComp Represents electrical components contained in the
CCA bill of materials (BOM).

EDASchem Represents the electrical schematic item.

The following relationships are children of the ImanRelation business object:

ImanRelation Description

EDAHasDerivedDataset Identifies the associated dataset as a derived
dataset.

EDAHasDerivedItem Identifies the associated item as a derived item.

Understanding how derived data works
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How to use the EDA derived data editor to configure derived data in Teamcenter

Use the EDA Derived Data editor in the BMIDE to work with derived data configurations used by the
Teamcenter EDA application. Teamcenter EDA integrates Teamcenter with ECAD applications that are
used to design electronic components, such as circuit boards.

1. To access the EDA Derived Data editor, open the Extensions→EDA Derived Data folder, right-click
an EDA derived data object, and choose Open.

2. To add an item to the EDA derived data object, click the Add button next to the Configure Items
table.

3. To add a dataset to the EDA derived data object, click the Add button next to the Configure
Dataset table.

How to create an EDA derived data configuration

You can configure how derived data is created in Teamcenter by using the EDA Derived Data folder
in Business Modeler IDE. After creating a derived data configuration, you can specify the name of the
configuration in the EDA_DerivedDataConfigDefault preference.

1. In BMIDE, open the Extensions folder.

2. In the Extensions folder, right-click EDA Derived Data and choose New EDA Derived Data.

The New EDA Derived Data wizard is displayed.

3. In the EDA Derived Data dialog box, enter the following information and click Next:

Field Description

Name Specify a name you want to assign to the new
derived data configuration.

This is the name used in the
EDA_DerivedDataConfigDefault preference.

Description Type a description for the new configuration.

The EDA Derived Data Configuration dialog box in the wizard is displayed.

4. In the EDA Derived Data Configuration dialog box, set up how all EDA item and dataset types are
to be handled for all contexts.

a. Click the Add button next to the Configure Items table.

The Add/Edit EDA Derived Item Configuration dialog box is displayed.
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In the Add/Edit EDA Derived Item Configuration dialog box, configure the derived items
to be generated. For example, create separate rows for contexts such as schematic, PCB,
simulation, and so on, including variations based on the what the parent is, such as
Schematic, CCA, and CCAVariant. In this way, you set up how derived data is generated
for all combinations of items.

In the Add/Edit EDA Derived Item Configuration dialog box, enter the following information
and click Finish:

Field Description

Name Type the name that you want to assign to the derived
item configuration.

This is the name displayed to the user on the Teamcenter
EDA Derived Item dialog box during save operations.

Context Browse to select a specific Teamcenter EDA application
context from the contexts listed below. When users in
Teamcenter EDA save derived data for the following
specified data types, derived items are generated
according to this configuration.

• all

• pcb

• pcb/simulation

• schematic

• schematic/pcb

• schematic/simulation

• simulation

For PWB, if you have derived items and derived datasets
defined for both schematic and PCB, you must set the
preference EDA_DefinePWBWith to schematicANDpcb
so that the PWB and derived data can be exposed and
modified in both schematic and PCB tools. By default, the
preference value is set to Schematic.

Prefix (Optional) Type a file name string to be attached to the
beginning of the parent item ID to distinguish it as being
generated by this configuration.

The resulting string, including the prefix and postfix, is
used in the derived item user interface in Teamcenter

How to create an EDA derived data configuration
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Field Description

EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

Postfix (Optional) Type a file name string to be attached to the
end of the item ID to distinguish it as being generated by
this configuration.

The resulting string, including the prefix and postfix, is
used in the derived item user interface in Teamcenter
EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

EDA Parent Browse to select the derived parent EDA business object
to which the derived item is related. (Teamcenter EDA
does not support attaching derived items under other
derived items).

• CCA represents a circuit card assembly (CCA).

• CCABase represents the common design data that is
shared between variant circuit card assemblies (CCAs).
It is used only for multiple CCA representations.

• CCAVariant represents the variant design data for a
circuit card assembly (CCA). This is the data that is
used on top of the CCABase business object.

• PWB represents a printed wire board (PWB). A PWB is
the product of a schematic design and printed circuit
board (PCB) layout design and holds all the printed
wire board production data created by those designs.

• Schematic represents the electrical schematic item.

Relation Browse to select the relationship between the derived
item and the parent item revision.

The EDAHasDerivedItem business object and its children
are displayed in the selection dialog box.

Item Business Object Browse to select the business object type name for the
derived item, for example, EDA.

Add to Bom Select this option to add the derived item to the bill of
materials of the Teamcenter EDA parent. This check box is
disabled if the Teamcenter EDA parent is a schematic or a
PWB.

The derived item configuration is added to the Configure Items table.
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b. Click the Add button to the right of the Configure Dataset table.

The Add/Edit EDA Derived Dataset Configuration dialog box is displayed.

In the Add/Edit EDA Derived Dataset Configuration dialog box configure the derived
datasets to be generated. For example, create separate rows for contexts such as schematic,
PCB, and simulation, including variations based on the what the parent is, such as Schematic,
CCA, and CCAVariant. In this way, you set up how derived data is generated for all
combinations of datasets.

In the Add/Edit EDA Derived Dataset Configuration dialog box, enter the following
information:

Field Description

Name Type the name that you want to assign to the derived
dataset configuration.

This is the name displayed to the user on the Teamcenter
EDA Derived Dataset dialog box during save operations.

Context Browse to select a specific Teamcenter EDA application
context from the contexts listed below. When users in
Teamcenter EDA save derived data for the following
specified data types, derived datasets are generated
according to this configuration.

• all

• pcb

• pcb/simulation

• schematic

• schematic/pcb

• schematic/simulation

• simulation

For PWB, if you have derived items and derived datasets
defined for both schematic and PCB, you must set the
preference EDA_DefinePWBWith to schematicANDpcb
so that the PWB and derived data can be exposed and
modified in both schematic and PCB tools. By default, the
preference value is set to Schematic.

How to create an EDA derived data configuration
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Field Description

Prefix (Optional) Type a file name string to be attached to the
beginning of the parent item ID to distinguish it as being
generated by this configuration.

The resulting string, including the prefix and postfix, is
used in the derived dataset user interface in Teamcenter
EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

Postfix (Optional) Type a file name string to be attached to the
end of the item ID to distinguish it as being generated by
this configuration.

The resulting string, including the prefix and postfix, is
used in the derived dataset user interface in Teamcenter
EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

EDA Parent Browse to select the derived parent EDA business object
to which the derived dataset is related.

In addition to the following item types, the list also
includes item configurations you already created.

• CCA represents a circuit card assembly (CCA).

• CCABase represents the common design data that is
shared between variant circuit card assemblies (CCAs).
It is used only for multiple CCA representations.

• CCAVariant represents the variant design data for a
circuit card assembly (CCA). This is the data that is
used on top of the CCABase business object.

• PWB represents a printed wire board (PWB). A PWB is
the product of a schematic design and printed circuit
board (PCB) layout design and holds all the printed
wire board production data created by those designs.

• Schematic represents the electrical schematic item.

Relation Browse to select the relationship between the derived
dataset and the parent item revision.

The EDAHasDerivedDataset business object and its
children are displayed in the selection dialog box.
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Field Description

Dataset Business
Object

Browse to select the parent dataset business object type
in Teamcenter to represent the derived item, for example,
PDF.

Dataset Reference Browse to select the kind of file reference to use for the
derived dataset.

If the derived data instance comprises more than one
file, this field must either be specified as a ZIPFILE type
or must be specified using a separate derived dataset
configuration entry with the same derived data name.

Pathname Type the path where the derived dataset is to be saved on
the user's machine.

Path names are evaluated at run time and must be
the fully qualified path of the dataset that is to be
saved. Path names can be explicitly specified (for
example, D:\EDA\Datasets\readme.txt) or formed using
the variables or file name filters. Derived datasets can
contain multiple files. Path names are case sensitive, and
the directory delimiters of / or \ are used interchangeably.

Callback Name Type the EDA callback name to execute.

This name is used to identify the configured callback
in the EDA configuration file to determine what script
to execute. The script is responsible for creating or
placing the corresponding derived files to be uploaded
as specified by the configured source path name.

The derived item configuration is added to the Configure Dataset table.

c. Click Finish.

The derived data configuration is added under the EDA Derived Data folder

5. To save the changes to the data model, choose BMIDE→Save Data Model, or click the Save Data
Model button  on the main toolbar.

6. Deploy your changes to the test server. Choose BMIDE→Deploy Template on the menu bar, or
select the project and click the Deploy Template button  on the main toolbar.

7. In the rich client, set the EDA_DerivedDataConfigDefault preference to point to the EDA derived
data configuration you just created.

8. Choose Edit→Options, click the Search link at the bottom of the Options dialog box, locate the
EDA_DerivedDataConfigDefault preference, and change its value to the new configuration.

How to create an EDA derived data configuration
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There may be multiple configurations created in the Business Modeler IDE, but an administrator can
point to only one of them through this preference.

9. After deployment, test your new configuration in Teamcenter EDA.

For example, in your ECAD design tool, choose Teamcenter→Save Derived Data. (You can also
select the Generate Derived Data check box in the Save As, Save, or Check In dialog box.)

To verify that the derived data is generated, in Teamcenter, expand the item that contains the
derived data (for example, a CCA item). The derived dataset entries appear as you expand the tree
structure. To see the contents of the derived dataset, right-click the dataset and choose Named
References. A dialog box appears that shows the files that are contained in the derived dataset.

Configure how derived data files are named in Teamcenter

Update the value of the EDA_UseDerivedDataSubDirs preference based on how you want the derived
data files to be named in Teamcenter. The values are as follows:

• True

The derived dataset name is the same as the Derived Dataset Configuration Name.

• False

The derived dataset name consists of the parent item ID and an underscore (character) followed by
the Derived Dataset Configuration Name.

Using wildcards in the derived data configuration path names

You can specify wildcard characters in the derived data configuration path name as follows:

Wildcard Definition Example

Asterisk (*) Matches any number of
characters including none.

$DESIGN\*\*.doc

Selects all .doc files from the child folder under the
$DESIGN folder.

$DESIGN\*\*PWB*.doc

Selects all .doc files with PWB in their file names
from the child folders under the $DESIGN folder.

$DESIGN\PWB*\*.doc

Selects all .doc files that start with PWB in their
file names from the child folder under the $DESIGN
folder.
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Wildcard Definition Example

Two asterisks (* *) Works like one asterisk
(*) but crosses directory
boundaries. This syntax is
generally used to match
complete paths.

$DESIGN\**\MyFile.doc

Selects the Myfile.doc file from all child folders
under the $DESIGN folder.

Question mark (?) Matches exactly one
character.

$DESIGN\Help\Help?.doc

Selects files with one character after their file name
like Help1.doc, Help2.doc and HelpA1.doc but
not HelpMe.doc.

Braces ({ }) Specifies a collection of sub
patterns.

$DESIGN\Help{Me,You}\*.pdf

Selects all .pdf files from either HelpMe or
HelpYou folder.

Square brackets
([ ])

Conveys a set of single
characters or when a
hyphen (-) is used a range
of characters.

$DESIGN\Help[123]\*.doc

or

$DESIGN\Help[1-3]\*.doc

Selects all .doc files any one of the folders Help1,
Help2, Help3.

If multiple files from different folders match during save of the derived dataset, no files are saved for the
derived dataset.

Example:

If your folder structure is like this:

$DESIGN\File1.doc

$DESIGN\Help1\File2.doc

$DESIGN\Help1\File3.pdf

$DESIGN\Help2\File4.doc

$DESIGN\Help2\File5.pdf

$DESIGN\Help2\File6.xls

The wildcards give the following results:

Using wildcards in the derived data configuration path names
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$DESIGN\**\*.doc will fail.

$DESIGN\*\*.pdf will fail.

$DESIGN\*\*.xls will succeed.

$DESIGN\Help1\*.doc will succeed.

$DESIGN\**\File4.doc will succeed.

$DESIGN\*\File3.pdf will succeed.

You can also specify that the entire contents of a directory, including all sub-directories and files, are
to be saved as a zip file. Specify the DerivedDatasetConfiguration Dataset Reference as ZIPFILE.
Specify the DerivedDatasetConfiguration Pathname as a fully qualified directory path ending with
the filename filter value **. Each directory of the path must be an existing directory, no wildcards are
allowed. Derived DatasetConfigurationPathname variables such as $DESIGN are supported.

Example:

$DESIGN/manufacturingData/**

Configure design variants

What are design variants?

To design and develop a product with several variations of that product, where each variation has
different options or capabilities, you create design variants. Creating design variants avoids the need to
create a unique version of the design for each variation. A variant uses the same base design, but the
PCB assembly is loaded with the set of components specified by the variation. A variation may then be
nominated when generating the design’s manufacturing output (such as BOM, Pick and Place (P&P), and
assembly drawings), which will in turn determine how the product is assembled.

When you are working with ECAD design files, you can create any number of variations of the same base
design, where each component may be configured differently as follows:

• Fitted

This is the default state of a component if the component is fitted. It does not have variations. When
you create a new variant, all components default to the state fitted.

• Not Fitted

If a component is set to not fitted, it still exists on the schematic and is transferred to the PCB, but it is
removed from the appropriate output documentation, such as the BOM.
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• Fitted with Varied Parameters

A component can have variations of any of its parameters, as part of the variant definition process.
Modifying the value of a parameter is a local variation, only affecting the output documentation. The
original schematic and the component whose parameter is being varied are not modified in any way.

• Alternate Part

It is also possible to select an entirely different component as an alternate part. Since the alternate
part is a different component, only one component is presented on the compiled schematic sheet.
The alternate part must also share the same set of pins placed in the same locations as the base
part. This is an essential requirement to ensure that the connectivity remains valid when the design is
compiled.

An ECAD design is saved as a non-variant design for the first time in Teamcenter. Later, the variants
of the ECAD design are added or created in Teamcenter as required. There are two scenarios for how
variants are added.

• In the first scenario, you save the ECAD design as a non-variant design in Teamcenter. When new
variants of the designs are created in the ECAD tool, you update the non-variant design in Teamcenter
with the variants.

• In the second scenario, you save the non-variant ECAD design as a variant design in Teamcenter by
creating dummy variants. When the variant designs are created in the ECAD tool, you replace the
dummy variants in Teamcenter with the actual variant designs.

You can configure how to save a nonvariant ECAD design to Teamcenter as a variant design
using the EDA variant object model.

Configure ECAD design variants in Teamcenter

You can save a nonvariant ECAD design to Teamcenter using the EDA variant object model. To configure
the saving of new nonvariant ECAD designs in Teamcenter as variant designs:

1. Update the value of the EDA_SaveAsForceVariant preference to true. This value specifies that
nonvariant ECAD designs not previously saved in Teamcenter are to be saved in Teamcenter, using
the EDA variant object model.

2. Update the value of the EDA_FutureVariantName preference. The default value is futureVariant.

When you save a nonvariant design to Teamcenter and the value of the EDA_SaveAsForceVariant
is true, the value of the EDA_FutureVariantName preference is used as the Variant Name in the
PCA Variants dialog box. The value of the Variant Name in the PCA Variants dialog box cannot be
changed.

Nonvariant ECAD designs already saved to Teamcenter using the EDA nonvariant object model are
converted to use the EDA variant object model by the existing nonvariant-to-variant conversion

Configure ECAD design variants in Teamcenter
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functionality. This conversion occurs automatically when an ECAD design, previously saved to
Teamcenter as a nonvariant design, is saved to Teamcenter after the first variant is added to the ECAD
design.

Base BOMs do not support this functionality.

Manage design files in local storage

You can configure the default behavior of removing design files in the local storage option after you
check in, check out, revise, or perform a save as operation on the design files. The Remove working
files from local storage check box allows you to remove associated design files after you check in, check
out, revise, or perform a save as operation on the design.

You can configure the default status of this check box by setting the following values in the
EDA_RemoveWorkingFilesOptionDefault preference:

• unchecked: The check box is cleared by default, and the user can select it.

• checked: The check box is selected by default, and the user can clear it.

• Forceunchecked: The check box is cleared, and the user cannot select it.

• Forcechecked: The check box is selected, and the user cannot clear it.

You can set the values of the EDA_ValidateRemoveWorkingFiles preference, to validate that the design
files are not locked before performing the purge action. When this preference is set to True, the design
files will be purged only if none of the design files are locked. However, if the preference value is set to
False, only those design files that are not locked will be purged from the local storage. Locked files will
not be purged and the users will be notified about the files not purged.
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Apply Teamcenter user's permission on the network shared ECAD design
folder

During any Teamcenter EDA operation on a design in a network shared folder, the ECAD users accessing
the design will have viewing or modifying rights on that shared folder based on the access permissions
set for that user in Teamcenter.

To apply the Teamcenter user’s permissions on the ECAD design folder, the Teamcenter administrator
must set the EDA_EnableFolderPermissions preference value to true.

To specify which Teamcenter user roles must have permission to access the ECAD design folder, the user
roles must be set in the FolderPermissions_ValidRolesForAccess preference.

Allow ECAD designers to assign a Teamcenter project from the EDA client

While saving a new or an existing EDA design from the EDA client to Teamcenter, the ECAD designers
can assign or remove a Teamcenter project for that design.

To make sure that the ECAD designer assigns a Teamcenter project while saving a design, you must set
the EDA_TCProjectRequired preference to true. If this preference is set to false, the ECAD designer can
save the design without assigning any project. The default value of the preference is false. If a default
project is assigned to a user in Teamcenter, that project is assigned to the design by default. However,
the user can assign additional projects while saving the design.

You must also assign the ECAD users to a project in Teamcenter to allow the users to select that project
during the save operation. All projects associated with the ECAD users are displayed for selection to that
user during the save operation.

A Teamcenter propagation rule is used for propagating security-related property values, such as project
and license assignments, from a source business object to a destination business object. The projects
assigned to Printed Circuit Assembly (PCA) objects are propagated to all ItemRevisions and Datasets
associated with the PCA object based on the Teamcenter propagation rule defined for that object. You
can also modify the OOTB propagation rules as per your requirements. For more information on how
to modify an existing propagation rule, refer to the Configure your business data model in BMIDE on
Support Center.

The OOTB propagation rules defined for EDA objects are as follows:
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You can also modify the OOTB propagation rules to create custom rules for variant and non-variant
designs.

Create a custom propagation rule for variant designs:
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Create a custom propagation rule for non-variant designs:
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Set configurations based on the ECAD applications used

You can configure which preference values should be used for a specific preference based on the
connectors configured for your ECAD design tool. This configuration allows all EDA preferences to be
overridden by application-specific preferences, if set. The application specific preferences can be created
for all the EDA design preferences by adding a suffix to the OOTB preference name. The suffix is the
name of the ECAD tool application as mentioned in the %TCEDAECAD_ROOT%\*_usrdef.xml file.

If the preference exists with the suffix of the connector name, this preference is used. Else, the
preference without a suffix is used.

Example:

Consider that you are using two different connectors, and you want to set different values for the
following preference, depending on which connector is currently being used. You can set different
values for the same preference by adding the application name as a suffix to the preference name.

The OOTB preference name is EDA_CCAVariantItemTypesAllowed.
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To set the preferences with different values for both the connectors, create two different instances
of the preference with the connector names suffixed to the preference.

• Preference to be used if connector 1 is used:

EDA_CCAVariantItemTypesAllowed_<connectorname_1>

• Preference to be used if connector 2 is used:

EDA_CCAVariantItemTypesAllowed_<connectorname_2>

Configure EDA to access Active Workspace for collaboration and issue
management

You must enable EDA to access Active Workspace for the collaboration and issue management
functionalities. The collaboration and issue management tasks can be completed using the Design Info
and Inbox commands from Active Workspace. To enable EDA to access Active Workspace:

• In Active Workspace, click Create Change  and check if Issue Report is part of the available

change types.

If Issue Report is not available, perform following:

• Create a Business Modeler IDE project, and add a condition with the following parameter values:

■ Name: isIssueReportCreatable

■ Input parameters: Custom

■ Signature: isIssueReportCreatable ( UserSession o )

■ Expression: Condition::isTrue()

• Deploy the Business Modeler IDE template.

• In the Teamcenter rich client, update the AWC_DispayableChangeTypes preference with the value
IssueReportRevision.

• Update the value of the ActiveWorkspaceHosting.URL preference with that of the Active Workspace
URL.

OR

Create a preference named ActiveWorkspaceHosting.EDA.URL and update it with the value of the
Active Workspace URL.

Configure EDA to access Active Workspace for collaboration and issue management
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Allow users to view the PCB board requirements for ECAD objects in Active
Workspace

ECAD designers can view the PCB board requirements specifications related to the design revisions in the
Requirements tab in Active Workspace for the EDACCABase and EDASchem object types, by default.

To allow users to configure Requirements tab for other Item Revisions, user can include the following in
the respective stylesheet.

<page titleKey="tc_xrt_Requirements" 
visibleWhen="ActiveWorkspace:SubLocation
 != com.siemens.splm.client.occmgmt:OccurrenceManagementSubLocation">
        <htmlPanel declarativeKey="Eda0RequirementsTraceability" />
</page> 

Additionally, you can specify the revision rule to configure the requirements BOM structure in the
Requirements tab by setting the EDA_AWRequirementBOMRevRule preference. The default value of
the revision rule is set to Latest Working.

Customize the acronyms used for ECAD design objects in Teamcenter

If your ECAD designers use acronyms different from the default acronyms provided, the Teamcenter a
can override the defaults by creating custom acronyms used for ECAD designs in Teamcenter.

By default, EDA uses the following acronyms to refer to electronic design objects on the user interface:

• PCA for printed circuit assembly or CCA for circuit card assembly (in earlier versions of EDA).

• PWB for printed wire board.

If your ECAD designers use different acronyms, the Teamcenter administrator can override the defaults
by creating custom text copies of the TC_ROOT\lang\textserverlocale\eda0_text_locale.xml file. For
each custom-name_text_locale.xml file, locate the following lines in the file, and edit the display text as
required:

<key id="Eda0_PCA">PCA</key>
<key id="Eda0_PCAToolTip">Printed Circuit Assembly</key>
<key id="Eda0_SCH">SCH</key>
<key id="Eda0_SCHToolTip">Schematic</key>
<key id="Eda0_PWB">PWB</key>
<key id="Eda0_PWBToolTip">Printed Wire Board</key>
<key id="Eda0_Design_Metrics_key">Design Metrics</key>
<key id="Eda0_Cad_Baselines_key">CAD Baselines</key>
<key id="Eda0_Edm_Viewer_key">EDM Viewer</key>
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Note:

There is a separate locale file for each supported locale. The example shown is from the en_US
locale file.

For more information about customizing textserver file text, see the Teamcenter Server Customization
help on Support Center.

Configure the EDA client to use the Teamcenter EDA panels instead of Active
Workspace

By default, the EDA uses the Active Workspace panels for user actions such as open and save. You
can use Teamcenter EDA panels instead, if you prefer to or in case you do not have Active Workspace
installed. This can be done by setting the following preferences:

EDA_Use_ActiveWorkspace

This preference specifies whether to display the Active Workspace panels instead of the older client
panels in dialog boxes where available. The default value is set to True. To switch to Teamcenter EDA
client panels, change the preference value to False.

The default value is valid only if one of the following preferences is also defined to point to an Active
Workspace server.

• ActiveWorkspaceHosting.URL

• ActiveWorkspaceHosting.EDA.URL

If neither preference is defined, then the EDA_Use_ActiveWorkspace preference is ignored, and Active
Workspace is not used. If either one of these preferences is defined, ActiveWorkspaceHosting.URL
takes precedence and the default for value for EDA_Use_ActiveWorkspace is True.

EDA_Use_ActiveWorkspace_Open

This preference specifies whether to display Active Workspace panel in the Open dialog box instead of
the Teamcenter EDA client panel. The default value is set to True. To switch to Teamcenter EDA client
panels, change the preference value to False.

The preference EDA_Use_ActiveWorkspace must also be set to True to use this preference.

Managing and configuring Teamcenter preferences for design management

You can set system-wide preferences on the Teamcenter server that apply to all EDA users. To
understand how preferences work and to understand how to access a list of all supported preferences,

Configure the EDA client to use the Teamcenter EDA panels instead of Active Workspace
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refer to the Managing Preferences help on Support Center. All EDA preferences begin with the prefix
EDA.

1. Run the rich client on the Teamcenter server and log on as an administrator.

2. In My Teamcenter, choose Edit→Options.

3. At the bottom of the Options dialog box, click Index.

4. In the Preferences dialog box, search for the preferences that begin with EDA_.

5. Change the preference value and click the Modify button to save the new value.

Installing the EDA client for design management on the ECAD
workstation

Install the EDA client for design management

Use the tem.bat command from the Teamcenter software kit to launch Teamcenter EDA Environment
Manager (TEM) to perform installation and maintenance operations of Teamcenter EDA on an ECAD
workstation for design integration.

TEM is available with the Teamcenter installation or upgrade images. Contact your Teamcenter
installation administrator to obtain the correct product distribution image.

Caution:

Before installing the EDA client on your ECAD workstation, refer to all the prerequisites and the
information required to install the client in the Planning your deployment topic.

1. Ensure that the proper version of JRE is installed and the JRE_HOME environment variable (32-bit
system) or the JRE64_HOME environment variable (64-bit system) is set.

2. Extract the Teamcenter software distribution image to a temporary location.

3. Specify the path to the Java Runtime Environment (JRE) by setting the JRE_HOME environment
variable on the ECAD workstation.

You can also specify the JRE path when you launch TEM from the command line using the -jre path
argument.

4. Start TEM.

a. Browse to the root directory of the extracted Teamcenter EDA software distribution image.
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b. Right-click the tem.bat program icon and choose Run as administrator.

TEM launches and displays the Installer Language panel.

c. In the Installer Language panel, select a language and click OK.

TEM displays the Welcome to Teamcenter EDA panel.

Your language selection applies only to the TEM session and not the Teamcenter EDA
installation.

5. In the Welcome to Teamcenter EDA panel, click Install.

6. In the Configuration panel, type the configuration ID and the description for the new Teamcenter
EDA configuration.

The configuration ID identifies your Teamcenter configuration when you maintain, upgrade,
uninstall, or add features to the configuration. Installation log files are also named based on this ID.

7. Proceed to the Features panel and click Next.

8. Expand EDA Client and select the required options:

• ECAD Design Integrations

Select the design tool support you require. This integrates the design tool with the EDA client.
However, a separate installation of the design tool is required.

• Mentor PADS

• Mentor PADS Professional

• Mentor Xpedition Designer and Layout

• Teamcenter Gateway for EDA Design

• (Optional) EDA Translation

9. In the Installation Directory box, browse to a folder where the EDA client will be installed. For
example, type c:\EDA_client for Windows.

The client is installed to an eda subdirectory, for example, c:\EDA_client\eda (Windows). This
directory is known as TCEDAECAD_ROOT.

10. Click Next.

Install the EDA client for design management
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11. In the FCC Client Cache (FCC) panel, select Use new FCC and click Next.

12. In the FCC Parents panel, type the Host name of the Teamcenter server in the FCC Parents box.

13. In the 4-tier Server Configurations panel, type the IP address of the Teamcenter server in the
4-tier Servers box. For example:

http://host:7001/tc

Replace host with the server name.

14. In the EDA Client panel:

a. Change the path if needed in the Staging Location box.

You must enter the full path to the directory where the ECAD designs are saved on the client.
This directory is the working directory for EDA.

If a staging directory already exists, you can continue using the same directory or select
another folder as the staging directory.

Caution:

Do not use spaces in the cache or staging directory path. Some EDA functions do not
work if there are spaces in these paths.

b. Clear the Will this configuration be shared by multiple users? check box to create user
environment variables after installation. By default, the check box is selected to create system
environment variables.

c. Click Next.

15. Review the features selected in Confirmation panel and click Start.

The EDA client components are installed.

The Install panel confirms whether the installation is successful. If the installation is successful,
click Close. If the installation is unsuccessful, click Show Details and proceed as needed.

After the installation of EDA client is complete you must verify that the EDA client is installed correctly
and perform the configurations required to set up design management.

Additionally, you must further configure and customize your ECAD tool connector as per your
requirement.
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Verify the EDA client installation

Verify the EDA client installation by checking the following:

1. Ensure that Teamcenter client communication system (TCCS) services point to the Teamcenter
server with EDA server support.

2. The FMS fcc.xml file points to your Teamcenter server.

3. The FMS_HOME system environment variable is set and points to the location of the fcc.xml file.

4. The TCEDAECAD_ROOT user environment variable is set to your EDA directory (for example,
c:\EDA_client\eda on Windows systems).

The value of TCEDAECAD_ROOT is added to PATH.

5. The directory defined by the TCEDAECAD_ROOT user variable exists and is populated with files.

6. The relevant ECAD tool subdirectory exists (<TCEDAECAD_ROOT>\eda\.

If you are using PADS, verify that the PADS subdirectory exists. If you are using Xpedition, verify
that the Mentor_Expedition subdirectory exists.

7. The TCEDAClient.properties file in the TCEDAECAD_ROOT directory contains the values you
entered using the installation routine, for example:

URL=http://hostname:port/tc
StagingDir=staging-directory-location

Note:

When you first run EDA, the staging directories are created from the settings in the
TCEDAClient.properties file.

The paths of the staging directories contain double back slashes (\\) on Windows systems. For
example:

C:\\ecad\\EdaStaging

Setting up the EDA client for design management

Configurations required to set up the EDA client for design management

Before configuring the EDA client for design management, you must first enable the Teamcenter
menu in the ECAD tool user interface to access the Teamcenter menu within the design tool. This is a
one-time process.

Verify the EDA client installation
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After integrating Teamcenter menus within the ECAD tool user interface, perform the following
configurations on the EDA client for design management:

• Mapping reference designator attributes for your ECAD tools

• Configuring cache and staging directory

• Modifying default user properties in the TCEDAClient.properties file

• Set a flatter folder structure for saving ECAD design

• Modifying the default logging configuration

Integrate Teamcenter menus within the ECAD tool

Enable Teamcenter menu within the ECAD tool

To access the Teamcenter menu within the design tool, you must first enable the Teamcenter menu in
the user interface, which is a one-time process.

Before you enable the Teamcenter menus within the ECAD tool, verify that:

• The Teamcenter server is operational.

• The Teamcenter rich client is installed and functional in a four-tier setup.

• The ECAD tool installation is complete.

• The TCEDAECAD_ROOT user environment variable is created by the installer and that it points to the
directory where EDA is installed.

• The JAVA_HOME environment variable exists and points to a supported 32-bit or 64-bit JAVA
installation.

• The proper Mentor WDIR environment variable is set and that the folder exists.

To integrate Teamcenter menu on your design tool perform the following tool specific steps:

To integrate Teamcenter menu within Xpedition

To enable Teamcenter panels within the Designer or the Layout tools:

1. Open the Xpedition Designer or Xpedition Layout.

2. Click File→Data Management Integration→Teamcenter.

3. Integrating Xpedition or PADS or PADS Professional with Teamcenter EDA for design management

3-40  Xpedition and PADS Integration With Teamcenter, Teamcenter 2412
© 2025 Siemens



3. In the Teamcenter EDA Login window, specify the Teamcenter User ID and Server details for
integration.

The Teamcenter user must have either the Author or the Occasional User license to manage ECAD
design data in Teamcenter.

4. Click Login.

To integrate Teamcenter menu within PADS

Note:

PADS can be installed to create schematics using either PADS Logic or PADS Designer. This
depends on which design flow is selected during PADS installation. The instructions below are
for PADS logic support.

Refer to the instructions explained below for PADS Professional flow integration with Teamcenter
to set up PADS Designer for PADS.

1. Customize the PADS application by completing these steps. This is a one-time procedure.

a. Create Windows shortcuts to the launching scripts located in %TCEDAECAD_ROOT%
\PADS\wnti\bin.
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Tip:

You can save these shortcuts on your desktop for easier access.

b. Launch PADS Logic and choose Tools→Basic Scripts→Basic Scripts.

c. Click Load File and browse to the Teamcenter.bas customization script located in the
%TCEDAECAD_ROOT%\PADS\wnti\vb directory.

d. Click Open and choose the In Menu command.

e. Click Close.

f. Launch PADS Layout and customize it in the similar way.

2. From PADS Logic and PADS Layout, choose Tools→Basic Scripts→Teamcenter to display the
Teamcenter palette menu in PADS.

The palette menu appears at the top of the PADS editing window. You can select any of the
Teamcenter actions by choosing the menu commands.

You can remove the palette menu by clicking Close.

To integrate Teamcenter menu within PADS Professional

To use the setup option, the following steps can be followed to enable the EDA menu items. This
procedure must be followed in the cases where English is not both the local language and the displayed
language.

Designer with PADS Design Flow setup recommended procedure:

1. Launch PADS Designer tool.

2. Click Setup→Settings.

3. Select Run on Startup.

4. Enter the full path for the vbs file from %TCEDAECAD_ROOT%\psw\dxd\pswMenu.vbs.

This path must contain only the absolute path to the vbs file.

5. Click OK.

To bypass the use of the setup option and directly configure the pointers to the EDA menu items, the
following steps can be followed:
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PADS Designer setup alternate procedure

1. If WDIR does not contain a scripts.ini file, copy the scripts.ini file file from %TCEDAECAD_ROOT%
\psw\exp\wdir to WDIR.

2. If WDIR already contains a scripts.ini file, add the following lines to the end of the file (or to the
appropriate areas if the ViewDraw or Expedition PCB sections already exist within the scripts.ini
file file). The new entries must be arranged in numerical order with no duplicate numbers within a
section.

        [ViewDraw]
        Script#0=%TCEDAECAD_ROOT%\psw\dxd\pswMenu.vbs
        [Expedition PCB]
        Script#0=%TCEDAECAD_ROOT%\psw\exp\pswMenu.vbs

PADS Professional Layout tool does not provide a setup menu item to configure the path to the EDA
menu items. The installed scripts.ini file must be directly edited. The following steps must be followed.

PADS Professional Layout setup procedure

1. Edit the scripts.ini file located within the installed PADS Professional installation. The file is found at
<PAD Professional installation>\SDD_HOME\standard\automation\startup location.

2. Add the following lines to the end of the file (or to the appropriate areas if the ViewDraw or
Expedition PE areas already exist). The new entries must be arranged in numerical order with no
duplicate numbers within a section.

        [ViewDraw]
        Script#0=%TCEDAECAD_ROOT%\psw\dxd\pswMenu.vbs
        [Expedition PE]
        Script#2=%TCEDAECAD_ROOT%\psw\exp\pswMenu.vbs

Note:

The second section of the scripts.ini file file, the label is Expedition PE instead of Expedition
PCB.

Where both Xpedition and PADS Professional are installed, the scripts.ini file file can contain
both Expedition PE and Expedition PCB sections.

Additional connector configurations and customizations for design management

You must configure and customize your ECAD tool connector as per your requirement. Some
connectors have unique configuration files named settings.ini. All connector specific customizations
and configurations as well as the information about using the settings.ini files is explained in ECAD
tool customizations for design management section. The settings.ini file allows you to configure
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connector behavior. Some connectors include customization files that need to be copied into folders
within the installed ECAD tools. Information about these files is also explained in this section.

Verify the integration of ECAD tool with Teamcenter

You must verify that your ECAD tool is correctly integrated with Teamcenter and the Teamcenter menu is
enabled within the ECAD tool.

Designer

1. Launch Designer.

2. Verify that Teamcenter button shows up in the menu bar.

3. Open a sample project.

4. Open a sample schematic.

5. Click Teamcenter→Open. This will launch the Teamcenter Open dialog box.

6. Dismiss the resulting Teamcenter Open dialog box.

Xpedition Layout

1. Launch Xpedition Layout.

2. Verify that Teamcenter button shows up in the menu bar.

3. Open a sample project.

4. Open a sample layout.

5. Click Teamcenter→Open. This will launch the Teamcenter Open dialog box.

6. Dismiss the resulting Teamcenter Open dialog box.

PADS Layout

1. Launch PADS Layout using the provided launching script.

2. Open the Teamcenter menu.

3. Verify that the Teamcenter floating menu appears and contains Teamcenter action buttons.

4. Open a sample layout.
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5. Click Teamcenter→Open. This will launch the Teamcenter Open dialog box.

6. Dismiss the resulting Teamcenter Open dialog box.

PADS Designer

1. Launch PADS Designer.

2. Verify that Teamcenter button shows up in the menu bar.

3. Open a sample project.

4. Open a sample schematic.

5. Click Teamcenter→Open. This will launch the Teamcenter Open dialog box.

6. Dismiss the resulting Teamcenter Open dialog box.

PADS Professional Layout

1. Launch PADS Professional Layout.

2. Verify that Teamcenter button shows up in the menu bar.

3. Open a sample project.

4. Open a sample layout.

5. Click Teamcenter→Open. This will launch the Teamcenter Open dialog box.

6. Dismiss the resulting Teamcenter Open dialog box.

Mapping reference designator attributes for your ECAD tools

A reference designator identifies a component within a schematic design or on a printed circuit board.
The reference designator usually consists of one or two letters followed by a number, for example
R13, C1002. The number is sometimes followed by a letter, indicating that components are grouped or
matched with each other, for example, R17A, R17B. IEEE 315 contains a list of Class Designation Letters
to use for electrical and electronic assemblies. For example, the letter R is a reference prefix for the
resistors of an assembly, C for capacitors, and so on.

In the EDA client definition file (*usrdef.xml) you can find additional elements that are required
for mapping the ReferenceDesignator element with the PSOccurrence attribute. This process is
referred to as reference designator (RDN) mapping. One or more of these files are installed in the
TCEDAECAD_ROOT folder. Identify the appropriate *usrdef.xml files in your installation and modify it to
enable RDN attribute mapping for your ECAD authoring tools.
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Tip:

Save a copy of each original file in case you have problems or must revert to an earlier version,
without your modifications.

Caution:

Do not modify any other areas of these files.

The RdnAttrMapDefs subelement of the following sample *edadef.xml file contains additional
subelements to enable and configure RDN attribute mapping. You must add this set of elements to
your *usrdef.xml file in a specific order.

<?xml version="1.0" encoding="UTF-8"?>
<EDAClientDef
    application="mentorEDXDes"
    family="mentorEDX"
    className="com.teamcenter.edabase.DefaultEDAFactory"
    bomOptionModel="pcbOnly"
    enableVariants="true"
    supportsBaseBom="true"
    preserveSession="false"
    enableOpenRelatedDatasets="false"
    copyFilesInSaveAsCopy="false"
    allowVariantNameAsItemId="false"
    USASCIIRequired="true"
    enableDoNotKeep="false"
    allowUnsavedVariants="false"
    supportSpacesInStagingDir="true"
    enableEDAUIDs="false"
    forceCheckIn="true">

    <PrimaryDataType name="combined" datasetType="EDADesExpBrd">
        <Include>*.edx</Include>
        <Exclude>odb</Exclude>
        <Exclude>edif</Exclude>
    </PrimaryDataType>

    <IntermediateDataType name="schCad" datasetType="EDAGenSchem"/>
    <IntermediateDataType name="pcbCad" datasetType="EDAGenPCBCAD"/>

    <ViewableDataType name="xsch"  datasetType="SCHFATF"/>
    <ViewableDataType name="xfatf" datasetType="PCBFATF"/>

    <PreferenceDefs/>

    <RdnAttrMapDefs>
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        <!-- component instance attribute mapping example
        <RdnAttrDesign cadAttrName="Foobar" tcAttrName="<BOMLine 
property name or PS
            Occurrence Note property name>" isOccNote="<true or false 
depending on the
            specified Tc property type>"/>
        -->
        <!-- component instance constant value mapping example
        <RdnAttrConst  tcAttrName="< BOMLine property name or PS 
Occurrence Note
            property name>" isOccNote="<true or false depending on the 
specified Tc
            property type>" value="value0"/>
        -->
    </RdnAttrMapDefs>

    <TranslatorDef type="xfatf" translator="odb"/>
    <TranslatorDef type="xsch"  translator="edif200"/>

</EDAClientDef>

The suggested order of the first-level subelements of the EDA client definition file is as shown below:

Example:

PrimaryDataType
RelatedDataType
IntermediateDataType
ViewableDataType
PartitionDataType
IssueAttachmentDataType
PreferenceDefs
CallbackDefs
RdnAttrMapDefs
TranslatorDef
LibraryDef
EDAGatewayDef
MigrationDef
SaveOptionDefs
OperationData

Point to consider while mapping the reference designator elements with PSOccurence attributes:

• The RdnAttrMapDefs subelement contains examples that are commented out. Siemens Digital
Industries Software suggests that you leave the commented out subelement as examples and then
copy them to add mappings. Add one subelement for each mapping, making modifications as
needed.
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• The BOMLine property name or PSOccurrenceNote property name (tcAttrName) must be the name
of the Teamcenter BOMLine property to which the ECAD attribute value is mapped.

• The ECAD attribute name (cadAttrName) must be the name of an ECAD attribute that can be
extracted from the ECAD component occurrence or RDN.

• The RdnAttrDesign subelement of the RdnAttrMapDefs element defines a mapping from an ECAD
attribute name to a Teamcenter PSOccurrence property or PSOccurrenceNote property name.

• The Teamcenter property must have write access for all ECAD designers. Otherwise, a write access
error is reported during BOM creation or update.

• The Boolean (isOccNote) value simply indicates that the Teamcenter property name is a
PSOccurrenceNote property.

• You must add one RdnAttrDesign subelement for each ECAD occurrence attribute that you want to
map to a BOMLine property.

• The RdnAttrConst subelement of the RdnAttrMapDefs element defines a Teamcenter BOMLine
property or PSOccurrenceNote property that is set to the string specified by the value attribute. You
may not need to define any mappings of this type.

Once you modify the *usrdef.xml file, and before you install it, drag it on to your browser. This verifies
that you have not introduced any XML syntax errors into the file. If there are any errors, your browser
displays an error message. Do not install the modified file until the browser verifies that it is clean, with
no errors or warnings.

Configuring cache and staging directory

Understanding how cache and staging directory works

The cache and staging directories temporarily store data as the ECAD designs move between the design
tool and Teamcenter. Occasionally, designers may need to refresh a design to synchronize the local copy
of the design with the latest version in Teamcenter. Alternatively, they may need to clear the cache to
remove all local copies of the designs that they are not working with. EDA uses a staging directory for
the local storage of ECAD designs and the cache directory for storing the temporary data.

The EDA cache directory may be created under the staging directory, or it may be created under the
user's home directory, depending on the configuration.

The EDA staging directory holds designs for checkin and checkout with Teamcenter. The first
time you choose a command on the Teamcenter menu, the staging directory is created
automatically. The staging directory path is based on the staging directory setting in the
TCEDAECAD_ROOT\TCEDAClient.properties file. The current OS username may be added to that value
as a subfolder and that path is written to a new user-specific TCEDAClient.properties file in the
USER_HOME directory.
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In the TCEDAClient.properties file, the environment variable EDA_StagingDir takes precedence over
the StagingDir property. The EDA_StagingDir environment variable must be defined as a full path and
not a relative path to an existing folder that the user has access to or to a folder that the user can create.

How to configure the checkout of files in EDA

When the designer opens an ECAD design object for checkout, the EDA file services tools must know
both the source and the destination for the action. For a checkout, the source is where the data is
stored within the Teamcenter file system and is part of the metadata maintained by Teamcenter. The
destination is where the designer wants to store the date and therefore varies.

At a minimum, each workstation has a unique file system. For the EDA file system tools, the designer
must establish a fixed location known to EDA for these files. This fixed location is defined at the time of
EDA installation. The location is stored within a settings file that all EDA tools can access. During each
installation, you must specify where the staging directory is defined for that user and host.

Once this is done, the resulting action for a checkout from EDA is that the data source is a Teamcenter
server, and the data destination is specified by the user’s staging directory setting in an EDA settings file.
A different user can also access the same data items. In such a case, the destination is the accessing
user’s specified staging directory.

How to configure the saving of files in EDA

When the designer saves an ECAD object, the source can be any location in the user’s file system, but
the destination is always an EDA-provided location within the Teamcenter server. In practice, however,
different scenarios are possible. In the case of one ECAD product, a design may be stored within a single
file. In another ECAD product, the design data may be stored in multiple files. Many designers may wish
to include supplemental data included with the design files. For example, the designer may want to add
a readme file or add a specification document.

To allow designers to save additional files with the design data, EDA stores such files in a separate
container. Any files or file objects that are in this container are captured when the ECAD tool executes an
EDA Save, Save As or Revise action.

Capturing supplemental or hidden ECAD files

Some ECAD products use hidden or invisible files to hold properties or metadata for use by specific ECAD
products. EDA assumes that these files are hidden in the directory that contains the design data. EDA
uses this directory as a reference point for all its activities and for capturing supplemental or hidden
ECAD files. To avoid the possibility of duplicate names (same names for different objects) if multiple
designs are stored within containers in a common staging directory, each directory containing an ECAD
design must be given a unique name. The name of this directory must match (be the same as that of)
the design’s item ID, also known as the part number.

Understanding how cache and staging directory works
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Create cache and staging directories

The first time you select a command on the Teamcenter menu and log on, the cache and staging
directories are created automatically. The staging directory path is based on the staging directory
setting in the TC_ROOT\eda\TCEDAClient.properties file. The current operating system user name
may be added to that value as a subfolder and that path is written to a new user-specific
TCEDAClient.properties file in the USER_HOME directory. The cache directory is also created under
the staging directory.

1. Open the design tool.

2. Log on to Teamcenter:

a. Choose Teamcenter→Purge Working Files.

Teamcenter EDA Login dialog box is displayed.

b. Type your Teamcenter user name, password, and group, if applicable. A group is required only
if you want to log on to a group that is not your default group.

c. Click Login.

d. In the Purge Working Files dialog box, click Cancel.

When you do this for the first time, the cache and staging directories are created
automatically, displaying the folders, including the latest ones.

3. Choose Teamcenter→Logout.

You are logged off Teamcenter.

4. Verify that the cache and staging directories are created.

The directories are created from the settings in the TCEDAClient.properties file.

Teamcenter EDA staging directory conventions

Teamcenter EDA requires that you create and work on designs in the staging directory. If you have
already created designs in another directory, copy them to the staging directory and then work on them
exclusively from the staging directory. All design datasets including schematic, PCB, and simulation data
files must be saved in a single design root folder that is associated to a PCA item.

In the following examples, replace the first instance of username in the path with the operating system
user name, replace the second instance of username in the path with the Teamcenter user ID, and siteid
with the site ID of Teamcenter.

3. Integrating Xpedition or PADS or PADS Professional with Teamcenter EDA for design management

3-50  Xpedition and PADS Integration With Teamcenter, Teamcenter 2412
© 2025 Siemens



Follow these conventions:

• PADS

• Save physical designs under a pads staging subdirectory. For example, save the latest version as

c:\ecad\EDAStaging\username\username_siteid\pads\latest\itemId\brd

and open a specified version as

c:\ecad\EDAStaging\username\username_siteid\pads\nonLatest\itemId.pcb.rev.ver\brd

• Save logical designs under a pads staging subdirectory. For example, save the latest version as

c:\ecad\EDAStaging\username\username_siteid\pads\latest\itemId\sch

and save a specified version as

c:\ecad\EDAStaging\username\username_siteid\pads\nonLatest\itemId.sch.rev.ver\sch

• Xpedition

Save designs under an expedition staging subdirectory. For example, save the latest version as

c:\ecad\EDAStaging\username\username_siteid\expedition\latest\itemId

and open a specified version as

c:\ecad\EDAStaging\username\username_siteid\expedition\nonLatest\
itemId.pcb.rev.ver

Allow concurrent editing and saving of designs from staging folder into Teamcenter

ECAD designers can transfer check-out on an item in Teamcenter to a different user. This will allow the
other user to continue to work on the designs checked out by previous user from the same location and
then check in the designs as well. To allow this, you must set the StagingDir in TcEDAClient.properties
file to a shared folder on a network drive and set new properties that defines what type of cache to use
under which scenario.

Set the StagingDir in the TcEDAClient.properties file:

You can map a drive to a network folder and then you can set it to use that mapped drive as the staging
directory.

1. If required, you can map a network drive, for example, S drive to a shared folder on network, for
example, \\<machine_name>\Shared.
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2. Set the staging directory StagingDir in the TCEDAClient.properties file to the path of the mapped
drive.

Example:

StagingDir=S\:\\StagingDir

StagingDir=\\\\<machine_name>\\Shared\\StagingDir

Set a new properties in the TcEDAClient.properties file

Note:

The old CacheDir property is now obsolete and it will not be used even if included in the
TCEDAClient.properties file.

• CacheType

The new property CacheType must be set in the TCEDAClient.properties file. The valid values are
Local, Shared, and ClientServer. The default value is Local.

• Local: This is the type of cache used in previous versions of EDA. The physical cache will be at
%USERPROFILE%/Teamcenter/EDA/<TC_SERVER_SITE_ID>.

• Shared: This type of cache can be shared by more than one user. The connection to the cache
will be closed after each access so that the other users are not blocked. However, this can affect
performance on a network file cache. The physical cache will be under the staging folder in a
hidden folder name tcedacache.

• ClientServer: This cache can be accessed through a client-server environment. This cache can be
shared and it also provides better performance than the Shared option. However, the server must
be ON, before it can be accessed. The physical cache will be under the staging folder in a hidden
folder name tcedacache.

• CacheHost

This is a new property, but is only used if CacheType=ClientServer. It defines the host port for the
Derby server.

• CachePort

This is a new property, but is only used if CacheType=ClientServer. It defines the host IP address for
the Derby server

• Set Derby Client/Server
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When CacheType is set to ClientServer, user must start a Derby server on some machine for all the
clients to use. The clients will point to that server using the CacheHost and CachePort properties.

The server machine must be setup to allow inbound and outbound traffic on that port.
To allow port input/output

1. Go to Settings > Windows Defender Firewall.

2. Click Advanced settings.

3. Select Inbound Rules, then click New Rule….

4. Select Port then click Next.
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5. Keep TCP selected, enter Specific local ports, then click Next.
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6. Keep Allow the connection selected, then click Next.
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7. Leave all options about when the rule will apply checked, or set as required, then click Next.
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8. Specify a Name for the Cache Server, then click Finish.

Repeat the steps to create a similar outbound rule.

• Start Server

To start the cache server, install EDA client on the machine you want to run the server on. Open a
console and run the following commands:

set CLASSPATH=%TCEDAECAD_ROOT%\derbyshared.jar;%TCEDAECAD_ROOT%\derby.jar

java -jar %TCEDAECAD_ROOT%\derbyrun.jar server start -h <host> -p <port> -noSecurityManager

The host (-h ipaddr) option value must be replaced with the server machine IP address.

The port (-p port) option is optional, if not specified, port 1527 is used.
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Example:

java -jar %TCEDAECAD_ROOT%\derbyrun.jar server start -h 10.104.127.167 -p 1529
-noSecurityManager

Modify default user properties in the TCEDAClient.properties file

Caution:

Follow this process only if you must change the properties for the user, the cache directory,
or staging directory, this process can be followed. Siemens Digital Industries Software does not
recommend this method to switch back and forth between settings but only as a one-time change
that should be undertaken only if necessary.

1. Use the EDA client to check in all currently checked-out designs.

2. Use the EDA client to purge the cache.

3. Manually delete the cache and staging directories.

4. Edit the URL line in the TCEDAECAD_ROOT\TCEDAClient.properties file to point to the new server:

URL=http://hostname:port/tc
StagingDir=staging-directory-location

In the example, replace hostname with the name of the new server running in the thin client
environment, and replace port with the port number of that server.

Note:

The path of the staging directory must contain double backslashes on Windows systems, for
example:

C:\\ecad\\EdaStaging\\

5. Edit the %USERPROFILE%\Teamcenter\EDA\TCEDAClient.properties files to match the preceding
settings, as necessary.

Caution:

Any definitions in this file override the file in TCEDAECAD_ROOT even if you edit the
properties there.
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Set a flatter folder structure for saving ECAD designs

In scenarios where two or more designers work on a single ECAD design within a shared network while
saving the designs, multiple levels of folders are created based on the operating system user name,
Teamcenter user name-site ID, project ID, and so on. This causes the file to be nested deep within the
structure. This hierarchical folder structure is defined in the TCEDAECAD_ROOTTCEDAClient.properties
file.

To make this structure flatter and remove the multiple levels of folders, enable the EDAStagingDirLevels
property defined in this file. The new structure saved in the staging directory excludes the intermediate
folders based on the user's profile.

To enable this property, remove the # sign in the left most line where the property is defined.

Example:

By default, when a designer is working on an ECAD design, the files are saved in the staging
directory format:

C:\Staging\user\siteid\app\latest\ItemID

Remove all the multiple folders created while saving ECAD designs by enabling the
EDAStagingDirLevels property and the files will be saved in the staging directory format:

C:\Staging\view_<RevID>_PrjName for read-only and previous revision files.

C:\Staging\PrjName for WIP project.

Modifying the default logging configuration

You can examine EDA log files to troubleshoot problems. You can update the log4j.properties file that is
located in the TCEDAECAD_ROOT directory to change the default logging configuration.

In the log4j.properties file, you can update the log name, change log values, change the location of log
storage, and so on.

After making changes to the log4j.properties file, restart the EDA client.

The log files are stored in the location you specified in the log4j.properties file and are named as
$user_name_TcEDA.log.

The historical log files are named as $user_name_TcEDA.log_yyyy-mm-dd.log.

Note:

Some connectors also produce log files that cover details of their operation. Refer to the
settings.ini files within the installed connector for additional information.
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Customize the integration by adding additional command calls

EDA integrations uses the following commands while performing integration operations between
Teamcenter and ECAD tools. You can use these commands to customize the integration.

Use the edacli.bat file to access these commands. The edacli.bat file initiates a Java process that passes
the required arguments to the EDA integration. The edacli.bat file is located in the TCEDAECAD_ROOT
directory.

Syntax

edacli -command -application=application_name -status= file_name

Arguments

-command

Specifies the command to execute. The following commands are available:

Command Description

checkPartWorkFlow
Status

Displays the Workflow Status dialog box that shows the
status of your workflow requests.

getMyWorklist Displays the My Worklist dialog box that shows your
workflow tasks.

logout Logs you off Teamcenter after displaying the Logout dialog
box.

Note:

The logout command only releases the Teamcenter
license. To release ECAD tool license, use the ECAD
tools.

logoutNoConfirm Logs you off Teamcenter without the Logout dialog box.

Note:

The logout command only releases the Teamcenter
license. To release ECAD tool license, use the ECAD
tools.

purgeCache Displays the Purge Working Files dialog box.

The Purge Working Files command allows you to clear the
cache of the designs that are not checked out.
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-application

Specifies the application name representing the ECAD tool. This value specifies which configuration
file to use.

The following applications are available:

Command Description

expeditionPcb Xpedition and Designer

padsPcb PADS Layout

padsSchematic PADS Logic

-status

Specifies the full path for the EDA status file that the common client creates.

The common client writes status information to this file. The status is either success or failure. If the
status is failure, the common client displays a failure message.

ECAD tool connector configurations and customizations for design
management

Overview of additional customizations required for your ECAD tool

After the configurations required to set up design management on the EDA client are complete you must
further configure and customize your ECAD tool connector as per your requirement. Refer to:

• Connector configurations and customizations for PADS Professional and Xpedition

• Connector configurations and customizations for PADS Layout and PADS Logic

Connector configurations and customizations for PADS Professional and
Xpedition

Customizing ECAD tool menus for Active Workspace

Teamcenter Active Workspace panel is supported from within the EDA client panels. If this is configured,
the design workflow and workflow status menu items can be instead accessed from the Teamcenter
design info menu item. In such a case, these two menu items can be removed from the user interface.

To remove the Design Workflow and Workflow Status menus from PADS Professional Flow and
PADS Designer with PADS Design Flow:

Overview of additional customizations required for your ECAD tool
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1. Revise your %TCEDAECAD_ROOT%\psw\dxd\pswMenu.vbs file for PADS Designer.

2. Replace the following lines:

addButton4 menu, "&Workflow",_
                     "&Design Workflow...",   
"pswDesignWorkflow.vbs",_
                     "&Part Workflow...",     
"pswInitiateWorkflow.vbs",_
                     "&Workflow Status...",   "pswWorkflowStatus.vbs"

with the following lines:

addButton menu,  "Part &Workflow...",     "pswInitiateWorkflow.vbs"

To remove the Design Workflow and Workflow Status menus from PADS Professional Flow:

1. Revise your %TCEDAECAD_ROOT%\psw\exp\pswMenu.vbs file for Xpedition PCB.

2. Replace the lines:

addButton4 menu, "&Workflow",_
                     "&Design Workflow...",   
"pswDesignWorkflow.vbs",    
                      "design_wf_16.bmp",_
                     "&Part Workflow...",     
"pswInitiateWorkflow.vbs",  
                      "library_wf_16.bmp",_
                     "&Workflow Status...",   
"pswWorkflowStatus.vbs",    
                     "processstate_16.bmp"

with the following lines:

addButton menu,  "Part &Workflow...",     
"pswInitiateWorkflow.vbs",  
                      "library_wf_16.bmp"

To enable the Design Info, Workflow, and Inbox menus where the Active Workspace panels are not
activated:

1. Revise your %TCEDAECAD_ROOT%\psw\dxd\pswMenu.vbs file for PADS Designer.
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OR

Revise your %TCEDAECAD_ROOT%\psw\exp\pswMenu.vbs file for Xpedition PCB.

2. Retain the following lines:

addButton4 menu, "&Workflow",_
                     "&Design Workflow...",   
"pswDesignWorkflow.vbs",    
                     "design_wf_16.bmp",_
                     "&Part Workflow...",     
"pswInitiateWorkflow.vbs",  
                     "library_wf_16.bmp",_
                     "&Workflow Status...",   
"pswWorkflowStatus.vbs",    
                     "processstate_16.bmp"

Replace other Teamcenter menu options with the following lines:

    addButton menu, "Inbox...",              
"pswWorkflowWorklist.vbs",  
                       "inbox_16.bmp"

    addButton menu, "Design Info...",        
"pswShowDesignInfo.vbs",    
                       "information_16.bmp"

    addSeparator menu

    addButton4 menu, "&Workflow",_
                     "&Design Workflow...",   
"pswDesignWorkflow.vbs",    
                        "design_wf_16.bmp",_   
                     "&Part Workflow...",     
"pswInitiateWorkflow.vbs",  
                        "library_wf_16.bmp",_
                     "&Workflow Status...",   
"pswWorkflowStatus.vbs",    
                        "processstate_16.bmp"

    addSeparator menu

Customizing ECAD tool menus for Active Workspace
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Disable availability of Variant Manager to perform Save, SaveAs, or Checkout actions on
design files

When a save, save as, or checkout action is attempted on design files, the EDA connector cannot identify
initially if the designs are created with or without variants. To determine if variants are defined, the
connector starts Variant Manager and searches for them. However, if you do not have a Variant Manager
license, this process fails.

To work around the issue of a missing license or working with a license with limited capabilities, the
connector must be customized to ignore the check for variants. This customization must be done in
the%TCEDAECAD_ROOT%\expeditionPcb_usrdef.xml configuration file.

Specifically, modify the enableVariants property to False in the configuration file to ignore the search
for design variants. This file is for both boards and schematics.

Note:

The padsDxSchematic_usrdef.xml file is located at the same location as the other configuration
files and must not be modified.

Configure connector behavior for Designer, Xpedition PCB, and PADS Professional

The setting.ini file allows you to configure connector behavior for Designer, Xpedition PCB, and PADS
Professional. PADS layout does not include this feature. This file contains values that are accessed by
identifiers, also referred to as keys.

The setting.ini file can be found at the following locations:

• For Designer: %TCEDAECAD_ROOT%\psw\dxd\settings.ini

• For Xpedition PCB: %TCEDAECAD_ROOT%\psw\exp\settings.ini

You can perform the following configurations or customizations using the setting.ini file:

• Control component extraction in Partlister

• Control BOM values

• Review configuration file limitations

• Design Reference Designator Name

• Partlister delimiter

• Enabling logging
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Control component extraction in Partlister

The Designer tools use a component extraction process that uses the Partlister tool. This tool is
configured to only extract specified attributes of components and map the ECAD tool internal attribute
names with the names as specified in the setting.ini file.

The configuration file can be found at the following locations, with the file name depending on tool
version:

• For Designer with Xpedition Design Flow: %TCEDAECAD_ROOT%\psw\dxd\partlister.v2.xml

• For PADS Designer with PADS Design Flow: %TCEDAECAD_ROOT%\psw\dxd\partlister.pads.xml

• For PADS Designer with PADS Professional Flow: %TCEDAECAD_ROOT%\psw\dxd\partlister.v2.xml

The only entries that should be changed are those related to the names of the extracted attributes. In
these files, look for the lines for column specification and having a type of PROPERTY.

They are similar to the following snippet:

    <Column type="PROPERTY" property="Ref Designator" label="REFDES"
        width="15" key="PRIMARY" sort="ASCENDING" display="Full"/>
    <Column type="PROPERTY" property="Part Number" label="PART_NUMBER"
        width="13" display="Full"/>
    <Column type="PROPERTY" property="Package" label="PKG_TYPE"
        width="15" display="Full"/>

The tag property defines the internal ECAD tool attribute name and the tag label defines the external
attribute name. The label value must match the definition within the settings.ini file.

Control BOM values

The settings.ini file contains several keys prefixed with the word part. These attributes control which
values are written from Designer into the edabom.xml file and sent to Teamcenter. The following table
describes which key affects which attributes. The values you specify must match the values generated
by the Partlister xml files. These values are only for the Designer connector. Xpedition PCB cannot be
configured using this method.

.ini file key Edabom element Edabom attribute
part.name Component Name
part.itemid Component itemId
part.revision Component itemRev
part.qty Component Qty
part.refdes Rdn Name

Configure connector behavior for Designer, Xpedition PCB, and PADS Professional
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Review configuration file limitations

Each user or user company may use different names to define properties that are to be passed to
Teamcenter. It is important that the configuration files described here are reviewed and corrected if
necessary prior to putting Teamcenter into production use.

Design Reference Designator Name

Within the Xpedition and PADS tools, each part instance is assigned a unique externally visible identifier.
This is called a Reference Designator. Some tools refer to this identifier as REFDES while other tools refer
this identifier as Ref Designator. To support the use of either of these names, an entry in the settings.ini
file allows the user to specify the proper name to use within their environment. This setting can be
found in the following line:

part.refdes=REFDES

The schematic and board tools can define independent names for this identifier. The names entered
in the settings.ini file must match the names entered in the Partlister configuration files found at the
location %TCEDAECAD_ROOT%\psw\dxd.

Partlister delimiter

The input.delimiter key specifies the delimiter used in the output file produced by partlister. This value
must match the value specified in the Partslister configuration xml files described above.

Enabling logging

The log.file key controls connector logging. If log.file is set to a non-blank value, the connector will
write logging information to the specified path and file. This information can help diagnosing connector
issues.

Configure viewable file generation

The PCB portion of the Teamcenter EDA Connector for Xpedition and PADS Professional is configured to
work with ODB++ files. The schematic viewable generator is preset to work with edif200 files. Your ECAD
tools may require additional licenses to generate any viewable file types.

The processing of ODB++ files can be performed either in automatic or manual mode. The ECAD tools
require an xeautoextended license to enable the EDA connector to automatically generate the ODB++
files. These files can also be manually created using just the base licenses. Because of this need for
an additional license, the connector has been developed to work with either automatic ODB++ file
generation or to work with ODB+ files manually created before saving the designs to Teamcenter.
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Generating ODB++ files manually

1. The ODB++ files can be manually generated from within the layout tool by selecting
Output→ODB++.

2. In the ODB++ creation dialog box, specify the path for the output files as .\Output\ODBpp\. This
indicates the ODB output folder within the design's PCB folder.

3. Specify the job name for the ODB++ files within the connector software as designodb.

4. Select the Compress Output option.

5. The generated viewable data must be contained within a single file for the Teamcenter translation
tool. Therefore, the ODB++ data (multiple files) must be compressed into a single TGZ file.

The path to the resulting file is <design>\PCB\Output\ODBpp\designodb.tgz.

Generating ODB++ files automatically

1. The ODB++ generation engine requires a configuration file that specifies all the characteristics of
the content of the generated files.

2. To allow the ECAD tools to indicate the information that it requires to properly generate the ODB++
files, the EDA connector assumes that the user has executed the ODB++ engine at least once and
saved the resulting specification files.

3. For this to happen, the user must run the Output→ODB++ menu item from within either layout
tool and set all the required configuration items.

4. The job name for the ODB++ files is hard-coded within the connector software as designodb.

5. Select the Compress Output option.

After performing the ODB++ file generation manually once, the user can then switch to automatic
generation.

Note:

The configuration files are stored within the PCB design data, so this manual setup must be
performed once for each design.

Defining the TcEdaUID attribute in Designer

EDA includes a new attribute, TcEdaUID, on BOM components. This attribute must be defined in
Designer, and passed between Designer and Xpedition and/or PADS.

Defining the TcEdaUID attribute in Designer
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Define TcEdaUID attribute in Designer property definition list

Launching the property definition editor can be done in one of two ways. Launch either xDM Library
Tools or Library Manager, as appropriate:

1. From within Designer:

a. Launch Designer.

b. Open the target active design.

c. In the menu bar, select Tools→Library Tools.

d. Go to step 4.

2. From Windows Start Menu:

a. Select the proper Xpedition version.

b. Select Data Management.

c. Select Library Tools.

d. Open target Central Library.

e. Go to step 4.

3. In the xDM Library Tools (or Library Manager) menu bar:

Select Tools→Property Definition Editor.

4. In the Property Definition Editor window:

a. Click the Add a property button.

b. Select:

• The first column checkbox

• Type User

• Name TcEdaUID
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• Format Character String

c. Click OK.

d. Save and close all active windows.

After the change to the Property Definition Editor, this change must be propagated to existing
designs that are or will be managed by Teamcenter. To get the added property into an existing
design, the user can either select Tools→Update Libraries and it reloads the library PRP file, or if
Designer is closed and reopened, the library PRP file is reloaded.

If a new design is created, this added property will be imported from the central library.

Note:

The added property should be added to each central library that may be used in design work.

Enable passing of TcEdaUID attribute to PADS Layout - To use with Designer - PADS Flow
only

To enable passing of the TcEdaUID attribute from PADS Designer to PADS Layout, you must modify the
PADS configuration file used by the Partlister.

1. Edit the file %SDD_HOME%\standard\pads94.cfg or %SDD_HOME%\standard\pads95.cfg.

2. Add the following line at the end of the General section:

PKG TcEdaUID

An alternate configuration method is to create a unique configuration file for each user.

1. Make a copy of the file %SDD_HOME%\standard\pads94.cfg or %SDD_HOME%
\standard\pads95.cfg.

2. Edit the copy as indicated above.

3. For each user, go to Designer→Setup→Settings→Project→PCB Configuration.

4. Edit the config file path to point to the copied file.

Occurrence Attribute Mapping

Depending on what occurrence attribute mapping is required, edit the %TCEDAECAD_ROOT%
\eda\padsDxSchematic_usrdef.xml file.

Occurrence Attribute Mapping
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Considerations when working with multiple ECAD tools

Designer and Xpedition work on a shared database model for storing EDA information. This allows users
to work on a single design from multiple tools simultaneously. However, Designer and Xpedition work
differently for saving and opening ECAD files. This can create issues when the designer works on the
same design files using the different ECAD tools.

Saving designs using different ECAD tools

Designer automatically saves designs into the database as soon as any changes are made. With
Xpedition, designers must periodically save their changes.

Consider a scenario where the designer is working in Xpedition and does not save the design file. The
designer then opens the same design in Designer. As soon as the changes are made in Designer, the files
are automatically saved to Teamcenter. However, these design files will not have all the latest changes
made in Xpedition. Hence, while working on the designs using different ECAD tools, users must make
sure that the designs are saved every time any changes are made.

Opening designs using different ECAD tools

The shared database is locked when any tool is active. This can be an issue when the designer wants
to check out a dataset from Teamcenter into a directory where multiple tools are operating. In cases
when only one ECAD tool is used, the connector downloads a zip file into the design directory, closes the
current design, unzips the file, and then reopens the design.

In scenarios where multiple ECAD tools are in use, the shared database is in a locked state, and the
files will not unzip. When the connector attempts to unzip a design, it warns the user that the shared
database will be overwritten.

Saving BOMS

During a save operation, such as save, save as, or check in from the ECAD tool, the designer is prompted
to save a bill of materials. Regardless of the tool being used, user can choose either a PCB BOM, or a
schematic BOM, or no BOM option.

Xpedition can produce both a layout BOM and a schematic BOM. It produces the schematic BOM
through the ECAD tool, Partlister.

Although the layout BOM option is prompted when you save the designs from the schematic tool,
Designer is only capable of producing a schematic BOM, which is done through the ECAD tool, Partlister.
If a user chooses to save a PCB BOM from Designer, a message is displayed that Designer cannot
generate the PCB BOM. The options displayed for the users would be to generate either a schematic
BOM or no BOM.

It is assumed that the schematic BOM gives the most accurate view of the materials associated with the
design.
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The following table summarizes which BOMs can be generated.

ECAD tool
Schematic
BOM

Layout
BOM

Xpedition PCB Yes Yes Only in Xpedition Flow or PADS Professional Flow or PADS
VX FlowDesigner Yes No

PADS Logic Yes No Only in PADS Flow

More information about how these files are generated in
the Xpedition and PADS Design Management help.

PADS Layout No Yes

Considerations for creating packaging

The generation of a valid BOM is dependent on component identification being valid. For the scenarios
where the user has added or removed components, the user must ensure that the design has been
packaged again. If the designs are not packaged after the components are added or removed, the
component reference designators may not be correct and the generated BOM will not reflect the latest
changes.

Considerations for saving design viewables in Teamcenter

The following table summarizes which viewables can be generated with which tools:

Schematic viewable Layout or PCB viewable
Xpedition PCB Yes Yes Only in Xpedition Flow

or PADS Professional
Flow or PADS VX Flow

Designer Yes No

PADS Logic Yes No Only in PADS Flow

More information about
how these files are
generated in the
Xpedition and PADS
Design Management
help.

PADS Layout No Yes

Considerations for Xpedition VX integration with the EDA client

If EDA client version 2.4 or a later version is installed on your ECAD workstation and the system
environment variable %TCEDAECAD_ROOT% is set, the user need not add the EDA menu items manually.
Designer and Xpedition have a built-in menu for EDA operations.

To enable the EDA menu, open Designer, select File→Data Management Integration→Teamcenter.

Follow the same steps for Xpedition to enable EDA menus. Do not configure EDA menu items again,
otherwise multiple EDA menus will be configured.

Considerations for creating packaging
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Note:

These steps are applicable for enabling EDA menus as the Active Workspace panels in the ECAD
tool. For the rich client panels, VB scripts are used to generate the menus.

Troubleshooting ECAD tool integration with Teamcenter

These are a few troubleshooting checks you can perform if the ECAD tool integration with Teamcenter
does not work properly:

Issues Action
Teamcenter menu does not show up in the
menu bar.

Verify that the scripts.ini file either does not
exist in WDIR folder or it does not contain the
required lines for the integration to work.

The environment variable WDIR was
previously shared between all Siemens EDA
products. It is now changed to allow each tool
version to have a unique WDIR location.

The Teamcenter EDA connectors do not
need to implement any changes to support
the WDIR update. However, each different
WDIR locations must contain a copy of the
ECAD tool scripts.ini file with Teamcenter
extensions.

You get an error when a menu item is
selected from the Teamcenter menu.

This means that the VBScript scripts copied
into WDIR do not contain the correct path to
EDA.

No BOM is generated during a save operation
when With BOM is selected

Make sure that the Partlister file is configured
to output a delimited file with a part number
attribute as one of the columns.

The delimiter in the file and the names of
the various columns must match up to those
specified in settings.ini.

Either Designer, Xpedition, PADS or their
related Teamcenter connectors do not launch
or report that they have license issues.

Make sure that the proper ECAD tool
and Teamcenter licenses are installed and
activated.

Connector configurations and customizations for PADS Layout and PADS
Logic

Customizing PADS Layout or PADS Logic menus for Active Workspace

Teamcenter Active Workspace is supported within the EDA client panels. If Active Workspace is
configured, the Design workflow and Workflow status menu items can be instead accessed from the
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Teamcenter Design info menu item. In that case, these two menu items can be removed from the user
interface.

To remove the Design workflow and Workflow status menus from PADS Layout or PADS
Logic:

1. Revise your %TCEDAECAD_ROOT%\PADS\wnti\vb\Teamcenter.bas file for PADS Layout or PADS
logic.

2. Search for comments with text Active Workspace and look for more instructions within the
comments to remove the menus.

Defining the TcEDAUID attribute in the PADS Layout attribute dictionary

EDA includes a new attribute, named TcEDAUID, on BOM components. This attribute must be defined in
the PADS Layout attribute dictionary, so that it will be included in ECO reports for backward annotation.
This must be done with an empty design, or one without a TcEDAUID attribute defined.

1. Click Edit→Attribute Dictionary.

2. Click New.

3. Enter attribute name as TcEdaUID.

4. On the Types tab, select Free Text.

5. On the Objects tab:

• Select Part.

• Select ECO Registered.

6. Click OK.

7. Click Close.

You must now save this updated attribute dictionary to a default startup file, so that it will be used in all
new designs that uses the same startup file.

1. Click the File menu and select Save as Start-up File.

2. Change the File name if required.

3. To save the updated attribute dictionary:

• Select Attributes section.

Defining the TcEDAUID attribute in the PADS Layout attribute dictionary
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• Enter a Startup File Description if required, for example, EDA.

• Click OK.

Back annotating from PADS Layout

PADS Layout to PADS Logic

Refer the PADS Layout Users Guide and Reference Manual, chapter Working with PADS Logic, section
Backward Annotating from PADS Layout to PADS Logic. You must use the first method, Automated
Backward Annotation Process or the third method, Creating the ECO File in PADS Logic.

Note:

The second method, that is, the creating the ECO File in PADS Layout method, will not work
because the TcEdaUID properties are updated programmatically, and will not be updated in the
ECO file created by Layout.

PADS Layout to PADS Designer

Refer the PADS Layout Users Guide and Reference Manual, chapter Working with Designer, section
Backward Annotating from PADS Layout to PADS Designer.

You can use any method, however, do not choose to use an existing ECO file. You must use a method
that creates a new ECO file using Netlist comparison.

Forward annotating from PADS Logic

Follow these steps to forward annotate from PADS Logic to PADS Layout:

1. Click the Tools menu and select PADS Layout.

2. Open the Design tab.

3. Select ECO To PCB.

4. Click Disconnect.

Setting up ECAD translation

ECAD translation modes

The following translation modes are supported for ECAD translation:

• Local translation
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The viewable file is generated locally. This option is available only on Windows clients.

• ECAD translation happens by default and is installed out-of-the-box and deployed locally on the
EDA client machines with the EDA Standalone Client TEM feature.

• You must edit the TCEDAClient.properties file located in the TCEADAECAD_ROOT directory to
update the path to the translation directory (Teamcenter EDA application root\emps\translation).

• Remote translation

The EDA integration initiates a remote translation of the intermediate file into a viewable format.

ECAD translation is embedded into the Teamcenter Dispatcher framework. Make sure that the
Dispatcher server and required translator are installed. After installing and setting up the
dispatcher you must enable the PcbToFatf translator.

If you select the Viewable check box while saving your EDA design, the following automatic
translation process takes place:

• The design intermediate file that can be parsed by the ECAD translator is extracted.

• The intermediate file is converted into a neutral file format: XFATF for PCB designs and XSCH for
schematic designs.

• The neutral file is saved as a viewable dataset in Teamcenter.

You can enable either the local translation mode or the remote translation mode. You may also enable
both these modes and control which mode to use by editing the EDA_PreferredLocalTS preference.

Enable PcbToFatf translator

After you install and configure Dispatcher as per the deployment strategy, you must enable the
PcbToFatf translator required for the remote translation of the intermediate file into a viewable format.

You can use TEM to install the translator or manually edit the translator.xml file to enable the
translator. For instructions on how to enable the PcbToFatf translator using TEM, see the Dispatcher
─ Deployment and Administration help on Support Center.

The following is an example of how to edit the translator.xml file to enable the translator.

Prerequisites: Verify that the TransExecutable dir is correctly specified for this translator.

1. Open the translator.xml file from the Dispatcher_RootModule\conf directory.

2. Set the isactive attribute to true to activate this translator.

Enable PcbToFatf translator
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Note:

By default, this attribute is set to false.

3. Open the translator.bat (Windows) from the
Dispatcher_Root\Module\Translators\translator_name directory and edit the CHANGE_ME tags.

For more information about CHANGE_ME tags, see the .bat file for the translator.

4. Run the translator in standalone mode from the command prompt to verify whether it is working
properly.

For more information about running the translator in standalone mode, from a command
prompt, change to the Dispatcher\Translators\translator_name directory and run the appropriate
command for your platform:

Note:

For more information, see the Readme file in the Translators\translator_name directory.

Windows: translator_name.bat -help

5. (Optional) To set up Dispatcher-client-proxy-user as the owner of the translated files, make the
following change to the translator_name.bat (Windows) file.

NxTransDirect translator example:

"%UGII_BASE_DIR%\ugmanager\run_nxtrans.bat" -u=Dispatcher-client-proxy-user 
-p=password 
-changeOwnerToCad=false "-pim=yes" %*

If you set up Dispatcher-client-proxy-user as the owner of the translated files, you must create a
dispatcher client access rule. For more information on how to create a dispatcher client access rule,
see the Dispatcher ─ Deployment and Administration help.

After installation, you must add a rule to the access rule tree permitting the translation service
proxy user to update attributes of a DispatcherRequest object. If this access rule is not created
correctly, the dispatcher client reports errors.

Supported translator services

Following translator services are supported in Teamcenter EDA:

• mentor

• pads
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• xpedition

Installing the ECAD viewer

ECAD Viewer displays separate ECAD views that help you navigate, search, and work with PCB designs,
schematic representations, and design for assembly and test output. You can use the ECAD viewer to
view the schematic and layout designs. The first steps to consider before you work with the ECAD Viewer
is to make sure your native ECAD files are translated to the XFATF or XSCH neutral file format. You can
also translate EDIF 2.0 and 3.0 schematic file formats to the neutral file format.

Installing the ECAD viewer is optional; if you do not want to use the ECAD viewer for design view and
markups, you can still use the EDA client to check in and check out designs between your ECAD design
tool and Teamcenter.

For more information about installing the ECAD viewer, see the Teamcenter Installation on Windows
Using TEM help.

For more information about using the ECAD viewer, see ECAD Viewer documentation on Support Center.

Installing the ECAD viewer
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4. Integrating EDM with Teamcenter EDA
for managing design files
Planning your deployment for EDM integration with Teamcenter

For installing and integrating Teamcenter with EDM for EDX design management, you must plan
your deployment and your environment setup. You can install the Teamcenter EDA server and client
components through Deployment Center or through TEM.

As an administrator, you must install the appropriate components on the server (Teamcenter) and client
machines (ECAD workstation - Xpedition or PADS) as per the site requirements as mentioned below:

Server components Requirements

Teamcenter server Teamcenter server is used to store and track the ECAD designs.

For information about the versions of operating systems, third-
party software, and Teamcenter software configurations that
are certified for the EDA platform, refer to the Hardware and
Software Certifications knowledge base article on Support
Center.

If you have an existing Teamcenter environment, you can
update it to support the latest EDA version.

Ensure that you download the compatible versions from
Support Center before starting your deployment.

EDA server support Teamcenter server is used to store and track the ECAD designs.
EDA server support is required to add ECAD data model to
the Teamcenter server environment. You must add EDA server
support on top of the Teamcenter environment.

As the EDA client is supported in a four-tier architecture, the
EDA Server Support feature (EDA data model) must also be
installed on a four-tier Teamcenter server.

Business Modeler IDE Business Modeler IDE is required to configure derived data for
EDA objects.

Before working with Teamcenter EDA objects in Business
Modeler IDE, you must install the EDA server support
features in Teamcenter Environment Manager (TEM). From
the Features panel, choose Extensions→Mechatronics Process
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Server components Requirements

Management→EDA for Business Modeler IDE. You must also
install the EDA Server Support template to your project.

Dispatcher Dispatcher is required for remote ECAD translations to translate
and save the design intermediate file into a viewable dataset in
Teamcenter.

If Dispatcher is already installed in your existing Teamcenter
environment, you can use the same instance. However, you
must modify it to include the translators that are specific to
ECAD translation.

Client components Requirements

EDA client EDA client moves designs between Xpedition and Teamcenter.
The EDA client must be installed on the ECAD workstation using
the Teamcenter software kit.

Before installing the EDA client, see the Hardware and
Software Certifications knowledge base article on Support
Center to identify which versions of the Xpedition are supported
on which versions of Teamcenter EDA.

Siemens Digital Industries Software recommends that you first
perform the installation on a test system to verify the parameter
values required for the installation on the ECAD workstations.
Prerequisites and requirements before installing the EDA
client:

• Supported Operating System:

The EDA client framework is supported only on the Windows
operating system.

• Supported Java version:

For information about the supported Java versions that
are certified for the EDA platform, see the Hardware and
Software Certifications knowledge base article on Support
Center.

• Software requirements specific to the ECAD tools on
which the EDA client should be installed:

• If you use Xpedition as the ECAD design tool, install
Xpedition Designer or Layout on the client workstations.

4. Integrating EDM with Teamcenter EDA for managing design files
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Client components Requirements

• Information required for EDA client installation from
Teamcenter installation administrator:

• FMS client cache (FCC)

If the FMS client cache (FCC) exists, use the existing one or
specify a new one.

• The FCC parent information for the EDA client, including
the host and port value

The minimum information required is the host name and
the port.

• The four-tier, middle-tier Web application server URL, and
the connection name for the EDA client

• Logon URL and the application ID To enable Teamcenter
Security Services

• Host name, port, and license server mode of the Siemens
Digital Industries Software common license server

Note:

Teamcenter software kit contains the 64-bit installer
for Windows system. You can select Win32 applications
directly from TEM or DC along with the rest of
the Win64 applications from within the Teamcenter
software kit.

• Other installation considerations

• Only the English versions of ECAD tools are supported.

• Item ID, variant name, dataset name, reference designator
value, and mapped attribute names and values must
contain only ASCII characters.

• The staging directory and all file names must contain only
ASCII characters.

EDM Server The EDM server administrator must perform configurations to
integrate Xpedition EDM with Teamcenter.

Planning your deployment for EDM integration with Teamcenter
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Workflow to install and setup Teamcenter EDA for EDM integration

Scenarios to deploy the Teamcenter EDA server and client components:

Using Deployment Center Using TEM

Install Teamcenter server
and the EDA client

Install Teamcenter server,
Install BMIDE, Install Dispatcher

Set up Teamcenter
server for design management

Set up Teamcenter
server for design management

Set up EDM integration Install the EDA client

Perform additional configurations
and customizations required

for EDM integrations
Set up EDM integration

Set up ECAD translation
Perform additional configurations

and customizations required
for EDM integrations

Set up ECAD translation

Installing Teamcenter server and the EDA client for EDM integration
through Deployment Center

The following procedures assume that you are installing EDA on an existing Teamcenter and that you are
familiar with Deployment Center.

Procedure

1. Log on to Deployment Center and select the environment to which you want to add Teamcenter
EDA .

2. Go to the Applications task. Click Add or Remove Selected Applications .

4. Integrating EDM with Teamcenter EDA for managing design files
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3. In the Available Applications panel, use the web browser search to find the Electronic
Design Automation (EDA) application. Select the application, and then click Update Selected
Applications.

Deployment Center automatically selects any additional dependent applications.

4. In the Available Applications panel, under EDA Client, select the required applications for
integrating Teamcenter EDA and Xpedition EDM for design management on the ECAD client
machine:

• (Optional) Select EDA Translation.

• Mentor Xpedition EDM Design

• Teamcenter Gateway for EDA

By default, all options under EDA Client are selected. Remove the tools and applications that are
not required for design integration and click Update Selected Applications.

Deployment Center automatically selects any additional dependent applications.

5. Go to the Components task.

6. In the Selected Components list of the Components task, note any remaining components whose
configuration status is not 100%. Select each incomplete component, enter required parameters,
and save component settings until all components in the environment show a configuration status
of 100%.

When all components are fully configured, the Deploy task is enabled.

7. Go to the Deploy task. Click Generate Install Scripts to generate deployment scripts you will use
to update affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.

8. Locate deployment scripts, copy each script to its target machine, and then run each script on its
target machine.

For more information about running deployment scripts, see Run the deployment scripts in the
Deployment Center documentation.

You can also generate mini-kits for mass client deployment. Running the generateMiniSoftware
utility extracts only the necessary software from the full software kits and builds a smaller, more
portable software kit for the specific client deployment. For more information, see Generating mini
kits for mass client installations in Deployment Center ─ Usage on Support Center.

Installing Teamcenter server and the EDA client for EDM integration through Deployment Center
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If you face any issues during the deployment, see Troubleshoot the deployment script in the
Deployment Center documentation.

Postrequisites

After the successful installation of the server and client components, you must configure the Teamcenter
server as well as perform the EDA client configurations for setting up EDM integration.

• To integrate EDM with Teamcenter EDA for design management:

• Set up Teamcenter server for Xpedition EDM integration

• Set up EDM integration

• Perform EDM tool connector configurations for Teamcenter integration

Installing Teamcenter server for EDM integration through TEM

Installing the Teamcenter server for EDM integration

Install Teamcenter

To install Teamcenter EDA, you must first install Teamcenter. To install the Teamcenter corporate server,
refer to the Teamcenter Installation on Windows Using TEM help.

If you have an existing Teamcenter environment, you can update it to support the latest EDA version.

Refer to the Install patches on a Teamcenter server topic in the Teamcenter Installation on Windows
Using TEM help for instruction on installing Teamcenter patches.

Add EDA support on the Teamcenter server for design management

EDA server support adds the EDA data model to the existing Teamcenter data model.

Before installing the EDA server support, you must install the Teamcenter server.

1. From your Teamcenter environment, start Teamcenter Environment Manager (TEM).

2. Select the Configuration Manager option to perform maintenance on an existing installation and
click Next until the Select Features dialog box appears.

3. In the Select Features dialog box:

a. Select the following options:

4. Integrating EDM with Teamcenter EDA for managing design files
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• Choose Extensions→Mechatronics Process Management and select EDA Server
Support.

• Choose Extensions→Mechatronics Process Management and select EMPS-Foundation.

• Choose Extensions→Mechatronics Process Management and select EDA for Business
Modeler IDE.

• Specify Active Workspace server extensions features for EDA. These are available in the
Features panel in Teamcenter Environment Manager (TEM), under Base Install→Active
Workspace→Server Extensions→EDA Server Support for Active Workspace.

• Specify Active Workspace client extensions features for EDA. These are available in the
Features panel in Teamcenter Environment Manager (TEM), under Base Install→Active
Workspace→Client→Electronic Design Automation for Active Workspace.

b. In the Installation Directory box, type the location where you want to install Teamcenter
(TC_ROOT).

c. Click Next.

4. Enter information as needed in the subsequent panes.

5. In the Confirm Selections dialog box, click Next.

The EDA server components are installed.

The Add/Remove Components dialog box confirms if the installation is successful. If the
installation is unsuccessful, click Show Details and proceed as needed.

6. Obtain the license file that includes EDA licensing and EDA library license (for library support) and
install it on the server.

After adding the EDA server support to your Teamcenter environment, you must verify your installation
by checking whether the EDA data types are added to Teamcenter.

Verify your installation

Verify the addition of the EDA data types to the server:

1. Run the Teamcenter rich client.

2. In My Teamcenter, choose File→New→Item.

The New Item dialog box is displayed.

Verify your installation
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3. Verify that the EDA, EDAComp, EDASchem, and EDACCABase item types are added to the list of
types you can create.

4. Select one of the EDA item types and create an instance.

5. Verify that the item instance is created.

Install BMIDE to configure derived data for EDA objects

You must install Business Modeler IDE to configure derived data for EDA objects and to import the
sample BMIDE EDA server support template.

You can install BMIDE either as a stand-alone application or place the BMIDE plug-ins in an existing
Eclipse environment.

For instructions on installing BMIDE, refer to the Install the Business Modeler IDE topic or the Add the
Business Modeler IDE to an existing Eclipse SDK environment topic in the BMIDE for Data Model Design
documentation on Support Center.

Install or update Dispatcher for setting up remote ECAD translation

Teamcenter viewers can only process neutral ECAD formats, and depending on the workflow of your
environment, you may need to translate native ECAD PCB and schematic data to this neutral file format.

With ECAD translation, the design intermediate file from the Xpedition or PADS tool is converted into a
neutral file format (XFATF for PCB designs and XSCH for schematic designs). The neutral file is saved as a
viewable dataset in Teamcenter.

The following translation modes are supported for ECAD translation:

• Local translation where the viewable file is generated locally.

• Remote translation where the Teamcenter integration initiates a remote translation of the
intermediate file into a viewable format.

You require Dispatcher for remote ECAD translations only. You can install Dispatcher as a standalone
instance or in an existing Teamcenter environment. If Dispatcher is already installed in your existing
Teamcenter environment, you must modify it to include the PcbToFatF ECAD translator.

For instructions on installing Dispatcher, refer to the Dispatcher ─ Deployment and Administration
documentation on Support Center. After installing and setting up the dispatcher you must enable the
PcbToFatf translator.

4. Integrating EDM with Teamcenter EDA for managing design files
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Setting up Teamcenter server for Xpedition EDM integration

Configurations required to integrate Teamcenter with the Xpedition EDM

To integrate Teamcenter with the Xpedition EDM, you must configure the following on the Teamcenter
server.

Configuration Why is it required?

Populate the Teamcenter database with ECAD
components

Any component that does not already exist in
Teamcenter is automatically created when saving
the BOM.

Add EDA relations and EDA objects in Active
Workspace Relation Browser

To traverse EDA relations and show EDA objects
from the Active Workspace Relation Browser,
EDA information must be included in the Active
Workspace Relation Browser configuration.

Customizing ECAD attribute mappings Using mapping definition files, the ECAD part
attributes can be stored in the Teamcenter
database and displayed and modified both in the
ECAD design tool and Teamcenter.

Configure derived data for ECAD design objects Derived data contains information that is derived
from an ECAD design and comprises derived
items and datasets. Derived items represent
parts, subassemblies, and tools. Derived datasets
manage data files created by ECAD applications.

Configure design variants To design and develop a product with several
variations, where each variation has different
options or capabilities, you create design variants.
Creating design variants avoids the need to
create a unique version of the design for each
variation. A variant uses the same base design,
but the PCB assembly is loaded with the set
of components specified by the variation. You
can then select a variation when generating the
design’s manufacturing output (BOM, Pick and
Place (P&P), assembly drawings), which will in
turn determine how the product is assembled.

Allow ECAD designers to assign a Teamcenter
project from the EDA client

While saving a new or an existing EDA design from
the EDA client to Teamcenter, the ECAD designers
can assign or remove a Teamcenter project for
that design. The projects assigned to Printed
Circuit Assembly (PCA) objects are propagated
to all ItemRevisions and Datasets associated
with the PCA object based on the Teamcenter
propagation rule defined for that object. You can

Configurations required to integrate Teamcenter with the Xpedition EDM
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Configuration Why is it required?

also modify the OOTB propagation rules as per
your requirements.

Set configurations based on the ECAD
applications used

You can configure which preference values should
be used for a specific preference based on the
connectors configured for your ECAD design tool.
This configuration allows all EDA preferences to
be overridden by application-specific preferences,
if set.

Allow users to view the PCB board
requirements in Active Workspace

By default, ECAD designers can view the PCB
board requirements specifications related to the
design revisions in the Requirements tab in
Active Workspace for the EDACCABase and
EDASchem object types, by default. Users can
configure the Requirements tab for other item
revisions.

(Optionally) Enable single sign-on for
Teamcenter and Xpedition EDM server design
integration

Teamcenter Security Services eliminates the
need for multiple authentication challenges as
users move from one Teamcenter application to
another. It also provides a common framework to
integrate with a site's single sign-on solution. With
single sign-on configuration extended to the EDM
server, users can log on to Teamcenter when they
are logged on to the EDM client. Alternatively,
they can log on to the EDM client automatically
when the user is logged on to Teamcenter.

Set properties on EDM designs during design
review

You can configure Teamcenter to initiate a
workflow to allow ECAD designers to set
properties on the EDM designs during the review
process.

Customize the acronyms used for ECAD design
objects in Teamcenter

If your ECAD designers use acronyms different
from the default acronyms provided, the
Teamcenter configurator can override the defaults
by creating custom acronyms used for ECAD
designs in Teamcenter.

Managing and configuring Teamcenter
preferences for EDX design management

You can set system-wide preferences on the
Teamcenter server that apply to all EDA users.

Populate the Teamcenter database with ECAD components

Many companies control the ECAD component library items that can be used to create BOMs by
checking in the approved components for use to the database. Thereafter, you can create BOMs that
use these components.

4. Integrating EDM with Teamcenter EDA for managing design files
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You can configure how to:

• Control ECAD component library items for BOM creation.

To control component library items for BOM creation, when EDA is first installed, the
EDA_CheckComponentExistence is set to 1 (true). With this setting, you cannot save design BOMs
unless all the necessary components are already in Teamcenter.

• Populate the database with ECAD components before the designer can save designs and before
creating BOMs in Teamcenter using EDA.

You can initially populate the database with components by changing the
EDA_CheckComponentExistence preference to 0 (false). If this preference is set to 0, any
component that does not already exist in Teamcenter is automatically created when saving the BOM.

Caution:

Do not set this preference to 0 in a production environment.

1. Set the EDA_CheckComponentExistence preference:

a. Run the rich client on the Teamcenter server and log on as an administrator.

b. In the My Teamcenter application, choose Edit→Options.

c. At the bottom of the Options dialog box, click Filters.

d. In the Preferences dialog box, search for the EDA_CheckComponentExistence preference.

e. Click Edit and change the value of the preference from 1 (true) to 0 (false).

f. Click Save to apply the changes.

2. Locate or create designs that use the approved library components. Use the EDA Save As
command to save the designs to the Teamcenter server and create BOMs. When the BOMs are
created, the components are automatically added to the database.

For information about using the Save As command, see Saving designs to Teamcenter in the
Xpedition and PADS Design Management documentation.

3. Reset the EDA_CheckComponentExistence preference to 1 (true) if you want to restrict users
to using only the approved (and checked-in) components. This is the recommended setting in
production environments.

However, if you wish to allow new components to be automatically placed in the database when
users create BOMs, leave the EDA_CheckComponentExistence preference as is, set to 0.

Populate the Teamcenter database with ECAD components
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This action bypasses business processes for component evaluation and approval.

Add EDA relations and EDA objects in Active Workspace Relation Browser

To traverse EDA relations and show EDA objects from the Relations tab in Active Workspace, EDA
information must be included in the Relation Browser configuration. To do this, you must update the
RelationBrowserConf dataset in the RB_UIConfigure.xml file in the Teamcenter server configuration.

To enable the Relations tab to show relations between Teamcenter objects and objects in a remote
application, do the following:

1. In the Teamcenter rich client, search for the dataset RelationB*.

2. Right-click the RelationBrowserConf dataset and choose Check-InOut > Check-Out.

3. Right-click RelationBrowserConf dataset and choose Named References.

4. In the Named References dialog box, select RB_UIConfigure.xml and click Download.

5. Modify the RelationBrowserConf dataset in the locally downloaded RB_UIConfigure.xml file to
add EDA relations and EDA objects as follows.

=====================================================================
==
            Filename: RB_UIConfigure.xml
       
            File used to configure control panel of relation browser.
=====================================================================
==

 -->
        <RelationBrowser>
          <OptionPanel>
            <view name="General">
              <ruleName>GenericRule</ruleName>
              <defaultLayout>IncrementalHierarchic</defaultLayout>
              <group name="relations">
                   
                <filter name="EDA" parameterSet="EDARelations" 
color="(204,51,0)"/>
              </group>
              <group name="objects">
                   
               <filter name="EDA" parameterSet="EDAObjects" 
color="(204,51,0)"/>

4. Integrating EDM with Teamcenter EDA for managing design files
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               <filter name="Other" parameterSet="WorkspaceObject" 
color="(238,236,225)"/>
              </group>
            </view>
            <view name="System"> 
                 
               <parameterSet name="EDAObjects">
                  <clipsfacts>
                    <fact>EDACCABase</fact>
                    <fact>EDACCABaseRevision</fact>
                    <fact>EDASchem</fact>
                    <fact>EDASchem Revision</fact>
                  </clipsfacts>
               </parameterSet>
                 <parameterSet name="EDARelations">
                   <clipsfacts>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasDerivedDataset,targetDirection=forward,inputTypes=ItemRevision
</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasDerivedItem,targetDirection=forward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasPWB,targetDirection=forward,inputTypes=ItemRevision</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSchematic,targetDirection=forward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSchematic,targetDirection=backward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSublayout,targetDirection=forward,inputTypes=Dataset,outputTyp
es=Dataset</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasVariant,targetDirection=forward,inputTypes=ItemRevision</fact>
                     </clipsfacts>                     </
parameterSet> 
                 
            </view>
        </RelationBrowser>

6. Delete the original RB_UIConfigure.xml file from the Named References dialog box and import
the new RB_UIConfigure.xml file in Teamcenter.

7. Click Close.

8. Check in the RelationBrowserConf dataset.

Add EDA relations and EDA objects in Active Workspace Relation Browser
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Customizing ECAD attribute mappings

1. Open a Teamcenter command prompt.

2. Change to the bin directory within TC_ROOT. (TC_ROOT is the installed location of Teamcenter.)

3. Run the export_attr_mappings command to output the mappings to a file, for example:

export_attr_mappings –file=test_attribute_mapping –u=Tc-admin-user –p=password

4. Edit the mappings file to add EDA tool attributes.

Below are the OOTB attribute mappings for EDM design integration:

{ Dataset type="EDADesExpBrd"
    "tc_PCA_ID" : Item.item_id /master=iman /description="CCA Item 
ID"
    "tc_PCA_revision" : ItemRevision.item_revision_id /master=iman /
description="CCA Item Revision ID"
    "tc_PCA_description" : ItemRevision.object_desc /
description="CCA Item Revision Description"
    "tc_PWB_ID" : ItemRevision.GRM(EDAHasPWB).item_id /master=iman /
description="PWB Item ID"
    
"tc_PWB_revision" : ItemRevision.GRM(EDAHasPWB).item_revision_id /
master=iman /description="PWB Item Revision ID"
    "tc_PWB_description" : ItemRevision.GRM(EDAHasPWB).object_desc /
description="PWB Item Revision Description"
    "tc_exported_date" : last_mod_date /master=iman /
description="Last modified date"

}

To define any additional mappings, add the mappings under this dataset type.

5. Import the edited mapping file back into Teamcenter by running the import_attr_mappings
command, for example:

import_attr_mappings –file=test_attribute_mapping –u=Tc-admin-user –p=password

4. Integrating EDM with Teamcenter EDA for managing design files
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Example:

The below example defines dataset attribute mappings and variant attribute mappings. In this
mapping definition, the Item level attribute mapping definition defines the ECAD variant attribute
mappings and it is part of the dataset level attribute mapping definition.

ECAD variant mapping for your ECAD tool:

{ Dataset type="EDADesExpBrd"
ORGNAME : Item.GRM(IMAN_master_form,Item Master).user_data_1
ORGADDR1 : Item.GRM(IMAN_master_form,Item Master).user_data_2
"DES_NAME" : ItemRevision.object_name
"DES_DESC" : ItemRevision.object_desc
Doc : Item.GRM(IMAN_master_form,Item Master).user_data_3

    { Item type="Item"
        "variant_def_list_tc_description" : 
ItemRevision.object_desc /description="Variant Item Revision 
Description"
    }
} 

In above example, the attribute mappings are defined with respect to the dataset type
EDADesExpBrd. Using this dataset attribute mapping functionality, it is possible to map an ECAD
design attribute to a property with the Teamcenter object type. In this example, the ECAD attribute
ORGNAME is mapped to user_data_1 property of the item master form and ORGADDR1 is
mapped to user_data_2 property of the item master form in Teamcenter.

In above example, the attribute mappings are defined with respect to the dataset type
EDADesAltiumBrd. Using this dataset attribute mapping functionality, it is possible to map an
ECAD design attribute to a property with the Teamcenter object type. In this example, the ECAD
attribute ORGNAME is mapped to user_data_1 property of the item master form and ORGADDR1
is mapped to user_data_2 property of the item master form in Teamcenter.

Similarly, the ECAD attribute DES_NAME is mapped to object_name property of ItemRevision
and DES_DESC is mapped to object_desc property of ItemRevision in Teamcenter.

In the last line of above example, the attribute mappings are defined for the item type
Item. However, these mappings are applicable only to the dataset type EDADesExpBrd.
These mappings are not applicable for other dataset types. To define the attribute mappings
between the ECAD variant attributes and the Teamcenter variant object properties, the attribute
mappings must be defined on the Variant Item type. In above example, the ECAD variant
attribute variant_def_list_tc_description is mapped to object_desc property on ItemRevision
in Teamcenter.

The attribute mapping import and export process uses the PLM XML import/export mechanism. For
more information, see the Tc XML and PLM XML Configuration for Data Import and Export help on
Support Center.

Customizing ECAD attribute mappings
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For details on how to map ECAD attributes, see the Mapping attributes section in the Teamcenter
Integration for NX documentation.

To understand the correct syntax and symantics for mapping attributes to standard and custom item
types, see the Examples of Syntax and Symantics for Mapping Attributes topic in the Teamcenter
Integration for NX documentation.

Configure derived data for EDX design files

Understanding how derived data works

Derived data contains information that is derived from an ECAD design and comprises derived items and
datasets. Derived items represent parts, subassemblies, and tools. Derived datasets manage data files
created by ECAD applications.

You can configure how derived data is created in Teamcenter EDA by using the EDA Derived Data folder
in Business Modeler IDE, creating an EDA derived data configuration, and configuring how derived data
files are named in Teamcenter. For example, a configuration can specify that when a schematic design
is saved in Teamcenter EDA, a schematic drawing can be automatically generated from the schematic
design and saved along with the schematic item

EDA business objects define the different types of derived data you can generate. To locate EDA business
objects, use the Find button in the BMIDE view to search for all business objects containing the EDA
string.

The following item types are children of the EDA business object:

Item Types Description

EDACCABase Represents the common electrical CAD (ECAD)
design data that is shared between variant circuit
card assemblies (CCAs). It is used only for multiple
CCA representations.

EDAComp Represents electrical components contained in the
CCA bill of materials (BOM).

EDASchem Represents the electrical schematic item.

The following relationships are children of the ImanRelation business object:

ImanRelation Description

EDAHasDerivedDataset Identifies the associated dataset as a derived
dataset.

EDAHasDerivedItem Identifies the associated item as a derived item.

4. Integrating EDM with Teamcenter EDA for managing design files
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Configure how derived data files are named in Teamcenter

Update the value of the EDA_UseDerivedDataSubDirs preference based on how you want the derived
data files to be named in Teamcenter. The values are as follows:

• True

The derived dataset name is the same as the Derived Dataset Configuration Name.

• False

The derived dataset name consists of the parent item ID and an underscore (character) followed by
the Derived Dataset Configuration Name.

How to create an EDA derived data configuration

You can configure how derived data is created in Teamcenter by using the EDA Derived Data folder
in Business Modeler IDE. After creating a derived data configuration, you can specify the name of the
configuration in the EDA_DerivedDataConfigDefault preference.

1. In BMIDE, open the Extensions folder.

2. In the Extensions folder, right-click EDA Derived Data and choose New EDA Derived Data.

The New EDA Derived Data wizard is displayed.

3. In the EDA Derived Data dialog box, enter the following information and click Next:

Field Description

Name Specify a name you want to assign to the new
derived data configuration.

This is the name used in the
EDA_DerivedDataConfigDefault preference.

Description Type a description for the new configuration.

The EDA Derived Data Configuration dialog box in the wizard is displayed.

4. In the EDA Derived Data Configuration dialog box, set up how all EDA item and dataset types are
to be handled for all contexts.

a. Click the Add button next to the Configure Items table.

The Add/Edit EDA Derived Item Configuration dialog box is displayed.

Configure how derived data files are named in Teamcenter
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In the Add/Edit EDA Derived Item Configuration dialog box, configure the derived items
to be generated. For example, create separate rows for contexts such as schematic, PCB,
simulation, and so on, including variations based on the what the parent is, such as
Schematic, CCA, and CCAVariant. In this way, you set up how derived data is generated
for all combinations of items.

In the Add/Edit EDA Derived Item Configuration dialog box, enter the following information
and click Finish:

Field Description

Name Type the name that you want to assign to the derived
item configuration.

This is the name displayed to the user on the Teamcenter
EDA Derived Item dialog box during save operations.

Context Browse to select a specific Teamcenter EDA application
context from the contexts listed below. When users in
Teamcenter EDA save derived data for the following
specified data types, derived items are generated
according to this configuration.

• all

• pcb

• pcb/simulation

• schematic

• schematic/pcb

• schematic/simulation

• simulation

For PWB, if you have derived items and derived datasets
defined for both schematic and PCB, you must set the
preference EDA_DefinePWBWith to schematicANDpcb
so that the PWB and derived data can be exposed and
modified in both schematic and PCB tools. By default, the
preference value is set to Schematic.

Prefix (Optional) Type a file name string to be attached to the
beginning of the parent item ID to distinguish it as being
generated by this configuration.

The resulting string, including the prefix and postfix, is
used in the derived item user interface in Teamcenter
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Field Description

EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

Postfix (Optional) Type a file name string to be attached to the
end of the item ID to distinguish it as being generated by
this configuration.

The resulting string, including the prefix and postfix, is
used in the derived item user interface in Teamcenter
EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

EDA Parent Browse to select the derived parent EDA business object
to which the derived item is related. (Teamcenter EDA
does not support attaching derived items under other
derived items).

• CCA represents a circuit card assembly (CCA).

• CCABase represents the common design data that is
shared between variant circuit card assemblies (CCAs).
It is used only for multiple CCA representations.

• CCAVariant represents the variant design data for a
circuit card assembly (CCA). This is the data that is
used on top of the CCABase business object.

• PWB represents a printed wire board (PWB). A PWB is
the product of a schematic design and printed circuit
board (PCB) layout design and holds all the printed
wire board production data created by those designs.

• Schematic represents the electrical schematic item.

Relation Browse to select the relationship between the derived
item and the parent item revision.

The EDAHasDerivedItem business object and its children
are displayed in the selection dialog box.

Item Business Object Browse to select the business object type name for the
derived item, for example, EDA.

Add to Bom Select this option to add the derived item to the bill of
materials of the Teamcenter EDA parent. This check box is
disabled if the Teamcenter EDA parent is a schematic or a
PWB.

The derived item configuration is added to the Configure Items table.

How to create an EDA derived data configuration
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b. Click the Add button to the right of the Configure Dataset table.

The Add/Edit EDA Derived Dataset Configuration dialog box is displayed.

In the Add/Edit EDA Derived Dataset Configuration dialog box configure the derived
datasets to be generated. For example, create separate rows for contexts such as schematic,
PCB, and simulation, including variations based on the what the parent is, such as Schematic,
CCA, and CCAVariant. In this way, you set up how derived data is generated for all
combinations of datasets.

In the Add/Edit EDA Derived Dataset Configuration dialog box, enter the following
information:

Field Description

Name Type the name that you want to assign to the derived
dataset configuration.

This is the name displayed to the user on the Teamcenter
EDA Derived Dataset dialog box during save operations.

Context Browse to select a specific Teamcenter EDA application
context from the contexts listed below. When users in
Teamcenter EDA save derived data for the following
specified data types, derived datasets are generated
according to this configuration.

• all

• pcb

• pcb/simulation

• schematic

• schematic/pcb

• schematic/simulation

• simulation

For PWB, if you have derived items and derived datasets
defined for both schematic and PCB, you must set the
preference EDA_DefinePWBWith to schematicANDpcb
so that the PWB and derived data can be exposed and
modified in both schematic and PCB tools. By default, the
preference value is set to Schematic.
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Field Description

Prefix (Optional) Type a file name string to be attached to the
beginning of the parent item ID to distinguish it as being
generated by this configuration.

The resulting string, including the prefix and postfix, is
used in the derived dataset user interface in Teamcenter
EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

Postfix (Optional) Type a file name string to be attached to the
end of the item ID to distinguish it as being generated by
this configuration.

The resulting string, including the prefix and postfix, is
used in the derived dataset user interface in Teamcenter
EDA as the initial value for the Derived Item ID box and
Name box. This can be overridden by the user.

EDA Parent Browse to select the derived parent EDA business object
to which the derived dataset is related.

In addition to the following item types, the list also
includes item configurations you already created.

• CCA represents a circuit card assembly (CCA).

• CCABase represents the common design data that is
shared between variant circuit card assemblies (CCAs).
It is used only for multiple CCA representations.

• CCAVariant represents the variant design data for a
circuit card assembly (CCA). This is the data that is
used on top of the CCABase business object.

• PWB represents a printed wire board (PWB). A PWB is
the product of a schematic design and printed circuit
board (PCB) layout design and holds all the printed
wire board production data created by those designs.

• Schematic represents the electrical schematic item.

Relation Browse to select the relationship between the derived
dataset and the parent item revision.

The EDAHasDerivedDataset business object and its
children are displayed in the selection dialog box.

How to create an EDA derived data configuration
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Field Description

Dataset Business
Object

Browse to select the parent dataset business object type
in Teamcenter to represent the derived item, for example,
PDF.

Dataset Reference Browse to select the kind of file reference to use for the
derived dataset.

If the derived data instance comprises more than one
file, this field must either be specified as a ZIPFILE type
or must be specified using a separate derived dataset
configuration entry with the same derived data name.

Pathname Type the path where the derived dataset is to be saved on
the user's machine.

Path names are evaluated at run time and must be
the fully qualified path of the dataset that is to be
saved. Path names can be explicitly specified (for
example, D:\EDA\Datasets\readme.txt) or formed using
the variables or file name filters. Derived datasets can
contain multiple files. Path names are case sensitive, and
the directory delimiters of / or \ are used interchangeably.

Callback Name Type the EDA callback name to execute.

This name is used to identify the configured callback
in the EDA configuration file to determine what script
to execute. The script is responsible for creating or
placing the corresponding derived files to be uploaded
as specified by the configured source path name.

The derived item configuration is added to the Configure Dataset table.

c. Click Finish.

The derived data configuration is added under the EDA Derived Data folder

5. To save the changes to the data model, choose BMIDE→Save Data Model, or click the Save Data
Model button  on the main toolbar.

6. Deploy your changes to the test server. Choose BMIDE→Deploy Template on the menu bar, or
select the project and click the Deploy Template button  on the main toolbar.

7. In the rich client, set the EDA_DerivedDataConfigDefault preference to point to the EDA derived
data configuration you just created.

8. Choose Edit→Options, click the Search link at the bottom of the Options dialog box, locate the
EDA_DerivedDataConfigDefault preference, and change its value to the new configuration.
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There may be multiple configurations created in the Business Modeler IDE, but an administrator can
point to only one of them through this preference.

9. After deployment, test your new configuration in Teamcenter EDA.

For example, in your ECAD design tool, choose Teamcenter→Save Derived Data. (You can also
select the Generate Derived Data check box in the Save As, Save, or Check In dialog box.)

To verify that the derived data is generated, in Teamcenter, expand the item that contains the
derived data (for example, a CCA item). The derived dataset entries appear as you expand the tree
structure. To see the contents of the derived dataset, right-click the dataset and choose Named
References. A dialog box appears that shows the files that are contained in the derived dataset.

How to use the EDA derived data editor to configure derived data in Teamcenter

Use the EDA Derived Data editor in the BMIDE to work with derived data configurations used by the
Teamcenter EDA application. Teamcenter EDA integrates Teamcenter with ECAD applications that are
used to design electronic components, such as circuit boards.

1. To access the EDA Derived Data editor, open the Extensions→EDA Derived Data folder, right-click
an EDA derived data object, and choose Open.

2. To add an item to the EDA derived data object, click the Add button next to the Configure Items
table.

3. To add a dataset to the EDA derived data object, click the Add button next to the Configure
Dataset table.

Configure EDA derived data for EDX design files

All the design files contained in an EDX design package can be classified as derived data files with the
exception of BOM files, EDIF files, and ODB++ files. Derived data files may be placed anywhere within the
package. Files that match your EDA derived data configuration are extracted from the EDX package to a
temporary folder with the same structure as that in the package. For this, you must prefix your derived
data path names with $DESIGN.

Example:

To save a file from your package at the \Design01\Board\DWG\PDF\*.pdf path,

• Edit or create a new EDA derived data configuration using Teamcenter Business Modeler IDE.
See the BMIDE help for more details.

• Add or edit a configure dataset entry.

How to use the EDA derived data editor to configure derived data in Teamcenter
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• In the Pathname field, enter $DESIGN\DWG\PDF\*.pdf

The $DESIGN keyword replaces the first two levels of the structure. Make sure you have the
Teamcenter preference EDA_DerivedDataConfigDefault set to the name of the EDA derived data
containing this dataset.

When an EDX file is published to Teamcenter, the files from the EDX package are saved in Teamcenter as
derived files based on the derived data configuration.

Using wildcards in the derived data configuration path names

You can specify wildcard characters in the derived data configuration path name as follows:

Wildcard Definition Example

Asterisk (*) Matches any number of
characters including none.

$DESIGN\*\*.doc

Selects all .doc files from the child folder under the
$DESIGN folder.

$DESIGN\*\*PWB*.doc

Selects all .doc files with PWB in their file names
from the child folders under the $DESIGN folder.

$DESIGN\PWB*\*.doc

Selects all .doc files that start with PWB in their
file names from the child folder under the $DESIGN
folder.

Two asterisks (* *) Works like one asterisk
(*) but crosses directory
boundaries. This syntax is
generally used to match
complete paths.

$DESIGN\**\MyFile.doc

Selects the Myfile.doc file from all child folders
under the $DESIGN folder.

Question mark (?) Matches exactly one
character.

$DESIGN\Help\Help?.doc

Selects files with one character after their file name
like Help1.doc, Help2.doc and HelpA1.doc but
not HelpMe.doc.

Braces ({ }) Specifies a collection of sub
patterns.

$DESIGN\Help{Me,You}\*.pdf

Selects all .pdf files from either HelpMe or
HelpYou folder.

Square brackets
([ ])

Conveys a set of single
characters or when a

$DESIGN\Help[123]\*.doc

or

$DESIGN\Help[1-3]\*.doc
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Wildcard Definition Example

hyphen (-) is used a range
of characters.

Selects all .doc files any one of the folders Help1,
Help2, Help3.

If multiple files from different folders match during save of the derived dataset, no files are saved for the
derived dataset.

Example:

If your folder structure is like this:

$DESIGN\File1.doc

$DESIGN\Help1\File2.doc

$DESIGN\Help1\File3.pdf

$DESIGN\Help2\File4.doc

$DESIGN\Help2\File5.pdf

$DESIGN\Help2\File6.xls

The wildcards give the following results:

$DESIGN\**\*.doc will fail.

$DESIGN\*\*.pdf will fail.

$DESIGN\*\*.xls will succeed.

$DESIGN\Help1\*.doc will succeed.

$DESIGN\**\File4.doc will succeed.

$DESIGN\*\File3.pdf will succeed.

You can also specify that the entire contents of a directory, including all sub-directories and files, are
to be saved as a zip file. Specify the DerivedDatasetConfiguration Dataset Reference as ZIPFILE.
Specify the DerivedDatasetConfiguration Pathname as a fully qualified directory path ending with
the filename filter value **. Each directory of the path must be an existing directory, no wildcards are
allowed. Derived DatasetConfigurationPathname variables such as $DESIGN are supported.

Using wildcards in the derived data configuration path names
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Example:

$DESIGN/manufacturingData/**

Configure design variants

What are design variants?

To design and develop a product with several variations of that product, where each variation has
different options or capabilities, you create design variants. Creating design variants avoids the need to
create a unique version of the design for each variation. A variant uses the same base design, but the
PCB assembly is loaded with the set of components specified by the variation. A variation may then be
nominated when generating the design’s manufacturing output (such as BOM, Pick and Place (P&P), and
assembly drawings), which will in turn determine how the product is assembled.

When you are working with ECAD design files, you can create any number of variations of the same base
design, where each component may be configured differently as follows:

• Fitted

This is the default state of a component if the component is fitted. It does not have variations. When
you create a new variant, all components default to the state fitted.

• Not Fitted

If a component is set to not fitted, it still exists on the schematic and is transferred to the PCB, but it is
removed from the appropriate output documentation, such as the BOM.

• Fitted with Varied Parameters

A component can have variations of any of its parameters, as part of the variant definition process.
Modifying the value of a parameter is a local variation, only affecting the output documentation. The
original schematic and the component whose parameter is being varied are not modified in any way.

• Alternate Part

It is also possible to select an entirely different component as an alternate part. Since the alternate
part is a different component, only one component is presented on the compiled schematic sheet.
The alternate part must also share the same set of pins placed in the same locations as the base
part. This is an essential requirement to ensure that the connectivity remains valid when the design is
compiled.

An ECAD design is saved as a non-variant design for the first time in Teamcenter. Later, the variants
of the ECAD design are added or created in Teamcenter as required. There are two scenarios for how
variants are added.
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• In the first scenario, you save the ECAD design as a non-variant design in Teamcenter. When new
variants of the designs are created in the ECAD tool, you update the non-variant design in Teamcenter
with the variants.

• In the second scenario, you save the non-variant ECAD design as a variant design in Teamcenter by
creating dummy variants. When the variant designs are created in the ECAD tool, you replace the
dummy variants in Teamcenter with the actual variant designs.

You can configure how to save a nonvariant ECAD design to Teamcenter as a variant design
using the EDA variant object model.

Configure ECAD design variants in Teamcenter

You can save a nonvariant ECAD design to Teamcenter using the EDA variant object model. To configure
the saving of new nonvariant ECAD designs in Teamcenter as variant designs:

1. Update the value of the EDA_SaveAsForceVariant preference to true. This value specifies that
nonvariant ECAD designs not previously saved in Teamcenter are to be saved in Teamcenter, using
the EDA variant object model.

2. Update the value of the EDA_FutureVariantName preference. The default value is futureVariant.

When you save a nonvariant design to Teamcenter and the value of the EDA_SaveAsForceVariant
is true, the value of the EDA_FutureVariantName preference is used as the Variant Name in the
PCA Variants dialog box. The value of the Variant Name in the PCA Variants dialog box cannot be
changed.

Nonvariant ECAD designs already saved to Teamcenter using the EDA nonvariant object model are
converted to use the EDA variant object model by the existing nonvariant-to-variant conversion
functionality. This conversion occurs automatically when an ECAD design, previously saved to
Teamcenter as a nonvariant design, is saved to Teamcenter after the first variant is added to the ECAD
design.

Base BOMs do not support this functionality.

Allow ECAD designers to assign a Teamcenter project from the EDA client

While saving a new or an existing EDA design from the EDA client to Teamcenter, the ECAD designers
can assign or remove a Teamcenter project for that design.

To make sure that the ECAD designer assigns a Teamcenter project while saving a design, you must set
the EDA_TCProjectRequired preference to true. If this preference is set to false, the ECAD designer can
save the design without assigning any project. The default value of the preference is false. If a default
project is assigned to a user in Teamcenter, that project is assigned to the design by default. However,
the user can assign additional projects while saving the design.

Configure ECAD design variants in Teamcenter
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You must also assign the ECAD users to a project in Teamcenter to allow the users to select that project
during the save operation. All projects associated with the ECAD users are displayed for selection to that
user during the save operation.

A Teamcenter propagation rule is used for propagating security-related property values, such as project
and license assignments, from a source business object to a destination business object. The projects
assigned to Printed Circuit Assembly (PCA) objects are propagated to all ItemRevisions and Datasets
associated with the PCA object based on the Teamcenter propagation rule defined for that object. You
can also modify the OOTB propagation rules as per your requirements. For more information on how
to modify an existing propagation rule, refer to the Configure your business data model in BMIDE on
Support Center.

The OOTB propagation rules defined for EDA objects are as follows:

Directio
n

Source
business
object Relation

Destination
business
object

Prop
Group Operation Style Details

Forward EDACCABa
seRevision

IMAN_Ren
dering

Dataset Security
Group I

All Merge Propagation
rule between
PCA
EDACCABas
eRevision
and viewable
Dataset in a
variant
design.

Forward EDACCABa
seRevision

structure_
revisions

PSBOMView
Revision

Security
Group I

All Merge Propagation
rule between
PCA
EDACCABas
eRevision
and
PSBOMView
Revision in a
variant
Design.

Forward ItemRevisi
on

EDAHasSc
hematic

EDASchem
Revision

Security
Group I

All Merge Propagation
rule between
PCA
ItemRevisio
n and
EDASchem
Revision.

Forward EDASche
mRevision

IMAN_Ren
dering

Dataset Security
Group I

All Merge Propagation
rule between
EDASchemR
evision and
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Directio
n

Source
business
object Relation

Destination
business
object

Prop
Group Operation Style Details

viewable
Dataset.

Forward ItemRevisi
on

EDAHasP
WB

ItemRevisio
n

Security
Group I

All Merge Propagation
rule between
PCA
ItemRevisio
n and
Printed
Wiring
Board.

Forward EDACCABa
seRevision

EDAHasVa
riant

ItemRevisio
n

Security
Group I

All Merge Propagation
rule between
PCA
EDACCABas
eRevision
and variant
ItemRevisio
n.

Forward ItemRevisi
on

EDAHasDe
rivedItem

ItemRevisio
n

Security
Group I

All Merge Propagation
rule between
any
ItemRevisio
n and
derived
ItemRevisio
n in a
design.

Forward ItemRevisi
on

EDAHasDe
rivedData
set

Dataset Security
Group I

All Merge Propagation
rule between
any
ItemRevisio
n and
derived
Dataset in a
design.

You can also modify the OOTB propagation rules to create custom rules for variant and non-variant
designs.

Allow ECAD designers to assign a Teamcenter project from the EDA client
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Create a custom propagation rule for variant designs:

Directio
n

Source
business
object Relation

Destination
business
object

Prop
Group Operation Style Details

Forward ItemRevisi
on for the
variant
item type
defined in
the
EDA_CCAV
ariantItem
TypeDefa
ult
preference

structure_
revisions

PSBOMView
Revision

Security
Group I

All Merge Propagation
rule between
the variant
ItemRevisio
n and
PSBOMView
Revision.

Create a custom propagation rule for non-variant designs:

Direction

Source
business
object Relation

Destinatio
n business
object

Prop
Group Operation Style Details

Forward ItemRevisi
on for the
PCA item
type
defined in
the
EDA_CCAI
temTypeD
efault
preference

IMAN_Ren
dering

Dataset Security
Group I

All Merge Propagatio
n rule
between
the PCA
ItemRevisi
on and
viewable
Dataset in
a non-
variant
design.

Forward ItemRevisi
on for the
PCA item
type
defined in
the
EDA_CCAI
temTypeD
efault
preference

structure_
revisions

PSBOMVie
wRevision

Security
Group I

All Merge Propagatio
n rule
between
the variant
ItemRevisi
on and
PSBOMVie
wRevision
.
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Set configurations based on the ECAD applications used

You can configure which preference values should be used for a specific preference based on the
connectors configured for y ECAD design tool. This configuration allows all EDA preferences to be
overridden by application-specific preferences, if set. The application specific preferences can be created
for all the EDA design preferences by adding a suffix to the OOTB preference name. The suffix
is the name of the ECAD tool application name exactly as mentioned in the %TCEDAECAD_ROOT%
\*_usrdef.xml file.

If the preference exists with the suffix of the connector name, then this preference is used. Else, the
preference without a suffix is used.

Example:

Consider that you are using two different connectors, and want to set different values for the
following preference, depending on which connector is currently being used. You can set different
values for the same preference by adding the application name as a suffix to the preference name.
The OOTB preference name is EDA_CCAVariantItemTypesAllowed.

To set the preferences with different values for both the connectors, create two different
preference instances with the connector names suffixed to the preference.

• Preference to be used if the connector 1 is used:
EDA_CCAVariantItemTypesAllowed_<connectorname_1>

• Preference to be used if the connector 2 is used:
EDA_CCAVariantItemTypesAllowed_<connectorname_2>

Allow users to view the PCB board requirements in Active Workspace

ECAD designers can view the PCB board requirements specifications related to the design revisions in the
Requirements tab in Active Workspace for the EDACCABase and EDASchem object types, by default.

To allow users to configure Requirements tab for other Item Revisions, user can include the following in
the respective stylesheet.

<page titleKey="tc_xrt_Requirements" 
visibleWhen="ActiveWorkspace:SubLocation != 
com.siemens.splm.client.occmgmt:OccurrenceManagementSubLocation">
        <htmlPanel declarativeKey="Eda0RequirementsTraceability" />
</page> 

Additionally, you can specify the revision rule to configure the requirements BOM structure in the
Requirements tab by setting the EDA_AWRequirementBOMRevRule preference. The default value of
the revision rule is set to Latest Working.

Set configurations based on the ECAD applications used
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Configure single sign-on for Teamcenter and Xpedition EDM integration

Teamcenter Security Services eliminates the need for multiple authentication challenges as users move
from one Teamcenter application to another. It also provides a common framework to integrate with a
site's single sign-on solution. With single sign-on configuration extended to the EDM server, users can
log on to Teamcenter when they are logged on to the EDM client. Alternatively, they can log on to the
EDM client automatically when the user is logged on to Teamcenter.

Single sign-on is supported for Xpedition EDM and Teamcenter. To enable SSO for the integration, you
must:

• Set up the SSO server

To set up the SSO server, refer to Security Services Installation/Customization in the Teamcenter
documentation.

• Set up the EDM server for SSO support

To set up the EDM server for SSO, refer to the Teamcenter Integration section in the Xpedition® EDM
Server and Utilities User’s Guide help on Support Center.

• Set up the integration for SSO support

When installing the Teamcenter EDA client, on the EDA Client wizard, select the Enable SSO check
box and navigate to the Security Services wizard.

Here, specify the Teamcenter login service in the Login URL field and the Teamcenter SSO application
ID in the Application ID field.

Set properties on EDM designs during design review

You can configure Teamcenter to initiate a workflow to allow ECAD designers to set properties on the
EDM designs during the review process.

To initiate this workflow during the review of EDM designs, you must:

1. Set the EDA_Workflows preference value to initiate a workflow during the review process.

2. Configure the EDM-set-properties workflow handler to apply the property-value pair on the EDM
designs.

4. Integrating EDM with Teamcenter EDA for managing design files
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1. Set the EDA_Workflows preference value to initiate the workflow during the review
process

You must specify a Teamcenter workflow that must be initiated during the EDM design review process in
the EDA_Workflows preference. If this preference value is not set, the workflow is not initiated during
the EDM review process.

The EDA_Workflows preference specifies the Teamcenter workflow template to be initiated on the CCA
ItemRevision based on the ECAD design status and the purpose of the review on that design. Specify
the value of the preference in the following format:

Design_Status;Design_Intent;TC_Workflow_Template where,

• Design_Status is the release status applied to the ECAD design.

• Design_Intent is the purpose of review for the ECAD design.

• TC_Workflow_Template is the name of the Teamcenter workflow template.

Example:

The value of the EDA_Workflows preference can be set as Released;Release;EDM Set Properties
where

• Released is the release status applied to the EDM design.

• Release is the design intent.

• EDM Set Properties is the Teamcenter workflow template.

2. Configure the EDM-set-properties workflow handler

Handler name: EDM-set-properties

Argument Value
-EDMInboxQueue This is the Inbox Queue Path location configured in the EDM Server
-CONTAINER:PROPERTY VALUE

• CONTAINER

This is the EDM container type. Its valid values are DC, LDC, PDC, and PLC.

Valid values Examples Value considerations
DC Board Container Any valid EDM property can be updated.

Set properties on EDM designs during design review
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Valid values Examples Value considerations
Example: -DC:tc_PCA_ID

LDC Logical Design Container Any valid EDM property can be updated.

Example: -LDC:tc_PWB_revision
PDC Physical Design Container Any valid EDM property can be updated.
PLC Part List Container Any valid EDM property can be updated.

• PROPERTY

This is the EDM property name, for example, tc_PCA_ID, tc_PCA_revision, or tc_PWB_ID, tc_UID.

You can update multiple containers and properties at a time. However, you cannot update containers
not present in the original EDX file attached to the design dataset.

• VALUE

This is the value to be set on the EDM container property. This value can be of two types:

• Direct value

The actual value is passed to the handler for the container property.

• Indirect value

The valid format is TCOBJECT:TCPROPERTY

Format Description Valid values
TCOBJECT It is the Teamcenter object (item) from which a property

value should be read.
PCAITEM, PCAITEMREV,
PWBITEM, PWBITEMREV

TCPROPERTY It is the property to be read on the given TCOBJECT. object_name

• PLACEMENT

Requires no specific placement. Proper placement depends on the desired behavior of the workflow
process and may require coordination with the placement of other handlers, especially in cases where
other handlers depend on the results of EDM-set-property. Typical placement might be on the Start
action or Complete action.

Additionally, the EDXClient utility is also supported for the workflow handler to make sure that the EDX
file is copied to the inbox queue path.
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Note:

The edxclient.exe is installed on the Teamcenter server by installing the Xpedition Data
Management > Xpedition EDM Engineer client product. Refer to the Xpedition help on Support
Center for more details.

The configname property is defined using the EDM Batch Admin utility to create a secure login
method to EDM, which is used during the handler execution. Because the login configuration is
stored in the HOME directory of the user that executes the EDM Batch Admin utility, the utility
should be executed using the same credentials that are used for the Teamcenter Server Manager
as this service executes the workflow handler.

To use this utility, the workflow handler must include these additional parameters:

Parameter Description
-EDXClientPath This is the absolute path of edxclient.exe

Example: %SDD_HOME%\common\win64\bin\edxclient.exe
-EDMConfigName This is the EDM configuration name for edxclient.exe. This configuration is created

in the EDM batch login.
-EDXQueueName This is the EDM queue name configured in the EDM server.

If you want to use the EDM-set-properties handler in your workflow and, if an argument is not passed
or if the value of an argument is empty, then the handler will pick the value set in the preferences
available for each of these parameters. You can set the values of the parameters in the preferences listed
below:

Parameter Preference
-EDXClientPath EDA_EdxClientPath
-EDMConfigName EDA_EdmConfigName
-EDXQueueName EDA_EdxQueueName

Customize the acronyms used for ECAD design objects in Teamcenter

If your ECAD designers use acronyms different from the default acronyms provided, the Teamcenter
configurator can override the defaults by creating custom acronyms used for ECAD designs in
Teamcenter.

By default, EDA uses the following acronyms to refer to electronic design objects on the user interface:

• PCA for printed circuit assembly or CCA for circuit card assembly (in earlier versions of EDA).

• PWB for printed wire board.

Customize the acronyms used for ECAD design objects in Teamcenter
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If your ECAD designers use different acronyms, the Teamcenter administrator can override the defaults
by creating custom text copies of the TC_ROOT\lang\textserverlocale\eda0_text_locale.xml file. For
each custom-name_text_locale.xml file, locate the following lines in the file and edit the display text as
required:

<key id="Eda0_PCA">PCA</key>
<key id="Eda0_PCAToolTip">Printed Circuit Assembly</key>
<key id="Eda0_PWB">PWB</key>
<key id="Eda0_PWBToolTip">Printed Wire Board</key>

Note:

There is a separate locale file for each supported locale. The example shown is from the en_US
locale file.

For more information about customizing textserver file text, see the Server Customization help.

Managing and configuring Teamcenter preferences for design management

You can set system-wide preferences on the Teamcenter server that apply to all EDA users. To
understand how preferences work and to understand how to access a list of all supported preferences,
refer to the Managing Preferences help on Support Center. All EDA preferences begin with the prefix
EDA.

1. Run the rich client on the Teamcenter server and log on as an administrator.

2. In My Teamcenter, choose Edit→Options.

3. At the bottom of the Options dialog box, click Index.

4. In the Preferences dialog box, search for the preferences that begin with EDA_.

5. Change the preference value and click the Modify button to save the new value.

Install the EDA client for EDM integration

Use the tem.bat command from the Teamcenter software kit to launch Teamcenter EDA Environment
Manager (TEM) to perform installation and maintenance operations of Teamcenter EDA on an ECAD
workstation for EDM design integration.

TEM is available with the Teamcenter installation or upgrade images. Contact your Teamcenter
installation administrator to obtain the correct product distribution image.
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Caution:

Before installing the EDA client on your ECAD workstation, refer to all the prerequisites and the
information required to install the client in the Planning your deployment topic.

1. Ensure that the proper version of JRE is installed and the JRE_HOME environment variable (32-bit
system) or the JRE64_HOME environment variable (64-bit system) is set.

2. Extract the Teamcenter software distribution image to a temporary location.

3. Specify the path to the Java Runtime Environment (JRE) by setting the JRE_HOME environment
variable on the ECAD workstation.

You can also specify the JRE path when you launch TEM from the command line using the -jre path
argument.

4. Start TEM.

a. Browse to the root directory of the extracted Teamcenter EDA software distribution image.

b. Right-click the tem.bat program icon and choose Run as administrator.

TEM launches and displays the Installer Language panel.

c. In the Installer Language panel, select a language and click OK.

TEM displays the Welcome to Teamcenter EDA panel.

Your language selection applies only to the TEM session and not the Teamcenter EDA
installation.

5. In the Welcome to Teamcenter EDA panel, click Install.

6. In the Configuration panel, type the configuration ID and the description for the new Teamcenter
EDA configuration.

The configuration ID identifies your Teamcenter configuration when you maintain, upgrade,
uninstall, or add features to the configuration. Installation log files are also named based on this ID.

7. Proceed to the Features panel and click Next.

8. Expand EDA Client and select the required options:

• ECAD Design Integrations

Install the EDA client for EDM integration
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Select the design tool support you require. This integrates the design tool with the EDA client.
However, a separate installation of the design tool is required.

• Mentor Xpedition EDM Design

• Teamcenter Gateway for EDA Design

• (Optional) EDA Translation

9. In the Installation Directory box, browse to a folder where the EDA client will be installed. For
example, type c:\EDA_client for Windows.

The client is installed to an eda subdirectory, for example, c:\EDAC_client\eda (Windows). This
directory is known as TCEDAECAD_ROOT.

10. Click Next.

11. In the FCC Client Cache (FCC) panel, select Use new FCC and click Next.

12. In the FCC Parents panel, type the Host name of the Teamcenter server in the FCC Parents box.

13. In the 4-tier Server Configurations panel, type the IP address of the Teamcenter server in the
4-tier Servers box. For example:

http://host:7001/tc

Replace host with the server name.

14. In the EDA Client panel:

a. Change the path if needed in the Staging Location box.

You must enter the full path to the directory where the ECAD designs are saved on the client.
This directory is the working directory for EDA.

If a staging directory already exists, you can continue using the same directory or select
another folder as the staging directory.

Caution:

Do not use spaces in the cache or staging directory path. Some EDA functions do not
work if there are spaces in these paths.

b. Clear the Will this configuration be shared by multiple users? check box to create user
environment variables after installation. By default, the check box is selected to create system
environment variables.
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c. Click Next.

15. Review the features selected in Confirmation panel and click Start.

The EDA client components are installed.

The Install panel confirms whether the installation is successful. If the installation is successful,
click Close. If the installation is unsuccessful, click Show Details and proceed as needed.

After installing the EDA client, you must integrate Xpedition EDM with Teamcenter, configure the
EDA client and configure the connectors for the Teamcenter integration to work correctly.

Setting up EDM integration

Configurations required for setting up EDM integration

After installing the EDA client and integrating Xpedition EDM with Teamcenter, you must:

• Integrate Xpedition EDM with Teamcenter .

• Configure and deploy the EDM server with Teamcenter.

• Perform EDM queue configuration.

• Create an EDM baseline profile to enable automation.

• Set automatic import options.

• Export X-Y coordinates and rotation details of the EDX file into Teamcenter

• Retain EDX files after publishing to Teamcenter.

• Configure the connector for EDM integration.

Integrating Xpedition EDM with Teamcenter

To integrate Xpedition EDM with Teamcenter, consider the following information and requirements after
installing the EDA client:

• You must have write permissions to create a file in the %TCEDAECAD_ROOT% folder.

• The API.properties file is created after installing the EDA client. This file contains the properties
required to use the Mentor EDX SDK API.

Configurations required for setting up EDM integration
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• The SDD_HOME environment variable should be set to Xpedition installation location in the
following files:

• %TCEDAECAD_ROOT%\MentorEDXDesCon\eda_edx_connector.bat

• %TCEDAECAD_ROOT%\MentorEDXDesCon\eda_edx_connector_singlejvm.bat

Configure and deploy EDM server with Teamcenter

The EDM server administrator can review all current configurations, modify and add to the existing
configurations, run pretests, and then deploy the EDM server with Teamcenter configuration.

1. Open the EDM Server Cockpit tool.

2. If deploying EDM server for the first time:

• If the EDM server is not previously deployed, you can Configure and Deploy it by specifying the
Teamcenter configurations.

a. Click Manage Configuration Tiles  to add the Teamcenter application.

4. Integrating EDM with Teamcenter EDA for managing design files
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b. In the Configuration Tile Management dialog box, click Add against the Teamcenter icon
to add and configure the Teamcenter application.

c. Click the Teamcenter tile.

3. If EDM server is previously deployed:

a. If the EDM server is already deployed, you can modify it to add Teamcenter configurations and
deploy it once again.

b. Click Modify Configuration.

Configure and deploy EDM server with Teamcenter

Xpedition and PADS Integration With Teamcenter, Teamcenter 2412  4-41
© 2025 Siemens



c. Click the Teamcenter tile if it is already added. If it is not added, in the Configuration Tile
Management dialog box, click Add against the Teamcenter icon to add and configure the
Teamcenter application.

4. On the Teamcenter application page, click Yes to Enable Teamcenter Integration.

5. In the Teamcenter Configuration Zip Path field, enter the location of EDXConfigFiles.zip file.

This file is located at %TCEDAECAD_ROOT%\MentorEDXDesCon\server_updates location.

The zip file contains the following xml files:

• MetaData.xml: It contains the new metadata created on EDX containers for EDX integration.

• SystemConfigurations.xml: It contains the new callback definitions created for saving EDX to
Teamcenter.

6. If the single sign on feature is enabled on the Teamcenter server, to use single sign-on for
Teamcenter EDA integration, provide the following information in the Teamcenter SSO Settings
fields:

4. Integrating EDM with Teamcenter EDA for managing design files
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a. Teamcenter URL

Teamcenter EDM integration uses the 4-tier URL configured on the EDM server to
connect to Teamcenter. This value overrides the URL defined in the %TCEDAECAD_ROOT%
\TCEDAClient.properties file on the client machine.

Note:

This change is applicable only when Teamcenter is configured in the non-SSO mode on
the EDM server. The parent FSC address configured in the %FMS_HOME%\fcc.xml file on
the client machine will be in sync with the 4-tier URL configured on the EDM server.

b. Identity Service URL

c. Login Service URL

Configure and deploy EDM server with Teamcenter
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Note:

The URL information can be obtained from the Teamcenter administrator.

7. Click Save to save the configuration.

The Teamcenter configuration tile will be added on the Modify Configurations page.

8. Click Review, Test, and Deploy on the main page to update the configuration and deploy the EDM
server.

EDM queue configuration for Teamcenter EDA integration

1. Click the http://<EDM_SERVER_HOST>:<PORT>/xdm URL to open the EDM portal web application,
where:

• EDM_SERVER_HOST is the host name of the EDM server where it is installed.

• PORT is the port number on which the EDM server is running, for example, http://
edm_server_machine_name.net.plm.eds.com:31000/xdm.

2. On the Xpedition EDM Portal page, click EDM Admin.

3. Click Settings on the navigation panel.
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4. Click Integration under EDX Import Queue, and select + Create new Queue from the Current
Teamcenter Queue list.

EDM queue configuration for Teamcenter EDA integration
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5. In the Create queue dialog box, enter a name for the queue in the Name field, select Inbox from
the list for Type, and for Purpose select Teamcenter.

6. In the Directory field, provide the directory path for the queue.

The directory path that you specify here must be accessible from the EDM Server. Additionally, the
mgcserveruser user must have write permissions to the inbox queue folder.

As you are not required to expose the Inbox Queue to the client machine, it is not required that the
Inbox Queue is a shared folder. The EDX files are imported to Inbox Queue in a secure manner using
the EDX client utility.
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7. Click Create queue.

Create an EDM baseline profile to enable automation

Import the baseline profile configuration

The baseline profile configuration file for publishing EDX file to Teamcenter is available in the
baselineprofile.zip file located at %TCEDAECAD_ROOT%\MentorEDXDesCon\server_updates location.

This ZIP file contains the LatchProfiles.xml file. This file contains the Publish to Teamcenter baseline
profile to define the part list options for generating design and variant BOM. This is also required to
automate the process of creating the baseline and the EDX file. The ZIP file also contains a supporting file
that describes the source option for part list generation.

To import the baseline profile:

1. Open the EDM Admin web tool.

Create an EDM baseline profile to enable automation
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2. Click Settings→Export/Import.

3. Click Choose Files under Import Settings.

4. Select the baselineprofile_*.zip file from the %TCEDAECAD_ROOT%
\MentorEDXDesCon\server_updates location.

4. Integrating EDM with Teamcenter EDA for managing design files
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5. Click Next: Verify Contents to verify the selected files.

6. Click Next: set options.

Create an EDM baseline profile to enable automation
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7. In the Import settings dialog box, select the following option for each scenario:

• Ignore, when an entity exists in the EDM system but not in the configuration file.

• Create, when an entity exists in the configuration file but not in the EDM system.

• Overwrite, when an entity exists in both the configuration file and the EDM system.

4. Integrating EDM with Teamcenter EDA for managing design files

4-50  Xpedition and PADS Integration With Teamcenter, Teamcenter 2412
© 2025 Siemens



8. Click Import settings to import the baseline profile. This creates a baseline profile with the name
Publish to Teamcenter in EDM.

How the baseline profile works

The baseline profile helps in reducing the number of manual steps such as creating a baseline and
the manual inputs required in the Create EDX dialog box. It also allows you to configure which files
should be included in the EDX file and to include the part list information for saving BOM information in
Teamcenter.

1. In the EDM Design Cockpit tool, select a project and assign the baseline profile.

Create an EDM baseline profile to enable automation
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2. Assign Publish to Teamcenter profile and click OK.
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3. Select the Project and create the baseline by selection the Publish to Teamcenter profile to
automatically create the baseline and EDX files.

Create an EDM baseline profile to enable automation
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Set automatic import options

1. Open the EDM Admin web tool.

2. Go to Settings and click EDM EDX Client from the navigation panel.

4. Integrating EDM with Teamcenter EDA for managing design files
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3. In the inbox queue panel you previously created, first enable the Automatic Import Options link
and in the Design field, from the list of users, select the Project Manager user next to Automatic
import as.

Export X-Y coordinates and rotation details of the EDX file into Teamcenter

In EDM integration, when you create a design BOM in Teamcenter, you can set the relative 3D position in
the BOM line transformation matrix for each component instance. However, for the relative 3D position
value to be set in the BOM lines, the X and Y coordinates, surface, and rotation information of the
design components must be available in the design EDX files.

Apart from these four attributes, you can also save other reference designator attributes while saving
designs from EDM to Teamcenter. To export these additional reference designator attributes from EDM
to Teamcenter, you must map the occurrence attributes such as reference designator and board side
(up or bottom) in the *usrdef.xml file.

The X and Y coordinates, surface, and rotation information are not available in the EDX files OOTB. For
this information to be exported in Teamcenter through the EDX files, you must perform the following
configuration in Xpedition EDM.

1. Open a design in Xpedition EDM Collaborate tool. Click View to open the design in the viewer.

Export X-Y coordinates and rotation details of the EDX file into Teamcenter
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2. At the top-right of the Xpedition EDM Collaborate Viewer tool, click , then choose the Data
View at the Bottom option from the list.

3. On the toolbar, click .

4. In the Edit Columns dialog box, on the Design tab, select the X Location, Y Location, Surface,
and Rotation options that are listed under the PCB column.

4. Integrating EDM with Teamcenter EDA for managing design files
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Apart from these four attributes, you can also save other reference designator attributes while
saving designs from EDM to Teamcenter. To export these additional reference designator attributes
from EDM to Teamcenter, you must map the occurrence attributes such as reference designator
and board side (up or bottom) in the *usrdef.xml file.

5. Click Save columns.

6. Click  to save the part list view scheme.

7. In the Save Scheme dialog box, click Save.

8. To auto generate the baseline information, in the EDM Design Cockpit tool, select the Data View
Scheme as the Part List in the Baseline Profile Management tree.

Export X-Y coordinates and rotation details of the EDX file into Teamcenter
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9. Double click Publish to Teamcenter option.

4. Integrating EDM with Teamcenter EDA for managing design files
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10. In the Modify Baseline Profile dialog box, select the Auto Generation tab.

11. Click Options to open the Part List Source dialog box..

Export X-Y coordinates and rotation details of the EDX file into Teamcenter
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12. Select Layout from the list and click OK.

13. Save the Project.

14. On Publish Baseline operation, the EDX file will be generated with the X location, Y location,
Surface, and Rotation information and open the Teamcenter Gateway for EDA user interface.

Retain the EDX files after publishing to Teamcenter

To retain the EDX files after they are published to Teamcenter, set the Teamcenter EDA log level to debug
mode in the %TCEDAECAD_ROOT%\log4j.properties file.

If the log level is no set to debug mode then after getting published to Teamcenter, the EDX files will be
deleted from the client machine.

EDM tool connector configurations for Teamcenter integration

Overview of connector configurations required for EDM integration

After the configurations required to integrate EDM with Teamcenter are complete you must further
configure and customize the ECAD tool connector as per your requirement.

How variant names are extracted to an EDX package from EDM project

Variant names are extracted from the variant table data in the DesignContainer.xml file created in EDX.
The variant BOM is derived from PartListContainer.xml file created in EDX for each variant in the design.

How design BOM is extracted to EDX package for an EDM project

The EDX connector extracts component instance information for a design from the
PartListContainer.xml file present in the EDX package.

The baseline profile Publish to Teamcenter is used to include the PartListContainer.xml files in the EDX
file generated. In the case of variant designs, a PartListContainer.xml file is generated for the base BOM
and a separate PartListContainer.xml file is created for each variant.

These PartListContainer.xml files are used in the maintenance of Teamcenter BOMs by using the EDX
connector.

Working with intermediate and viewable files

During the save action, EDIF design files contained in the EDX design package are extracted from the
EDX package to the edif subdirectory in the design directory as an input for translation to a schematic
Formatted ASCII Text File (FATF) file. The input files are referred to as schematic intermediate files.
The resulting EDIF translator generated schematic FATF files generated by the EDIF translator and
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the schematic intermediate files, if any, are uploaded and attached to SCHFATF and EDAGenSchem
datasets, respectively.

In addition, during the save action, ODB++ design files contained in the EDX design package are
extracted to the odb subdirectory in the design directory as an input for translation to a PCBFATF file.
The input ODB++ files are referred to as PCB intermediate files. The resulting ODB++ translator-generated
PCB FATF files, and optionally the PCB intermediate files, are uploaded and attached to PCBFATF and
EDAGenPCBCAD datasets, respectively.

To create the intermediate file required for the save operation from Xpedition Layout:

1. Select the Output→ODB++ menu option.

2. In the ODB++ Output dialog box, set the output path to as .\Output\ODBpp\, and set the file name
as designodb.

3. Select the Compress output option to create the designodb.tgz file.

The user created EDIF files can be placed at any location in the <design> folder inside the EDX design
package. Also, the location of the <board.eds> file can be anywhere inside the EDX design package. The
user created ODB++ files can be placed at any location in the <design> folder. Also, the location of the
designodb.tgz file can be anywhere inside the EDX design package.

Working with supported data files

Within the xDM Design client, supporting or derived data files are included with an Xpedition design.
These files consist of information related to manufacturing, assembly, fabrication, or BOM data.

These attached data files may be of data types unrecognized by the user's operating system (typically,
Windows). If these files are not recognized by the system, by default these files cannot be opened or
viewed from within the xDM Design client. This is because xDM Design client passes most actions on
standard data types to the operating system for execution. The operating system must have default tools
defined for the standard data types used within the EDM data.

To add support for these unrecognized file types, the user must configure the Windows operating system
to recognize these file types.

1. From a Windows system, open a file system browser.

2. Navigate to and locate the target file.

3. Select the target file, right click on the file and select Open With.

If the tool to be used with the target data type appears in the dialog box, the setup is complete.

Working with supported data files
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4. If the tool to be used with the target data type does not appear in the dialog box, select the target
file, right click on the file and select Select a program from a list of installed programs and click
OK.

5. Select the required tool and click OK.

Current behavior of EDM integration

When the EDX baseline is released, the EDX project and the BoardContainer are also released in EDM.
If the EDA_Workflows preference is configured to release the CCA item revision based on the EDX
baseline status, the CCA item revision is released each time the EDX files are saved to Teamcenter. So,
the subsequent save of EDX files to Teamcenter always result in revise operation. If a new baseline is
created for the released EDX project then the baseline is in the Valid state but the EDX project is still in
the Release state.

The EDX API retrieves the status of the EDX files from the EDX project and not from baseline. Due to this
reason, when the EDX file is saved using this unreleased baseline, the CCA item revision is released in
Teamcenter. The subsequent save action of EDX files to Teamcenter results in a revise action.

Setting up ECAD translation

ECAD translation modes

The following translation modes are supported for ECAD translation:

• Local translation

The viewable file is generated locally. This option is available only on Windows clients.

• ECAD translation happens by default and is installed out-of-the-box and deployed locally on the
EDA client machines with the EDA Standalone Client TEM feature.

• You must edit the TCEDAClient.properties file located in the TCEADAECAD_ROOT directory to
update the path to the translation directory (Teamcenter EDA application root\emps\translation).

• Remote translation

The EDA integration initiates a remote translation of the intermediate file into a viewable format.

ECAD translation is embedded into the Teamcenter Dispatcher framework. Make sure that the
Dispatcher server and required translator are installed. After installing and setting up the
dispatcher you must enable the PcbToFatf translator.

If you select the Viewable check box while saving your EDA design, the following automatic
translation process takes place:
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• The design intermediate file that can be parsed by the ECAD translator is extracted.

• The intermediate file is converted into a neutral file format: XFATF for PCB designs and XSCH for
schematic designs.

• The neutral file is saved as a viewable dataset in Teamcenter.

You can enable either the local translation mode or the remote translation mode. You may also enable
both these modes and control which mode to use by editing the EDA_PreferredLocalTS preference.

Enable PcbToFatf translator

After you install and configure Dispatcher as per the deployment strategy, you must enable the
PcbToFatf translator required for the remote translation of the intermediate file into a viewable format.

You can use TEM to install the translator or manually edit the translator.xml file to enable the
translator. For instructions on how to enable the PcbToFatf translator using TEM, see the Dispatcher
─ Deployment and Administration help on Support Center.

The following is an example of how to edit the translator.xml file to enable the translator.

Prerequisites: Verify that the TransExecutable dir is correctly specified for this translator.

1. Open the translator.xml file from the Dispatcher_RootModule\conf directory.

2. Set the isactive attribute to true to activate this translator.

Note:

By default, this attribute is set to false.

3. Open the translator.bat (Windows) from the
Dispatcher_Root\Module\Translators\translator_name directory and edit the CHANGE_ME tags.

For more information about CHANGE_ME tags, see the .bat file for the translator.

4. Run the translator in standalone mode from the command prompt to verify whether it is working
properly.

For more information about running the translator in standalone mode, from a command
prompt, change to the Dispatcher\Translators\translator_name directory and run the appropriate
command for your platform:

Enable PcbToFatf translator
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Note:

For more information, see the Readme file in the Translators\translator_name directory.

Windows: translator_name.bat -help

5. (Optional) To set up Dispatcher-client-proxy-user as the owner of the translated files, make the
following change to the translator_name.bat (Windows) file.

NxTransDirect translator example:

"%UGII_BASE_DIR%\ugmanager\run_nxtrans.bat" -u=Dispatcher-client-proxy-user 
-p=password 
-changeOwnerToCad=false "-pim=yes" %*

If you set up Dispatcher-client-proxy-user as the owner of the translated files, you must create a
dispatcher client access rule. For more information on how to create a dispatcher client access rule,
see the Dispatcher ─ Deployment and Administration help.

After installation, you must add a rule to the access rule tree permitting the translation service
proxy user to update attributes of a DispatcherRequest object. If this access rule is not created
correctly, the dispatcher client reports errors.

4. Integrating EDM with Teamcenter EDA for managing design files
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5. Integrating Xpedition or PADS or EDM
with Teamcenter EDA for part library
management
Planning your deployment for part library management

For installing and integrating Teamcenter EDA with Xpedition, PADS, PADS Professional, or EDM for part
library management, you must plan your deployment and your environment setup. You can install the
Teamcenter EDA server and client components through Deployment Center or through TEM.

As an administrator, you must install the appropriate components on the server (Teamcenter) and client
machines (ECAD workstation) as per the site requirements as mentioned below:

Server components Requirements

Teamcenter server Teamcenter server is used to store and track the ECAD designs.

For information about the versions of operating systems, third-
party software, and Teamcenter software configurations that
are certified for the EDA platform, refer to the Hardware and
Software Certifications knowledge base article on Support
Center.

If you have an existing Teamcenter environment, you can
update it to support the latest EDA version.

Ensure that you download the compatible versions from
Support Center before starting your deployment.

EDA server support and
library support

Teamcenter server is used to store and track the ECAD designs.
EDA server support is required to add ECAD data model to
the Teamcenter server environment. You must add EDA server
support on top of the Teamcenter environment.

As the EDA client is supported in a four-tier architecture, the
EDA Server Support feature (EDA data model) must also be
installed on a four-tier Teamcenter server.

BMIDE BMIDE is required to map ECAD objects with Teamcenter
objects.

Dispatcher Dispatcher is required for remote ECAD translations to translate
and save the design intermediate file into a viewable dataset
in Teamcenter. For library integrations, the acistoprt translator
will support the translation of the ACIS part to NX parts.

If Dispatcher is already installed in your existing Teamcenter
environment, you can use the same instance. However, you
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Server components Requirements

must modify it to include the translator acistoprt. In addition,
you also require NX to be installed on the same machine where
the Dispatcher is installed.

Teamcenter
Classification Admin

Teamcenter Classification Admin is required to create custom
classification schema and set up classification mappings for part
library management.

Client components Requirements

EDA client EDA client moves designs and library parts between ECAD
design tools and Teamcenter. The EDA client must be installed
on the ECAD workstation using the Teamcenter software kit.

Before installing the EDA client, see the Hardware and
Software Certifications knowledge base article on Support
Center to identify which versions of the Xpedition or PADS
or PADS Professional are supported on which versions of
Teamcenter EDA.

Siemens Digital Industries Software recommends that you first
perform the installation on a test system to verify the parameter
values required for the installation on the ECAD workstations.
Prerequisites and requirements before installing the EDA
client:

• Supported Operating System:

The EDA client framework is supported only on the Windows
operating system. Teamcenter software kit contains the 64-
bit installer for Windows system. You can select Win32
applications directly from TEM or DC along with the rest of
the Win64 applications from within the Teamcenter software
kit.

• Supported Java version:

For information about the supported Java versions that
are certified for the EDA platform, see the Hardware and
Software Certifications knowledge base article on Support
Center.

• Information required for EDA client installation from
Teamcenter installation administrator:

• FMS client cache (FCC)

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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Client components Requirements

If the FMS client cache (FCC) exists, use the existing one or
specify a new one.

• The FCC parent information for the EDA client, including
the host and port value

The minimum information required is the host name and
the port.

• The four-tier, middle-tier Web application server URI, and
the connection name for the EDA client

• Logon URL and the application ID To enable Teamcenter
Security Services

• Host name, port, and license server mode of the Siemens
Digital Industries Software common license server

• Other installation considerations

• Only the English versions of ECAD tools are supported.

• Item ID, variant name, dataset name, reference designator
value, and mapped attribute names and values must
contain only ASCII characters. Mapped attributes include
CAD attribute mappings and component instance attribute
mappings.

• The staging directory and all file names must contain only
ASCII characters.

• PADS Logic does not support variants.

Teamcenter EDA
gateway

Install Teamcenter EDA gateway for part library management.
Teamcenter EDA Gateway allows the ECAD tool users to save,
check in, or check out native design files, access approved
components, populate electrical component BOMs, share
fabrication and assembly data, and create and manage other
types of derived ECAD data files.

Workflow to integrate your ECAD applications with Teamcenter for
part library management

Scenarios to deploy the Teamcenter EDA server and client components:

Workflow to integrate your ECAD applications with Teamcenter for part library management
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Using Deployment Center Using TEM

Install Teamcenter server
and the EDA client

Install Teamcenter
server and Install BMIDE

Set up Teamcenter server
for part library management

Set up Teamcenter server
for part library management

Configure the EDA client
for part library management Install the EDA client

Perform additional configurations
and customizations required
for your ECAD applications

Configure the EDA client
for part library management

Perform additional configurations
and customizations required
for your ECAD applications

Install Teamcenter EDA for part library management using
Deployment Center

The following procedures assume that you are installing EDA on an existing Teamcenter and that you are
familiar with Deployment Center.

Procedure

1. Log on to Deployment Center and select the environment to which you want to add Teamcenter
EDA .

2. Go to the Applications task. Click Add or Remove Selected Applications .

3. In the Available Applications panel, use the web browser search to find the Electronic
Design Automation (EDA) application. Select the application, and then click Update Selected
Applications.

Deployment Center automatically selects any additional dependent applications.

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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4. In the Available Applications panel, under EDA Client, select the ECAD tool with which you are
integrating Teamcenter EDA for part library management and other options as required on the
ECAD client machine:

• Mentor PADS Library

• Mentor PADS Library Win32

• Mentor Xpedition EDM Library

• Mentor Xpedition Library

• Teamcenter Gateway for EDA Library

• Teamcenter Gateway for EDA Library Win32

By default, all options under EDA Client are selected. Remove the tools and applications that are
not required for part library integration and click Update Selected Applications.

Deployment Center automatically selects any additional dependent applications.

5. Go to the Components task.

6. In the Selected Components list of the Components task, note any remaining components whose
configuration status is not 100%. Select each incomplete component, enter required parameters,
and save component settings until all components in the environment show a configuration status
of 100%.

When all components are fully configured, the Deploy task is enabled.

7. Go to the Deploy task. Click Generate Install Scripts to generate deployment scripts you will use
to update affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.

8. Locate deployment scripts, copy each script to its target machine, and then run each script on its
target machine.

For more information about running deployment scripts, see Run the deployment scripts in the
Deployment Center documentation.

You can also generate mini-kits for mass client deployment. Running the generateMiniSoftware
utility extracts only the necessary software from the full software kits and builds a smaller, more
portable software kit for the specific client deployment. For more information, see Generating mini
kits for mass client installations in Deployment Center ─ Usage on Support Center.

Install Teamcenter EDA for part library management using Deployment Center
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If you face any issues during the deployment, see Troubleshoot the deployment script in the
Deployment Center documentation.

Installing Teamcenter server for part library management through
TEM

Installing the Teamcenter server for part library management

Install Teamcenter

To install Teamcenter EDA, you must first install Teamcenter. To install the Teamcenter corporate server,
refer to the Teamcenter Installation on Windows Using TEM help.

If you have an existing Teamcenter environment, you can update it to support the latest EDA version.

Refer to the Install patches on a Teamcenter server topic in the Teamcenter Installation on Windows
Using TEM help for instruction on installing Teamcenter patches.

Add EDA server support and library support on Teamcenter

EDA Server Support adds the EDA data model to the Teamcenter data model. ECAD Library
Management adds the EDA part library data model to the existing Teamcenter data model. As the
EDA client is supported in a four-tier architecture, the EDA Server Support feature (data model) must
also be installed on this Teamcenter server.

Because you are adding EDA server support and library support to an already existing Teamcenter server,
launch Teamcenter Environment Manager from your Teamcenter environment.

1. Start Teamcenter Environment Manager (TEM).

2. Select the Configuration Manager option to perform maintenance on an existing installation and
click Next until the Select Features dialog box appears.

3. In the Select Features dialog box:

a. Choose Extensions→Supplier Relationship Management and select Vendor Management.

b. From Extensions→Mechatronics Process Management, select the following options:

• EDA Server Support

• EMPS-Foundation

• ECAD Library Management.

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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c. Choose Extensions→Mechatronics Process Management and select EDA for Business
Modeler IDE.

d. Specify Active Workspace server extensions features for EDA. These are available in the
Features panel in Teamcenter Environment Manager (TEM), under Base Install→Active
Workspace→Server Extensions→EDA Server Support for Active Workspace.

e. Specify Active Workspace client extensions features for EDA. These are available in the
Features panel in Teamcenter Environment Manager (TEM), under Base Install→Active
Workspace→Client→Electronic Design Automation for Active Workspace.

4. In the Installation Directory box, type the location where you want to install Teamcenter
(TC_ROOT).

5. Click Next.

6. Enter information as needed in the subsequent panes.

7. In the Confirm Selections dialog box, click Next.

The EDA server components are installed.

The Add/Remove Components dialog box confirms if the installation is successful. If the
installation is unsuccessful, click Show Details and proceed as needed.

8. Obtain the license file that includes EDA licensing and EDA library license (for library support) and
install it on the server.

After adding the EDA server support and library support to your Teamcenter environment, you must
verify your installation by checking whether the EDA data types are added to Teamcenter.

Verify your installation

Verify the addition of the EDA data types to the server:

1. Run the Teamcenter rich client.

2. In My Teamcenter, choose File→New→Item.

The New Item dialog box is displayed.

3. Verify that the EDA, EDAComp, EDASchem, and EDACCABase item types are added to the list of
types you can create.

4. Select one of the EDA item types and create an instance.

Verify your installation
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5. Verify that the item instance is created.

Install BMIDE for mapping ECAD library objects with Teamcenter objects

You must install Business Modeler IDE to configure mapping of ECAD library objects with Teamcenter
objects.

You can install the BMIDE either as a stand-alone application, or place the BMIDE plug-ins into an
existing Eclipse environment.

For instructions on installing BMIDE, refer to the Install the Business Modeler IDE topic or the Add the
Business Modeler IDE to an existing Eclipse SDK environment topic in the BMIDE for Data Model Design
documentation on Support Center.

Install or update Dispatcher for translating ACIS parts to NX parts and JT file

If Dispatcher is already installed in your existing Teamcenter environment, you can use the same
instance. However, you must modify it to include an additional translator to translate the ACIS part
files to NX parts.

For library integrations, the acistoprt translator will support the translation of the ACIS part to NX part.
Further more, to convert the NX part to JT file to visualize the part in Active Workspace, you must enable
the NxToPvDirect translator.

Note:

Ensure that the TC_DATA and TC_ROOT point to correct location in the Dispatcher\Translators\
\nxtopvdirect\nxtopvdirect.bat.

For instructions on installing Dispatcher, refer to the Dispatcher ─ Deployment and Administration
documentation on Support Center. After installing and setting up the dispatcher you must enable the
acistoprt translator.

Setting up Teamcenter server for part library management

Overview of configuring Teamcenter for ECAD part library management

Before you install and enable your design tools, you must configure your server for part library
management.

To enable the part library feature, you can create a custom classification schema, set up the mappings,
map the ECAD part attributes and component instance attributes, and configure the import or export
process. Additionally, you can change the system preferences as per your requirements.

You must configure the following for part library integration on your Teamcenter server:

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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• Create external applications for your ECAD tool in Teamcenter.

External applications are part libraries that are based on site objects. To create an EDA library gateway
application configuration file on the EDA client, you must first setup external applications on your
Teamcenter server. You can create external applications for setting up your ECAD library tool by using
the OOTB application types or by creating a custom application type. You can then create the EDA
library gateway application configuration file using the application types available on the Teamcenter
server.

• Create a Teamcenter part library

The Teamcenter part library is the enterprise-wide master ECAD library. Users can either export the
whole ECAD library into Teamcenter or select a subset of it and then upload it to Teamcenter. You
can identify the parts that do not exist in Teamcenter and save them to Teamcenter. After you have
enabled and configured the part library to function with Teamcenter, users can start working with the
part library management feature.

• Map ECAD part attributes to Teamcenter properties and Map ECAD library objects to Teamcenter
objects.

ECAD part attributes can be mapped to Teamcenter properties. When parts are imported into
Teamcenter, ECAD attributes are placed into the corresponding Teamcenter Classification object. The
ECAD attributes can also be mapped to the properties on the Item or ItemRevision objects. When
parts are exported from Teamcenter, the properties are mapped back to the corresponding part
attributes in the ECAD tool. All ECAD attributes are passed to Teamcenter during import. However,
only the attributes that are mapped to Teamcenter properties are imported.

You can also update or modify the following OOTB configurations or use custom configurations for
part library integration on your Teamcenter server:

• Create a custom classification schema and set up classification mapping for part library
management. The classification mapping converts the part category in the ECAD tool library to the
class ID defined in Teamcenter Classification and vice versa.

• Use custom objects or custom relations by modifying default values in the EDA library preferences.

Teamcenter EDA provides a basic set of objects and relations. The relations between the object
and the item and item revision determines the rules enforced. By default, Teamcenter objects
and relations are created during the EDA library integration, which can be configured using the
Teamcenter EDA library preferences.

The administrator can also use custom objects and relations by modifying the default values of the
preferences that are used to create the default Teamcenter objects and relations. Before using custom
part types, custom objects, and relations, you can refer to the EDA library preferences that are used to
create the OOTB objects and the OOTB relations.

• Synchronize ECAD library parts with multiple external sites

Overview of configuring Teamcenter for ECAD part library management
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ECAD users should be able to synchronize and reuse the part data across multiple external sites. You
can create a query in the Query Builder application to support synchronization of ECAD library parts
with multiple external sites.

• Managing and configuring system preferences for part library management.

Create external applications for your ECAD tool in Teamcenter

External applications are part libraries that are based on site objects. In the Organization application,
you can create, modify, and delete external applications. To create EDA library gateway application
configuration file on the EDA client, you must first set up external applications on your server. You can
create external applications for setting up your ECAD library tool by:

• Using the OOTB application types

Based on the application types currently supported on the Teamcenter server, the default application
names, family names, and primary dataset types for the supported application types is given in the
table below for setting up ECAD library integration.

Note:

The application name in the *.edadef file, *.edadef file name, and in the Teamcenter
application ID must be same.

Library
Integration Application Name

Application
Type (External
Applications) Family Name

Primary Dataset
type

Mentor Xpedition mentorExpLib Mentor Expedition expedition EDAComExpedition
Mentor PADS mentorPadsLib Mentor Pads pads EDAComPADS
Mentor EDM mentorEDXLib Mentor EDX mentorEDX Epl0EDXPackage

OR

• Creating a custom application type

Instead of using the OOTB application types, you can define a new application type in the
EDALIB_External_Applications preference. Refer to the preference description for the details.

After the application type is defined in the EDALIB_External_Applications preference, it is displayed
in the Application Types list along with the OOTB values. You can then create external applications
using this custom value. For example, you can create a custom application type named TcEDA.

1. Select the top-level External Applications node  from the Organization List tree.

The External Applications pane appears.

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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2. Complete the following information:

a. Type a unique application name in the Application Name box using any combination of
alphanumeric characters. You can use the hyphen (-) and underscore (_) special characters.

b. Type a unique application ID in the Application ID box. The application ID must be any valid
positive integer.

To automatically generate a unique application ID, click the Assign button.

c. Select the application type from the Application Type list. You can use either the OOTB
application type or a custom application type to create an external application.

• Use the OOTB application type from the available options:

• Mentor Expedition

• Mentor Pads

• Mentor EDX

• Mentor board station

OR

• Use a custom application type

After the application type is defined in the EDALIB_External_Applications preference, it is
displayed in the Application Types list along with the OOTB values, for example TcEDA.
Select the custom application type from the list.

Create external applications for your ECAD tool in Teamcenter
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d. Select Allow deletion of replicated master items to this site to allow the deletion of
replicated master items.

Note:

The Uses TCXML Payload check box only for information purposes and cannot be
modified.

3. Click Create.

Create a Teamcenter part library

Because the Organization application in Teamcenter is integrated with the ECAD part library, you can
create the Teamcenter part library in Organization using the External Applications node. This node
holds the part libraries created.

1. Open Organization.

2. From the Organization List tree, select the External Applications node.

The External Applications pane appears.

3. Type a name In the Application Name box. This can be any combination of alphanumeric
characters.

4. Type an ID in the Application ID box.

This can be any positive integer. If you want the system to generate an ID, click Assign.

5. From the application type list, select a type based on your ECAD tool. All available ECAD options are
listed here.

Note:

Select the PADS application type only for the PADS standard product. For PADS Professional
product, you must select Xpedition application type.

6. Check Allow deletion of replicated master objects to this site.

7. Click Create.

The new part is created and listed under the External Applications node in the Organization List
tree.

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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Mapping ECAD part attributes to Teamcenter attributes

Overview of mapping ECAD part attributes with Teamcenter properties

ECAD part attributes and objects must be mapped to Teamcenter properties. When the ECAD parts are
imported into Teamcenter, ECAD attributes are placed into the corresponding Teamcenter properties.
When parts are exported from Teamcenter, the properties are mapped back to the corresponding part
attributes in the ECAD tool. All ECAD attributes are passed to Teamcenter during import. However, only
the attributes that are mapped to Teamcenter properties are imported.

During the EDA library integration, OOTB mappings between the ECAD tool and Teamcenter are
provided by default in the Integration Definition File. You can customize the mappings in Teamcenter by
making changes in the Integration Definition File. Refer to the best practices for mapping ECAD library
objects to Teamcenter objects topic before creating custom mappings.

Best practices for mapping ECAD library objects to Teamcenter objects

• Use the available EDA type objects in Teamcenter

Instead of using the generic item types to represent EDA objects in Teamcenter, use the available EDA
types or subtypes. This limits the number of objects for the synchronizer to process and improves
performance.

Teamcenter provides the following EDA objects:

• Epl0EDALibPart

• EDAComPart

• EDASymbol

• EDAFootprint

• Map different EDA objects in separate types to avoid duplicate item IDs

• Use the default type mappings

Even though you can give any name for EDA objects in the EDAlib.xml file, and then map the object
names to Teamcenter business object types, Siemens Digital Industries Software recommends that
you use the following types to represent your ECAD objects in the EDAlib.xml file:

Overview of mapping ECAD part attributes with Teamcenter properties
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ECAD object Description Value in the EDAlib.xml file

Library part Represents a library part LibraryPart

Component/Part Represents a component or
part

Component

Symbol/
Schematic Model

Represents a symbol Symbol

Footprint Represents a footprint Footprint

• The name attribute is mandatory and some ECAD applications do not have a corresponding attribute.
In this case, the value of the name attribute can be itemID.

   <property name="itemId" required="true">
   </property> <property name="name" required="true"> </property>

• Usually, attributes in the ECAD library tools are in the string format. However, the corresponding
Teamcenter properties may be in a different format to leverage the Teamcenter Classification search
capabilities. Ensure that the unit in the ECAD attribute matches the Teamcenter attribute unit. The
value can then be converted to the Teamcenter attribute format. Otherwise, the import fails. To check
the Teamcenter attribute format, refer to Basic Classification ─ Deployment and Administration help
on Support Center.

Additionally, the Classification application uses the concept of unit bundles. For example, distance is
measured using units in a bundle, such as millimeters, centimeters, meters, and inches. Among the
units in a bundle, one of them is known as the base unit, and its attribute value is saved into the
database. However, the Classification import-export layer does not provide APIs to access subunits
other than the base unit. This leads to ECAD library integrations failing during an import when the
value is not in the base unit. To avoid this problem, do not use unit bundles for ECAD attributes in
ECAD tools and Classification.

Map ECAD part attributes to Teamcenter attributes

If you use a custom part or dataset type in your ECAD tool, you must create the corresponding item and
dataset in Teamcenter using Business Modeler IDE before mapping the custom objects. Refer to the Best
practices for mapping ECAD library objects to Teamcenter objects topic before mapping ECAD part
attributes to Teamcenter attributes to avoid ECAD library integrations failing during an import.

You can customize the mappings in Teamcenter by downloading the Integration Definition File from
the dataset for respective integration, editing the file, and importing the file back into the dataset in
Teamcenter.

• Search the dataset in Teamcenter for the respective library integration. Names of the dataset to search
for a specific library integration is given in the table below. For instructions on how to search datasets
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in Teamcenter, refer to Searching in Teamcenter topic in the Teamcenter Basics help on Support
Center.

Integration Dataset name Integration Definition File in the dataset
Mentor
EDX
Library

MENTOREDXLIB_BHM_INT_DEF_FILE MENTOREDXLIB_BHMIntegrationDefinition.xml

Mentor
Expedition
Library
(ODBC)

MENTOREXPLIB_BHM_INT_DEF_FILE MENTOREXPLIB_BHMIntegrationDefinition.xml

Mentor
PADS
Library

MENTORPADSLIB_BHM_INT_DEF_FILE MENTORPADSLIB_BHMIntegrationDefinition.xml

• Perform a check-out operation on the selected dataset. For instructions on how to checkout objects in
Teamcenter, refer to Check out an Object topic in the Teamcenter Basics help on Support Center.

• Download the Integration Definition File within the dataset.

• Make changes in the Integration Definition File to add the ECAD tool attributes. For instructions on
how to modify configurations related to attribute mappings in the Integration Definition File, refer to
the Integration Definition File topic in the MBSE Integration Gateway ─ Deployment help on Support
Center.

• Replace the Integration Definition File with the updated one in the dataset.

• Perform the check-in operation on the dataset.

Sample ECAD part attribute mapping definitions

The below example defines sample ECAD part attribute mappings for Mentor PADS library integration
within the Integration Definition File.

<?xml version="1.0" encoding="utf-8"?>
<!-- 
@<COPYRIGHT>@
=========================================================================
=======
Copyright 2023.
Siemens Product Lifecycle Management Software Inc.
All Rights Reserved.
=========================================================================
=======
@<COPYRIGHT>@
-->

Sample ECAD part attribute mapping definitions
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<!--
 
    This file contains the object mapping definition for all the 
    EDA objects created in Teamcenter using Tc EDA integration.
 
-->
<BHMIntegration xmlns="http://www.plmxml.org/Schemas/bhm" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.plmxml.org/Schemas/bhm" 
applicationName="MENTORPADSLIB">
    <ConnectorClass fullName="" jarFilePath="" />
    <SupportedVersions>
        <Version id="2018.1" />
    </SupportedVersions>

    <ObjectMapping type="Component" behaviorType="MIXED" 
tctype="EDAComPart">
        <AttributeMappings>
            <AttributeMapping name="name" tcattr="object_name" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="id" tcattr="item_id" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="description" tcattr="object_desc" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="object_application" 
tcattr="object_application" includeinduplicatecheck="false"/>
            <RevisionAttributeMapping>
                <AttributeMapping name="object_application" 
tcattr="object_application" includeinduplicatecheck="false"/>
            </RevisionAttributeMapping>
        </AttributeMappings>

        <BHMElement type="mentorPadsLib" tctype="EDAComPADS" 
behaviorType="GRM" reltype="IMAN_reference" reftype="mentorPadsLib"></
BHMElement>
        <BHMElement type="Footprint" tctype="EDAFootprint" 
behaviorType="BVR" reltype="" reftype=""></BHMElement>
        <BHMElement type="Symbol" tctype="EDASymbol" behaviorType="BVR" 
reltype="" reftype=""></BHMElement>
    </ObjectMapping>

    <ObjectMapping type="Footprint" behaviorType="MIXED" 
tctype="EDAFootprint">
        <AttributeMappings>
            <AttributeMapping name="name" tcattr="object_name" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="id" tcattr="item_id" 
includeinduplicatecheck="false"/>
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            <AttributeMapping name="description" tcattr="object_desc" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="object_application" 
tcattr="object_application" includeinduplicatecheck="false"/>
            <RevisionAttributeMapping>
                <AttributeMapping name="object_application" 
tcattr="object_application" includeinduplicatecheck="false"/>
            </RevisionAttributeMapping>
        </AttributeMappings>
        <BHMElement type="mentorPadsLib" tctype="EDAComPADS" 
behaviorType="GRM" reltype="IMAN_reference" reftype="mentorPadsLib"></
BHMElement>
    </ObjectMapping>

    <ObjectMapping type="Symbol" behaviorType="MIXED" tctype="EDASymbol">
        <AttributeMappings>
            <AttributeMapping name="name" tcattr="object_name" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="id" tcattr="item_id" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="description" tcattr="object_desc" 
includeinduplicatecheck="false"/>
            <AttributeMapping name="object_application" 
tcattr="object_application" includeinduplicatecheck="false"/>
            <RevisionAttributeMapping>
                <AttributeMapping name="object_application" 
tcattr="object_application" includeinduplicatecheck="false"/>
            </RevisionAttributeMapping>
        </AttributeMappings>
        <BHMElement type="mentorPadsLib" tctype="EDAComPADS" 
behaviorType="GRM" reltype="IMAN_reference" reftype="mentorPadsLib"></
BHMElement>
    </ObjectMapping>

    <ObjectMapping type="mentorPadsLib" behaviorType="GRM" 
tctype="EDAComPADS">
        <AttributeMappings>
            <AttributeMapping name="name" tcattr="object_name" 
includeinduplicatecheck="false"/>
        </AttributeMappings>
        <FileMapping>
            <FileMap fileExt="*" tcNameReferencedType="*"  />
        </FileMapping>
    </ObjectMapping>

    <FileMapping>
        <FileMap fileExt="txt" tcDatasetType="Text" 
tcNameReferencedType="Text" />
        <FileMap fileExt="png" tcDatasetType="Image" 
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tcNameReferencedType="Image" />
        <FileMap fileExt="html" tcDatasetType="HTML" 
tcNameReferencedType="HTML" />
        <FileMap fileExt="jpg" tcDatasetType="JPEG" 
tcNameReferencedType="JPEG_Reference" />
        <FileMap fileExt="zip" tcDatasetType="Zip" 
tcNameReferencedType="ZIPFILE" />
        <FileMap fileExt="tif" tcDatasetType="TIF" 
tcNameReferencedType="TIF_Reference" />
        <FileMap fileExt="gif" tcDatasetType="GIF" 
tcNameReferencedType="GIF_Reference" />
        <FileMap fileExt="*" tcDatasetType="MISC" 
tcNameReferencedType="MISC_TEXT" />
    </FileMapping>
    
    <!-- Sample classification mappings -->
    <!-- Do not edit toolClassifybyAttribute value -->
    <!--    
    <ClassificationMapping>
        <AtributeCollection  toolClassId="Component">
            <ClassAttribute toolClassAttrId="Description" 
tcClassAttrId="-4275" direction="TcToTool"/>
        </AtributeCollection>

        <Class toolClassId="Component" tcClassId="RNC363" 
classifyAnchor="false">
        </Class>
        
        <Class toolClassId="Component" 
toolClassifybyAttribute="classificationCategory"  
toolClassifybyAttributeValue="TOP" tcClassId="RNC364" 
classifyAnchor="false">
            <ClassAttribute toolClassAttrId="Status" 
tcClassAttrId="-5489" direction="ToolToTc"/>
            <ClassAttribute toolClassAttrId="Currency" 
tcClassAttrId="-4253" direction="ToolToTc"/>
        </Class>
    </ClassificationMapping>
    -->

</BHMIntegration>

Map ECAD library objects to Teamcenter objects

You can map ECAD objects with Teamcenter objects. For example, if you want to add the Block model
from an ECAD tool to Teamcenter, perform the following steps:

1. Create the object in Business Modeler IDE.
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If there is no Teamcenter object that maps to the ECAD object, create a new Teamcenter object
using Business Modeler IDE.

For example, create an object called ReusableBlock as a subtype of Item in the Business Modeler
IDE.

For more information about creating objects, see the BMIDE for Data Model Design.

2. Configure the new object for classification.

Update the ICS_classifiable_types preference to enable classification of the Teamcenter object, for
example:

ICS_classifiable_types=ReusableBlock, ReusableBlock Revision

For more information on classification, refer to the Basic Classification ─ Deployment and
Administration help on Support Center.

3. Modify the Integration Definition File file to map the library object to Teamcenter object.

You can customize the mappings in Teamcenter by downloading the Integration Definition File
from the dataset for respective integration, editing the file, and importing the file back into the
dataset in Teamcenter.

You can create classification mapping for ECAD parts with Teamcenter classes in the Integration
Definition File.

Creating classification mapping for ECAD parts with Teamcenter classes

Overview of classifying ECAD library data

The Classification application utilizes a classification hierarchy to categorize your company's product
data. As the system administrator, you use Classification Admin to define the groups, classes, and views
that form the classification hierarchy. You also define and format the attributes that, when associated
with a class, determine the type of information that is stored.

You can import and export classification hierarchy data using either the import and export features in
the Classification Admin application or using command line utilities. Classification Admin supports both
legacy XML files, as well as the industry standard PLM XML.

As a library administrator, you can create a custom classification schema using the Teamcenter
Classification Admin application.

After you import or create the classification schema, you must set up Classification mapping. This is
a one-time process and the classification mapping must be updated only if the classification schema
is changed. Classification mapping converts the part category in the ECAD tool library to the class ID

Overview of classifying ECAD library data
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defined in Teamcenter Classification and the class ID in Teamcenter Classification to the part category in
ECAD tool library.

Because the classification schema may contain a long list of classes, the
edalib_generate_classification_csv_maps utility is provided to pre-populate the Classification mapping
files.

Before you begin

As a library administrator, you must create a classification schema using the Teamcenter Classification
Admin application. You can also create a custom classification schema if you are using custom business
objects.

Before you start working with the Teamcenter Classification Admin application:

Prerequisites Your classification administrator must have already created a
classification hierarchy in the Classification Admin application before
you can use Classification.

For details about how to create a schema, see the Basic Classification
─ Deployment and Administration help.

If you are using customized business objects (for example, customized
item types), your administrator must add the names of these to the
values of the ICS_classifiable_types preference.

Enable Classification Classification does not need to be enabled before you use it.

If you have trouble accessing Classification, see your system
administrator; it may be a licensing issue.

Note:

You can log on to Teamcenter only once. If you try to log on to
more than one workstation at a time, you see an error message.

Configure Classification Before you begin using Classification, your Classification administrator
must create the classification hierarchy.

Start Classification Click Classification  in the navigation pane.

If you are not licensed to run the application, you see an error message
and you are not able to perform any application functions.

Set up Classification mapping

After you import or create the classification schema, you must set up Classification mapping in the
Integration Definition File. This is a one-time process and the classification mapping must be updated
only if the classification schema is changed. Using the Integration Definition File, you can define
classification of objects and attributes in your modeling tool to objects and attributes in Teamcenter.
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For detailed instructions on how to classify objects and attributes between your ECAD tool and
Teamcenter using the Integration Definition File, refer MBSE Integration Gateway for Integrating
Modeling Tools help on Support Center.

An example of the classification mapping in the Integration Definition File is as follows:

<ClassificationMapping>
    <AtributeCollection  toolClassId="EDABOMComp">
        <ClassAttribute toolClassAttrId="PartNumber" 
tcClassAttrId="-5485" direction="TcToTool"/>
        <ClassAttribute toolClassAttrId="Mass" tcClassAttrId="-5491" 
direction="ToolToTc"/>
        <ClassAttribute toolClassAttrId="OperatingTemperature" 
tcClassAttrId="-5517" direction="ToolToTc"/>
    </AtributeCollection>
    <Class toolClassId="EDABOMComp" tcClassId="RNC363" 
classifyAnchor="false">
        <ClassAttribute toolClassAttrId="NumberOfFans" 
tcClassAttrId="-5160"/>
        <ClassAttribute toolClassAttrId="FanDiameter" 
tcClassAttrId="-5159"/>
        <ClassAttribute toolClassAttrId="UnitCapacity" 
tcClassAttrId="-5158"/>
        <ClassAttribute toolClassAttrId="NumbMaximumSupplyPowererOfFans" 
tcClassAttrId="-5157"/>
    </Class>
    <Class toolClassId="EDABOMComp" 
toolClassifybyAttribute="classificationCategory"  
toolClassifybyAttributeValue="top/HEATSINK" tcClassId="RNC364" 
classifyAnchor="false">
        <ClassAttribute toolClassAttrId="ThermalResistance" 
tcClassAttrId="-6700" direction="TcToTool"/>
        <ClassAttribute toolClassAttrId="Height" tcClassAttrId="-6643" 
direction="ToolToTc"/>
        <ClassAttribute toolClassAttrId="Length" tcClassAttrId="-6641" 
direction="ToolToTc"/>
        <ClassAttribute toolClassAttrId="FinThickness" 
tcClassAttrId="-5182" direction="ToolToTc"/>
    </Class>
</ClassificationMapping>

Note:

The mapping files must contain the classId value of components mapped to the EDA class only.
If any component is mapped to any class other than the EDA classes, for example, mechanical
class, such components should not be mentioned in the in the Integration Definition File.

Set up Classification mapping
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The value for the toolClassifybyAttribute should always be fixed as classificationCategory.

How to use a custom part type in the EDA library integration

Overview of custom part types, objects, and relations

Organizations produce several documents that describe, are used by, or in some way relate to an item.
For the data to be understood, it has to be associated in a meaningful way to the item or item revision.
Teamcenter associates data to items and item revisions using relations.

Teamcenter EDA provides a basic set of part types, objects, and relations. The relations between the
object and the item and item revision determines the rules enforced. By default, Teamcenter objects
and relations are created during the EDA library integration. These OOTB objects and relations can be
configured using the Teamcenter EDA library preferences.

When a user exports, saves, or synchronizes the ECAD library part from the ECAD tool to Teamcenter,
the ECAD part is created in Teamcenter and all objects and relationships defined in Teamcenter will be
associated with the new library part. You can use custom part types by modifying default preference
values and modifying the default query details in Teamcenter.

The administrator can also use custom objects and relations by modifying the default values of the
preferences that are used to create the default Teamcenter objects and relations. You can refer to
the EDA library preferences that are used to create the OOTB objects and the OOTB relations in
Teamcenter.

Use a custom part type for EDA library integration

When an ECAD designer exports, saves, or synchronizes the ECAD library part from the ECAD tool
to Teamcenter, the ECAD part is created in Teamcenter and all objects and relationships defined in
Teamcenter will be associated with the new library part. Teamcenter EDA provides a basic set of part
types, objects, and relations. You can also use custom part types by modifying the default preference
values and modifying the default query details in Teamcenter.

To use a custom part type instead of the default part type for the EDA library integration:

1. Specify your custom part type in the respective Object Mapping section in the Integration Definition
File.

2. Check the default value defined for the EDALIB_Sync_FindNewParts preference. This default value
represents the query saved in Teamcenter to find new parts for EDA library synchronization. The
default value is __EDALIB_find_newparts.

3. In the Query Builder application, search for the __EDALIB_find_newparts query and change the
default search criteria value defined in this query for the object_type attribute with the custom
part type defined in the step 1.
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For more information on how to modify and create a query, refer to the Query Builder
documentation on Support Center.

The administrator can also use custom objects and relations by modifying the default values of the
preferences that are used to create the default Teamcenter objects and relations. You can refer to
the EDA library preferences that are used to create the OOTB objects and the OOTB relations in
Teamcenter.

OOTB Teamcenter objects created during the EDA library integration

Teamcenter objects are created during the EDA Library integration with OOTB configurations using the
EDA library preferences in Teamcenter.

The following EDA library preferences are used for creating the OOTB Teamcenter objects:

Preference name Description Default values

EDAPadstackRelation_relatio
n_primary

This preference is used
to define the primary
relation objects for the
EDAPadstack relation for
RAC.

EDAFootprint Revision

EDAPackage Revision

ICS_classifiable_types This preference is used
to identify whether a
particular type can be
classified or not. It is
recommended that the
default value should be
set as Item/ItemRevision

EDAComPart

EDAComPart Revision

Epl0EDALibPart

Epl0EDALibPartRevision

EDASymbol

EDASymbol Revision

EDAFootprint

EDAFootprint Revision

Vendor

VendorRevision

ICS_attribute_mapping_-
unit_support

This preference is used
to identify whether a
particular type of object
can be supported for
attribute mapping not.

EDAComMentorBS

EDAComPADS

EDAComExpedition

EDAComCR5000

EDAComCADStar

EDAComPCAD

OOTB Teamcenter objects created during the EDA library integration
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Preference name Description Default values

Epl0EDXPackage

EDAComPart

Epl0EDALibPart

EDASymbol

EDAFootprint

Note:

The EDA_ComponentItemTypes, EDALIB_PartTypeDefault,
EDALIB_Classification_Object_Type, EDALIB_SymbolTypeDefault,
EDALIB_FootprintTypeDefault, EDALIB_PadstackTypeDefault,
EDALIB_GDETypesMapping, EDALIB_DatasetTypesMapping, EDALIB_ManagedObjects,
EDALIB_AttributesForms_mentorEDX, and EDALIB_ItemTypesMapping preferences are now
replaced by mappings in the Integration Definition File for respective library integration.

Based on your connector configurations, specific object types will be used. A list of all supported
Teamcenter object types is given below for reference only:

EDAComPart EDAComPADS

EDAComPartMaster EDAComPCAD

EDAComPartVerMaster Epl0EDXPackage

EDAComPart_0_Revision_alt EDAComPart Master

EDAFootprint EDAComPart Revision Master

EDAFootprintMaster EDAFootprint Master

EDAFootprintVerMaster EDAFootprint Revision Master

EDAFootprint_0_Revision_alt EDAPackage Master

EDAPackage EDAPackage Revision Master

EDAPackageMaster EDAShape Master

EDAPackageVerMaster EDAShape Revision Master

EDAPackage_0_Revision_alt EDASymbol Master

EDAPadstackStorage EDASymbol Revision Master

EDAShape Epl0AttrForm
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EDAShapeMaster Epl0EDALibPartMaster

EDAShapeVerMaster Epl0EDALibPartRevisionMaster

EDAShape_0_Revision_alt EDAPadstack

EDASymbol EDAComPart Revision

EDASymbolMaster EDAFootprint Revision

EDASymbolVerMaster EDAPackage Revision

EDASymbol_0_Revision_alt EDAPadstackRelation

Epl0AttrFormStorage EDAShape Revision

Epl0EDALibPart EDASymbol Revision

Epl0EDALibPartMasterS Vendor

Epl0EDALibPartRevMasterS VendorRevision

Epl0EDALibPartRevision ManufacturerPart

EDAComExpedition EDAComMentorBS

OOTB Teamcenter relations configured during the EDA library integration

Teamcenter relations are created by default during the EDA Library integration with OOTB configurations
using the EDA library preferences in Teamcenter.

The following EDA library preferences are used for creating the OOTB Teamcenter relations:

Preference name Description Default values

EDAPadstack_shown_-
relations

This preference is used
to specify the relations to
display when expanding a
node for an object of type
EDAPadstack.

IMAN_Rendering

IMAN_reference

EDAComPart Revision_-
DefaultChildProperties

Lists the properties that
can be used as children
for the type EDAComPart
Revision.

IMAN_master_form_rev

bom_view_tags

IMAN_requirement

IMAN_manifestation

IMAN_reference

IMAN_MEView

OOTB Teamcenter relations configured during the EDA library integration
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Preference name Description Default values

IMAN_vi_sos

IMAN_external_object_link

IMAN_specification

TC_WorkContext_Relation

TC_AuditLog

TC_Is_Represented_By

release_status_list

vendors

vendorparts

structure_revisions

view

Epl0HasSimulation

EDAComPart
Revision_PseudoFolder

This preference is used
to list the properties that
can be displayed as a
pseudo-folder under a
node for objects of type
EDAComPart Revision
object in the Rich client.

CAEAnalysis

MEProcess

MESetup

view

Epl0HasSimulation

EDAFootprint Revision_-
DefaultChildProperties

This preference is used
to list the properties
that can be used as
children for the type
EDAFootprint Revision.

IMAN_master_form_rev

IMAN_reference

EDAPadstackRelation

EDAPackage Revision_-
DefaultChildProperties

This preference is used
to list the properties that
can be used as children
for the type EDAPackage
Revision.

IMAN_master_form_rev

IMAN_reference

EDAPadstackRelation

EDAPadstack_-
DefaultChildProperties

This preference is used
to list the properties that
can be used as children
for the type EDAPadstack
object in the rich client.

IMAN_Rendering

IMAN_reference

Epl0EDALibPartRevision_-
DefaultChildProperties

This preference is used
to list the properties
that can be used as

IMAN_master_form_rev
bom_view_tags
IMAN_requirement
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Preference name Description Default values

children for the type
Epl0EDALibPartRevision
object in the rich client.

IMAN_manifestation

IMAN_reference

IMAN_MEView

IMAN_vi_sos

IMAN_external_object_link

IMAN_specification

TC_WorkContext_Relation

TC_AuditLog

TC_Is_Represented_By

release_status_list

structure_revisions

view

Epl0HasSimulation

Epl0HasComponent

Epl0EDALibPartRevision_-
PseudoFolder

This preference is used
to list the properties that
can be displayed as a
pseudo-folder under a
node for objects of type
Epl0EDALibPartRevision
object in the Rich client.

Epl0HasSimulation

Epl0HasComponent

IMAN_reference_relation_-
primary

This preference is used
to indicate the list
of valid primary object
types for the relation
IMAN_reference.

EDAPadstack

Note:

The EDAComPart Revision_<DatasetType>_default_relation,
EDAFootprint Revision_<DatasetType>_default_relation , EDAPackage
Revision_<DatasetType>_default_relation , EDAPadstack_<DatasetType>_default_relation,
and EDASymbol Revision_<DatasetType>_default_relation preferences are now replaced by
mappings in the Integration Definition File for respective library integration.

Based on your connector configurations, specific Teamcenter relations will be used. A list of all supported
Teamcenter relations is given below for reference only:

OOTB Teamcenter relations configured during the EDA library integration
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EDAPadstackRelation

Epl0HasAttrForm

Epl0HasComponent

Epl0HasEDXPackage

Epl0HasSimulation

IMAN_reference

view

VMRepresents

TC_vendor_part_rel

IMAN_Rendering

IMAN_master_form_rev

bom_view_tags

IMAN_requirement

IMAN_manifestation

IMAN_MEView

IMAN_vi_sos

IMAN_external_object_link

IMAN_specification

TC_WorkContext_Relation

TC_AuditLog

TC_Is_Represented_By

release_status_list

vendors

vendorparts

structure_revisions
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Transfer mode used for EDA library integration

EDA library integration uses the following Transfer Mode information while creating export records.
For more information about the transfer modes and how they work, refer the Tc XML and PLM XML
Configuration for Data Import and Export help in the Teamcenter documentation.

Transfer Option Set Transfer Mode
Closure Rule (Transfer
Rule) Property Set

TIEOptionSetEdaLib TIEEdaLibExport TIEEDALibExport TIEExportDefaultPS

Synchronize ECAD library parts with multiple external sites

To enable ECAD users synchronize and reuse their part data across multiple external sites, you create a
query in the Query Builder application to support this synchronization. Consider an example where you
want to synchronize a part that is already synchronized with SiteB to a different site, SiteA.

1. Create a new query __EDALIB_find_parts_sync_multiple_sites_<site name> in the Query Builder
application using an existing query __EDALIB_find_parts_sync_multiple_sites where <site name>
is the name of the site to which you want to synchronize the parts.

In our example, this is __EDALIB_find_parts_sync_multiple_sites_SiteA, where SiteA is the site to
which you want to synchronize the parts.

Transfer mode used for EDA library integration
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2. Specify the site name (SiteB) in the query to which the part is already synchronized.

Criteria for creating the query:

• The query must search for parts that are not yet synchronized to any site (new parts) AND the
parts that are synchronized to a site (SiteB).

• The above condition to search new parts and existing parts for a site (SiteB) is separated by the
OR function.

• In each condition, the object type EDAComPart is specified with a different User Entry L10NKey
(ObjectType1) and User Entry Name (ObjectType2) name.

3. Save the query. By default, the type of the query is Local Query.

4. To change the above query to a User Query, from the Teamcenter command prompt, run the
following command:

%TC_BIN% \tc_set_query_where_run –u=Tc-admin-user –p=password –g=group
-query=__EDALIB_find_parts_sync_multiple_sites_SiteA" –run=query
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5. Set the value of the preference EDALIB_Sync_FindNewParts with the new query name
(__EDALIB_find_parts_sync_multiple_sites_<site name>).

You can also specify this query name in the integration-specific preference. For
example, in the Xpedition EDX integration, the value can be set to the preference
EDALIB_Sync_FindNewParts_mentorEDX.

To modify a query in the Query Builder application, you must first change the query type to Local Query.
To do this, from the Teamcenter command prompt, run the following command:

%TC_BIN% \tc_set_query_where_run –u=Tc-admin-user –p=password –g=group
-query=__EDALIB_find_parts_sync_multiple_sites_SiteA" –run=iman

After making the required changes to the query, run the command specified in the Step 4 to change it to
User Query again.

Managing and configuring Teamcenter preferences for part library
management

You can set system-wide preferences on the Teamcenter server that apply to all EDA users. To
understand how preferences work and to understand how to access a list of all supported preferences,
refer to the Managing Preferences help on Support Center. All EDA preferences begin with the prefix
EDALIB.

1. Run the rich client on the Teamcenter server and log on as an administrator.

2. In My Teamcenter, choose Edit→Options.

3. At the bottom of the Options dialog box, click Index.

4. In the Preferences dialog box, search for the preferences that begin with EDALIB_.

5. Change the preference value and click the Modify button to save the new value.

Installing the EDA client for part library management

Install the EDA client for part library management

Use the tem.bat command from the Teamcenter software kit to launch Teamcenter EDA Environment
Manager (TEM) to perform installation and maintenance operations of Teamcenter EDA on an ECAD
workstation for part library integration.

TEM is available with the Teamcenter installation or upgrade images. Contact your Teamcenter
installation administrator to obtain the correct product distribution image.

Managing and configuring Teamcenter preferences for part library management

Xpedition and PADS Integration With Teamcenter, Teamcenter 2412  5-31
© 2025 Siemens



Caution:

Before installing the EDA client on your ECAD workstation, refer to all the prerequisites and the
information required to install the client in the Planning your deployment topic.

1. Ensure that the proper version of JRE is installed and the JRE_HOME environment variable (32-bit
system) or the JRE64_HOME environment variable (64-bit system) is set.

2. Extract the Teamcenter software distribution image to a temporary location.

3. Specify the path to the Java Runtime Environment (JRE) by setting the JRE_HOME environment
variable on the ECAD workstation.

You can also specify the JRE path when you launch TEM from the command line using the -jre path
argument.

4. Start TEM.

a. Browse to the root directory of the extracted Teamcenter EDA software distribution image.

b. Right-click the tem.bat program icon and choose Run as administrator.

TEM launches and displays the Installer Language panel.

c. In the Installer Language panel, select a language and click OK.

TEM displays the Welcome to Teamcenter EDA panel.

Your language selection applies only to the TEM session and not the Teamcenter EDA
installation.

5. In the Welcome to Teamcenter EDA panel, click Install.

6. In the Configuration panel, type the configuration ID and the description for the new Teamcenter
EDA configuration.

The configuration ID identifies your Teamcenter configuration when you maintain, upgrade,
uninstall, or add features to the configuration. Installation log files are also named based on this ID.

7. Proceed to the Features panel and click Next.

8. Expand EDA Client and select the required options:

• ECAD Library Integrations
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Select the library tool support you require. This integrates the ECAD library tool with the EDA
client. However, a separate installation of the ECAD tool is required.

• Mentor PADS Library

• Mentor PADS Library Win32

• Mentor Xpedition EDM Library

• Mentor Xpedition Library

• Teamcenter Gateway for EDA Library

• Teamcenter Gateway for EDA Library Win32

9. In the Installation Directory box, browse to a folder where the EDA client will be installed. For
example, type c:\EDA_client for Windows.

The client is installed to an eda subdirectory, for example, c:\ECAD_client\eda (Windows). This
directory is known as TCEDAECAD_ROOT.

10. Click Next.

11. In the FCC Client Cache (FCC) panel, select Use new FCC and click Next.

12. In the FCC Parents panel, type the Host name of the Teamcenter server in the FCC Parents box.

13. In the 4-tier Server Configurations panel, type the IP address of the Teamcenter server in the
4-tier Servers box. For example:

http://host:7001/tc

Replace host with the server name.

14. In the EDA Client panel:

a. Change the path if needed in the Staging Location box.

You must enter the full path to the directory where the ECAD designs are saved on the client.
This directory is the working directory for EDA.

If a staging directory already exists, you can continue using the same directory or select
another folder as the staging directory.

Install the EDA client for part library management
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Caution:

Do not use spaces in the cache or staging directory path. Some EDA functions do not
work if there are spaces in these paths.

b. Clear the Will this configuration be shared by multiple users? check box to create user
environment variables after installation. By default, the check box is selected to create system
environment variables.

c. Click Next.

15. Review the features selected in Confirmation panel and click Start.

The EDA client components are installed.

The Install panel confirms whether the installation is successful. If the installation is successful,
click Close. If the installation is unsuccessful, click Show Details and proceed as needed.

After the installation of EDA client is complete you must verify that the EDA client is installed correctly
and perform the configurations for setting up part library management.

You can also perform additional ECAD library tool customizations for setting up library management
integration.

Verify the EDA client installation

Verify the EDA client installation by checking the following:

1. Ensure that Teamcenter client communication system (TCCS) services point to the Teamcenter
server with EDA server support.

2. The FMS fcc.xml file points to your Teamcenter server.

3. The FMS_HOME system environment variable is set and points to the location of the fcc.xml file.

4. The TCEDAECAD_ROOT user environment variable is set to your EDA directory (for example,
c:\EDA_client\eda on Windows systems).

The value of TCEDAECAD_ROOT is added to PATH.

5. The directory defined by the TCEDAECAD_ROOT user variable exists and is populated with files.

6. The relevant ECAD tool subdirectory exists (<TCEDAECAD_ROOT>\eda\.
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If you are using PADS, verify that the PADS subdirectory exists. If you are using Xpedition, verify
that the Mentor_Expedition subdirectory exists.

7. The TCEDAClient.properties file in the TCEDAECAD_ROOT directory contains the values you
entered using the installation routine, for example:

URL=http://hostname:port/tc
StagingDir=staging-directory-location

Note:

When you first run EDA, the staging directories are created from the settings in the
TCEDAClient.properties file.

The paths of the staging directories contain double back slashes (\\) on Windows systems. For
example:

C:\\ecad\\EdaStaging

Configure the EDA client for part library management

Steps to configure the EDA client for part library management

You can perform the following configurations and customizations to set up the EDA client for part library
management.

• Create customized gateway configurations for managing ECAD part data

The Teamcenter Gateway for part library management enables one or more ECAD part library
applications to connect with the Teamcenter server to manage ECAD part data, customize
configuration files, and also manage the relation between the library objects. Teamcenter provides
some OOTB configuration files and templates that you can use to configure Teamcenter Gateway for
EDA for part library management.

• Create an ECAD library configuration

• Map ECAD library objects to Teamcenter objects using ODBC mapping

After mapping ECAD library objects to Teamcenter objects, you can map the properties of ECAD
objects to the Teamcenter objects using the Open Database Connectivity database applications
(ODBC) mapping. The ODBC mapping feature is only available if your ECAD tool supports ODBC
databases.

• Set up EDA part library synchronization with Teamcenter

To make specific design teams use only the latest data, ECAD library administrators can establish
specific synchronization schedules and processes (or execute the process on demand) between

Steps to configure the EDA client for part library management
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Teamcenter and an ECAD tool’s local library. The synchronization process identifies any new or
updated parts that need to be exported to local libraries. Prior to executing a synchronization process,
the library administrator can browse the list to verify which parts should be updated in the local ECAD
tool libraries.

Create customized gateway configurations for managing ECAD part data

Overview of configuring Teamcenter Gateway for part library management

The Teamcenter Gateway for part library management enables one or more ECAD part library
applications to connect with the Teamcenter server to manage ECAD part data, customize configuration
files, and also manage the relation between the library objects. ECAD library administrators can populate
libraries, map attributes, modify data, save and check-in check-out ECAD parts, and define access rules
from the gateway’s user interface.

Before configuring Teamcenter Gateway for part library management, ensure that you install
Teamcenter Gateway with library support during the EDA client installation.

Teamcenter provides some OOTB configuration files and templates that you can use to configure
Teamcenter Gateway for EDA. Using these configuration files, ECAD librarians or administrators can:

• Automate the library import and export process.

• Add or update parts.

• Specify scripts in the callback feature to be called for pre- or post- Teamcenter operations.

• Synchronize attribute data with the ECAD tool data.

You can also create your own configuration file for custom ECAD applications and add callbacks.

You must restart the EDA gateway after performing the configurations.

About configuration files and templates used by Teamcenter Gateway

Configuration files define the various properties required by Teamcenter Gateway for EDA library
integration. The configuration file is a readable XML file and can be created and edited using any
ASCII text editor. The client configuration must be a valid XML file that is compliant with the supported
schema. To help the administrators create their own customized configurations, configuration templates
are provided in the EDA installation folder.

Configuration templates are located in the EDA client installation folder and can be used to create new
customized gateway configurations. The templates provide defaults and contain place holders for you
to configure. You can also edit the out-of-the-box configuration template to create a configuration. The
configuration file should be named as application-name_usrdef.xml and should be located in <EDA
client installation>/gateway folder.
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For a basic configuration, the minimum required properties are as follows:

• Family

This is the subdirectory name under the top-level EDA staging directory, for example, expedition.

• Application

The initial part of the file name is application name_usrdef.xml. This name appears in Teamcenter
Gateway for EDA when you choose File→Configuration to select a configuration.

• className

This refers to the Java class defining the model type for this configuration. These model types should
not be modified from the templates.

When you start Teamcenter Gateway for EDA, you can either specify a configuration depending on your
requirement or skip specifying the configuration at that point. If you do not specify the configuration
to be used, a dialog box to select the configuration is displayed later. You can also switch to an
alternate configuration after you start Teamcenter Gateway for EDA by choosing File→Configuration
and selecting another configuration from the displayed list.

You can add your own elements and attributes as long as the EDA client configuration scheme is
followed and the features added can be supported by Teamcenter Gateway for EDA. You can also delete
the configurable elements and attributes that are not required.

Note:

A commented instance of an attribute mapping element example is also shown in the template for
reference purposes. However, Siemens Digital Industries Software recommends that you configure
this element only if you have a good understanding of Business Modeler IDE and EDA client
configuration.

Create a new library gateway configuration file for your ECAD application

You can create the Teamcenter EDA library gateway application configuration file using the application
types available on the Teamcenter server.

1. Create a library configuration file with the name <application type>_edadef.xml. For example,
TcEDA_edadef.xml.

2. Use this application type as the value for the application attribute in <application
type>_edadef.xml.

3. The value for the family attribute can be any name related to the ECAD library integration or it can
be the default application type value.

Create a new library gateway configuration file for your ECAD application
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4. Refer to the %TCEDAECAD_ROOT%\example\docs\SchemaReference.doc file for details about each
XML element and attributes defined in configuration file <application type>_edadef.xml to create
the application configuration file.

<EDAClientDef
        application="mentorEDXLib"
        className="com.Teamcenter.edabase.lib.DefaultLibraryFactory"
        family="mentorEDX">

    <PrimaryDataType datasetType="Epl0EDXPackage"/>

    <LibraryDef
            SyncLibrary="false"
            SyncDatabase="false"
            SyncFile="true"
            Extension="*.edx"
    />

    <CallbackDefs>
        <callback
                operation="exportLibrary"
                type="java"
                
command="com.Teamcenter.eda.mentoredx.connector.MentorEDXLibConnector
:exportLibrary"
        />
        <callback
                operation="importLibrary"
                type="java"
                
command="com.Teamcenter.eda.mentoredx.connector.MentorEDXLibConnector
:importLibrary"
        />
    </CallbackDefs>

    <OperationData operationName="SaveLibraryOperation">
        <Attr name="linkToTCLib" value="true"/>
    </OperationData>

    <EDAGatewayDef/>

</EDAClientDef>

5. Copy this configuration file in %TCEDAECAD_ROOT%\gateway folder. When you launch the
Teamcenter EDA Gateway, this configuration file is displayed in the list of available configurations.
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Specify scripts in the callback feature for pre- or post- Teamcenter operations

You can add a callback feature to your configuration. The callback configuration feature allows you
to specify names of scripts to be called by Teamcenter Gateway for EDA before or after Teamcenter
operations such as save or open. The Teamcenter Gateway for EDA integration framework supports a
limited number of callback operations specially designed for the EDA integration.

The callback starts a custom script, which may be written to perform ECAD tool-specific tasks appropriate
to that process. The name of each callback script and its type are defined in the configuration file.
Whenever a callback is available, the gateway client calls it to prepare for pre- or post-Teamcenter
operations. Each callback is specified by its operation type, command name, and a list of arguments.

For a detailed explanation of these callbacks, refer to the EDA library integration callback summary
in the Callbacks in Teamcenter EDA help on Support Center. This help is also available at
%TCEDAECAD_ROOT%\example\docs\Callbacks.doc in the EDA install folder.

Callback type Argument 1 Argument 2 Argument 3 Argument 4
preLoadLibrary applicationName edaLibXmlFileNa

me
postLoadLibrary applicationName edaLibXmlFileNa

me
statusFileName

preExportLibrary applicationName edaLibFileName
postExportLibrary applicationName edaLibFileName statusFileName
preSyncLibrary applicationName edaLibFileName
postSyncLibrary applicationName edaLibFileName statusFileName
preSaveLibrary applicationName selectedObjectXm

lFileName
edaLibXmlFileNa
me

postSaveLibrary applicationName selectedObjectXm
lFileName

edaLibXmlFileNa
me

statusFileName

preReviseLibrary applicationName selectedObjectXm
lFileName

postReviseLibrary applicationName selectedObjectXm
lFileName

edaLibXmlFileNa
me

statusFileName

preCheckoutLibrary applicationName selectedObjectXm
lFileName

postCheckoutLibrar
y

applicationName selectedObjectXm
lFileName

edaLibXmlFileNa
me

statusFileName

preCheckinLibrary applicationName selectedObjectXm
lFileName

edaLibXmlFileNa
me

postCheckinLibrary applicationName selectedObjectXm
lFileName

edaLibXmlFileNa
me

statusFileName

Specify scripts in the callback feature for pre- or post- Teamcenter operations
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Callback type Argument 1 Argument 2 Argument 3 Argument 4
preCancelCheckoutL
ibrary

applicationName selectedObjectXm
lFileName

postCancelCheckout
Library

applicationName selectedObjectXm
lFileName

edaLibXmlFileNa
me

statusFileName

Create an ECAD library configuration

1. In the EDA Gateway, choose the Teamcenter→Configure menu command.

2. In the Library Integration Configuration dialog box, click the Configuration tab and set the
following values:

• Library Configuration

Specifies the name of the library configuration. To use an existing library configuration, choose a
name from the list. Alternatively, you can type a unique name to create a new configuration. You
can also click Delete to delete an existing configuration.

Note:

You cannot delete the working library.

• Tc Part Library

Select the required Teamcenter part library from the list of library names. These part libraries are
created in the Organization application in Teamcenter. Only those libraries are listed depending
on the ECAD tool being integrated. You cannot enter a new library name.

• Configure ECAD Library

This option is used to manage the ECAD part library metadata that is stored in Teamcenter. You
can use this option for PADS library integration.

Click Browse and ensure that Library Data Source points to the correct library path.

Select the Set Data Source Folder as Read Only check box to make the library read-only and
protect the data on your workstation after synchronization is complete.

Specify the following library data source for your ECAD tools:

ECAD tool name Library data source

PADS %SDD_HOME%\Libraries\amd.pt9

%SDD_HOME%\Libraries\amd.ld9
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ECAD tool name Library data source

%SDD_HOME%\Libraries\amd.pd9

%SDD_HOME%\Libraries\amd.ln9

• Configure Part Metadata Database

This option is used to manage the ECAD part library metadata that is stored in the databases that
can be accessed using ODBC for the Xpedition, Cadence, Orcad, and Altium library integration.

a. Select the Configure Part Metadata Database check box to configure the part metadata
database.

b. Click Configure to configure the data source and a mapping file.

a. (Optional) In the Configure ODBC Connector dialog box, select a data source from the list
installed on your workstation and then browse to a mapping file.

The Configure ODBC Connector dialog box maps elements in the EDA part library to the
table structure in the part metadata database. In this process, an EDALibXML element
(component, symbol, or footprint) is mapped to a table, and an EDA property is mapped to
a column of the table. Only the modified and new parts are synchronized.

If the required mapping is not available, click Create Mapping to create a new ODBC table
mapping, or click Modify Mapping to modify the current ODBC table mapping.

b. (Optional) In the ODBC Table Mapping dialog box, the Teamcenter Library Object tree
shows all available EDA elements. Only components and shapes (that is, footprint, symbol,
and padstack) are valid.

The attributes of the elements are listed in the edalib.xml file in the following format:

<attr value="68p" itemId="900-2000000-006" name="Value"/>

In this example, the displayed attribute name is Value.

A. If the required attribute is not displayed, select the component and click the Add
button  to add an attribute to the selected EDA element.

Teamcenter EDA Gateway displays the Add a property dialog box, allowing you to
define the name of the new attribute.

B. If the required table is not displayed in the Table Definition list, click the Add button
.

Create an ECAD library configuration
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Teamcenter EDA Gateway displays the Add a table dialog box, allowing you to define
the name of the new table.

C. To add properties or columns to the table, select the table and click the Add button
.

Teamcenter EDA Gateway displays the Add a column dialog box, allowing you to
define the name of the new column. The new column is added to the table, but no
new column is added to the physical table.

D. Select a property in the Teamcenter Library Object tree and a column in the Table
Definition tree, and then click Map button to add the table into the Teamcenter
Library Object list.

E. When the list is complete, you can click Save to save the mapping result in a file in a
specified folder.

• Configure File Mode

This option is supported only for EDM library integration.

In the Sync Folder box, type or browse to the location that will create a .edx file during the
synchronization from Teamcenter. Typically, this location is the EDM inbox queue folder for
Xpedition.

3. Click OK to close the dialog boxes and complete the configuration process.

Map ECAD library objects and attributes using ODBC

Overview of mapping library parts and Teamcenter object properties using ODBC

ODBC library integration supports the export of the part library data saved in external databases such
as Oracle, Microsoft Access, or SQL in the Teamcenter database by using ODBC mapping. As an ECAD
library user, you can map the library part attributes with the Teamcenter object properties using ODBC
mapping if your ECAD tool supports ODBC databases.

For mappings using the ODBC connector, the primary key must be configured for the database so that
the existing database entries are updated instead of inserting a new database entry.

Note:

ODBC mapping is not supported for PADS and EDM library integrations.

As an ECAD library administrator you can map the ECAD library parts and part attributes stored in a
single table or in a multiple table database with the corresponding Teamcenter property.
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Use ODBC to map ECAD part attributes with Teamcenter properties

To map ECAD library part attributes with the Teamcenter object properties using ODBC mapping:

1. In EDA Gateway, choose the Teamcenter→Configure menu command.

2. In the Library Integration Configuration dialog box, select the Configure Part Metadata
Database option.

3. Click Configure to configure the data source and a mapping file.

Use ODBC to map ECAD part attributes with Teamcenter properties
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4. In the Configure ODBC Connector dialog box,

• Select the data source from the list of all the data source names installed on your workstation.

• Add your custom data sources to this list from Windows by choosing Start→Control
Panel→Administrative Tools→Data Sources.

• Add and configure your data source from the ODBC Data Source Administrator dialog box.

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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5. You can map elements in the EDA part library to the table structure in the part metadata database
from the Configure ODBC Connector dialog box. In the mapping process, an EDALibXML element
(component, symbol, or footprint) is mapped to a table and an EDA property to a column of the
table.

Browse to an existing mapping file and click Modify Mapping to modify the current ODBC table
mapping. If the required mapping is not available, click Create Mapping to create a new ODBC
table mapping.

Use ODBC to map ECAD part attributes with Teamcenter properties
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6. Add new EDA objects

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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In the ODBC Table Mapping dialog box, the Teamcenter Library Object tree shows all the
available EDA objects and its properties.

To add new object, for example Simulation:

a. Select EDA objects and click the Add button .

Teamcenter displays the Create Teamcenter Object dialog box.

b. Specify the Name and Type of the new EDA object.

c. Click OK.

7. Add additional properties

a. Select the Properties node and click the Add  button.

b. Specify a new property in the Add Property dialog box.

Use ODBC to map ECAD part attributes with Teamcenter properties
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A new property Value is added under the Properties list.
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c. Click Save.

Note:

Apart from the default Teamcenter properties, that is, itemId and name, if you add any other
additional Teamcenter properties to map with the ECAD part attributes in the ODBC Table
Mapping dialog box, you must include these new Teamcenter properties in your attribute
mapping file. For example, in the attribute mapping file, we must add the new Teamcenter
property, Value, for the configuration to work.

Use ODBC to map ECAD part attributes with Teamcenter properties

Xpedition and PADS Integration With Teamcenter, Teamcenter 2412  5-49
© 2025 Siemens



{ Item type="EDAComPart"
    MANUFACTURER : ItemRevision.ICS(-5488) /
description="MANUFACTURER"
    DESCRIPTION : Item.GRM(IMAN_master_form).object_desc /
description="DESCRIPTION"
    PACK_TYPE : ItemRevision.ICS(-5487) /description="PACK_TYPE"
    ROHS : ItemRevision.ICS(-4952) /description="ROHS"
    Cost : Item.GRM(IMAN_master_form).object_desc /
description="Cost"
    Value : Item.GRM(IMAN_master_form).object_desc /description="Value"
    ECADVersion : 
ItemRevision.GRM(Epl0HasAttrForm,Epl0AttrForm).epl0ecad_version /
description="ECADVersion"
    ECADModified : 
ItemRevision.GRM(Epl0HasAttrForm,Epl0AttrForm).epl0ecad_lmd /
description="ECADModified"
}

8. Map ECAD part attributes with Teamcenter properties

a. Select a property in the Teamcenter Library Object tree and a column in the Table Definition
tree, and then click Map >> to add the table into the Teamcenter Library Object list.

Note:

The name attribute is mandatory and some ECAD applications do not have a
corresponding attribute. In such a case, you can map the name attribute to the same
ECAD attribute that you used to map the item ID.
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b. If your database is stored in multiple tables within a database file, you can map a specific
column from all tables to the selected property in Teamcenter in a single step.

For example, in a multiple table database, each table represents a component type, for
example, CAPCACITOR, IC, and RESITOR. The database can also have a table that contains
mixed components types. In such a table, the component type is specified in the column
category.

Use ODBC to map ECAD part attributes with Teamcenter properties
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c. In a multiple table database, you can map a property in the Teamcenter Library Object tree
with all matching columns from all the tables in the Table Definition tree in a single step.

To do this, select a property in the Teamcenter Library Object tree and a column in the Table
Definition tree and click Map >>.

d. Click Yes to continue to map the selected property for all matching columns from all the
tables in the database. If not, click No.

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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e. The Teamcenter EDA property is matched with all the matching columns from the multiple
component tables.

Use ODBC to map ECAD part attributes with Teamcenter properties
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9. Classify the ECAD component type with the respective Teamcenter EDA object property
(category):

The table name that represents the ECAD component name, for example, Capacitor, can be
directly mapped as the Teamcenter EDA component property for classifying the ECAD components
in Teamcenter. You can map all table names in the Table Definition list at a time.

a. Select the table name (for example, Capacitor) in the Tables Definition list with the
corresponding property category in the Teamcenter Library Object list.

5. Integrating Xpedition or PADS or EDM with Teamcenter EDA for part library management
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b. Click Map >> to classify the ECAD component types.

c. For the part data stored in multiple tables and each table name representing a component's
category, click Yes to map all the table names with the Teamcenter EDA component property
at a time. Click No to continue mapping the selected table only.

d. In scenarios where the database table does not represent a specific component type, but a list
of different components whose type is defined in a column of that table, you may want to
change the component mapping to a column in that table instead of the table name.

To do this, select the Teamcenter EDA component property and select a column of the table
in the Table Definition list and click Map >>.

Example:

For example, a Miscellaneous table may contain different part types, where the part
type is defined in the column category within that table. You can change the mapping
of the Category property in the Teamcenter Library Object list with the previously

Use ODBC to map ECAD part attributes with Teamcenter properties
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mapped table name, that is, Miscellaneous in the Tables Definition list to a column,
category, within the Miscellaneous table.

The category mapping is now applied to the selected column for that table only.

10. When the list is complete, click Save to save the mapping result in a file in a specified folder.

11. Click OK to close the dialog boxes and complete the configuration process.

Note:

If you reclassify any ECAD part in Teamcenter as another ECAD part type (for example, if
a previously classified capacitor part is reclassified as a resistor in Teamcenter), during the
synchronization of parts from Teamcenter to the ODBC database, the part is copied to the new
table. However, because all columns of both the tables may or may not be the same, the part
is also retained in the previous table with _MOVED_TO_<new table name> suffix added to the
original part name for reference purposes.

For example, a capacitor part cap_1234 is now reclassified as a resistor part in Teamcenter. During
the synchronization process, the part cap_1234 is added to the Resistor table. The same part in
the Capacitor table is not removed but is renamed as cap_1234_MOVED_TO_Resistor.

Set the working library

The ECAD part designer can be configured to maintain one or more ECAD libraries in the same
workstation. You can switch between ECAD libraries and the current selection is referred to as the
working library.

All EDA library operations use the working library. For example, during synchronization EDA will look for
modified library objects only in the working library.

1. In Teamcenter Gateway for EDA, choose Teamcenter→Set Working Library.

The Set Working Library dialog box appears.

2. Select the working library and click OK.

The EDA library integration traverses the library and collects the object list (parts, symbols,
footprints, and padstacks).

Set up EDA part library synchronization with Teamcenter

The EDA part library is synchronized with Teamcenter by running the eda_sync.bat command. Perform
the following steps to select, edit, and run the script corresponding to your ECAD system.
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1. Create a Teamcenter proxy user account that will be used to perform the library integration sync
operations.

2. In the TcEDAClient.Properties file, set the User value to match the Teamcenter proxy user ID.

3. Generate a file to hold the Teamcenter proxy user password, using the following command:

Example: eda_password_file.bat -p <proxy user psw> -pf
C:\Siemens\EDASecure\file.txt

4. Select the script corresponding to your ECAD system from the following list. The selected script is
invoked in the task scheduler to synchronize the library periodically.

Use start_syncMentorExpLibrary to synchronize the Xpedition library.

Use start_syncMentorEDXLibrary to synchronize the Xpedition EDM library.

This script takes an optional argument such as - syncFolder <folder>. This argument
specifies a folder where the EDX file will be created. This argument overrides the syncFolder
defined in the library configuration. This command creates an EDX file with the name
eda_sync_yyyyMMdd_HHmmss.edx where yyyyMMdd_HHmmss refers to the current date
and time. This file must then be manually imported into the Xpedition EDM library, unless the
syncFolder has been set up as an EDM inbox queue.

Use start_syncMentorPADSLibrary to synchronize the PADS library.

5. Edit the script that corresponds to your ECAD system as follows:

Example:

eda_sync.bat -syncLibrary -application mentorEDXLib –syncConfig “EDM
Library” –pf D:\EDASecure\file.txt

Where:

-pf specifies the file holding encrypted Teamcenter password.

-syncConfig specifies the synchronization configuration name.

Example:

edacli.bat -syncLibrary -application seexpLib -mode 0
-workingLibraryName X -edaLib X -status statusFile -pf passwordFile

Where:

-pf passwordFile specifies the file holding encrypted Teamcenter password.

Set up EDA part library synchronization with Teamcenter
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6. In a task scheduler, create an entry that invokes the sync script edited in the previous step at the
desired time and frequency.

Enable acistoprt translator

After you install and configure Dispatcher as per the deployment strategy, you must enable the acistoprt
translator required for translation of 3D models into NX parts.

You can use TEM to install the translator or manually edit the translator.xml file to enable the translator.
For instructions on how to enable the acistoprt translator using TEM, see the Dispatcher ─ Deployment
and Administration help on Support Center.

The following is an example of how to edit the translator.xml file to enable the translator.

Prerequisites: Verify that the TransExecutable dir is correctly specified for this translator.

1. Open the translator.xml file from the Dispatcher_RootModule\conf directory.

2. Set the isactive attribute to true to activate this translator.

Note:

By default, this attribute is set to false.

3. Open the translator.bat (Windows) from the
Dispatcher_Root\Module\Translators\translator_name directory and edit the CHANGE_ME tags.

For more information about CHANGE_ME tags, see the .bat file for the translator.

4. Run the translator in standalone mode from the command prompt to verify whether it is working
properly.

For more information about running the translator in standalone mode, from a command
prompt, change to the Dispatcher\Translators\translator_name directory and run the appropriate
command for your platform:

Note:

For more information, see the Readme file in the Translators\translator_name directory.

Windows: translator_name.bat -help

5. (Optional) To set up Dispatcher-client-proxy-user as the owner of the translated files, make the
following change to the translator_name.bat (Windows) file.

NxTransDirect translator example:
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"%UGII_BASE_DIR%\ugmanager\run_nxtrans.bat" -u=Dispatcher-client-proxy-user 
-p=password 
-changeOwnerToCad=false "-pim=yes" %*

If you set up Dispatcher-client-proxy-user as the owner of the translated files, you must create a
dispatcher client access rule. For more information on how to create a dispatcher client access rule,
see the Dispatcher ─ Deployment and Administration help.

After installation, you must add a rule to the access rule tree permitting the translation service
proxy user to update attributes of a DispatcherRequest object. If this access rule is not created
correctly, the dispatcher client reports errors.

Set up automatic synchronization of EDM part library with Teamcenter

The EDM part library is synchronized with Teamcenter by running the EDM_sync.bat command.
Configure the script file corresponding to your EDM system and the script will then run periodically
as configured.

For 3D models to be exported from EDM to Teamcenter, EDA gateway must be installed on the EDM
server running on windows. If the EDM server is on a Linux machine, the outbox queue must be
configured on a Windows machine and the EDA gateway must be installed on the same machine.

1. Edit the following values in the EDM_sync.bat script file located at %TCEDAECAD_ROOT%
\MentorEDXLibCon\wnti\bin.

• USERNAME: Specify the username to login to Teamcenter.

• PWDFILE: Specify the path of the file holding encrypted Teamcenter password.

• WORKINGLIBNAME: Specify the working library name from the EDA Client library configuration.

2. EDM_sync.bat must be manually invoked once. Later, it will continue to poll the EDM outbox
queue folder for any newly generated .edx files.

Once the script starts, the <filename>.edx file is generated in the syncFolder specified in the
WORKINGLIBNAME argument in the script file and is automatically added or updated in Teamcenter.

The <filename>.RESULT file is created in the syncFolder which provides the status of the sync
operation. A <filename>.log file is created that lists the components that fail to get exported to
Teamcenter.

During the translation of 3D models from EDM to Teamcenter, the .sab file can be removed from the
dataset after adding the translated the .prt file only if the user performing the translation has write
access on the dataset.

Set up automatic synchronization of EDM part library with Teamcenter
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ECAD tool customizations for part library management

Overview of ECAD tool customizations required for part library management

After the configurations required to set up part library management on the EDA client are complete you
must further configure and customize your ECAD tool connector as per your requirement.

• Setting up PADS Library integration

• Setting up Xpedition Library integration

• Setting up EDX Library integration

Setting up PADS Library integration

To set up PADS Library integration

1. Open a console window and enter the command eda_gateway.

2. On the Configuration dialog box, select mentorPadsLib.

To modify the default properties

Various properties to control the execution of the library tool may be set in file %TEMP%
\eda\mentorPadsLibCon.ini. This file is created the first time when the integration is run and a
configuration is created.

• LogFile

The path and file specification for a log file where the integrations specific logging information is
written. This, along with the common-client EDA log file, is required for debugging purposes in case of
issues. The default is %TEMP%\eda\mentorPadsLibCon.log.

• LogLevel

The minimum logging level for information to write to the above log file. Options in the decreasing
order are:

• ERROR

• WARN

• INFO

• DEBUG
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The default level selected is INFO.

• PadsApplication

Defines the PADS application to open for connection. Options are:

• PowerLayout

• PowerLogic

The default value is PowerLayout.

• PadsVisible

Defines the visibility of the PADS application when opened. Options are:

• True

• False

The default value is True.

Setting up Xpedition Library integration

To set up Xpedition Library integration

1. Open a console window and enter the command eda_gateway.

2. On the Configuration dialog box, select mentorExpLib.

To modify the default properties

Various properties to control the execution of the library tool may be set in file %TEMP%
\eda\mentorExpLibCon.ini. This file is created the first time when the integration is run and a
configuration is created.

• LogFile

The path and file specification for a log file where the integrations specific logging information is
written. This, along with the common-client EDA log file, is required for debugging purposes in case of
issues. The default is %TEMP%\eda\mentorExpLibCon.log.

• LogLevel

Setting up Xpedition Library integration
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The minimum logging level for information to write to the above log file. Options in the decreasing
order are:

• ERROR

• WARN

• INFO

• DEBUG

The default level selected is INFO.

• attrsmap

This is used to define the multiple attribute/value format in the edalib.xml file while updating the
Xpedition part attribute.

The connector will parse into two pairs, for example, <attributename, attributeValue> and then use
these to update the part information.

For example, the default is Value,VALUE;Value2,VALUE2.

Setting up EDX Library integration

To Install the EDX trusted certificate into the Mentor keystore

The Teamcenter EDA and EDX integration provides a trusted certificate that must be added to the
keystore used by your ECAD tool. This is used while synchronizing components back from Teamcenter
into the EDX Librarian. The certificate is available in the %TCEDAECAD_ROOT%\certificate.pem folder.

To install the certificate into the Mentor keystore, execute the following command from a console:

%KEYTOOL_PATH%\keytool -import -alias TeamcenterEDA20 -file %TCEDAECAD_ROOT%
\certificate.pem -keystore %MENTOR_KEYSTORE% -validity 3650

where,

• KEYTOOL_PATH is the location of the keytool program in the ECAD tool installation.

For example, C:\MentorGraphics\EEVX.1.2\EEVX.1.2\SDD_HOME\common\win64\jre\default\bin

• TCEDAECAD_ROOT is the eda installation folder. This environment variable is set during installation.

• MENTOR_KEYSTORE is keystore folder used by your ECAD tools.
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For example, C:\MentorGraphics\EEVX.1.2\EEVX.1.2\SDD_HOME\common\win64\jre\default\lib\sec

• The -validity 3650 tells the tool that the key should be valid or 3650 days (10 years). The keytool
command will prompt for a password to the Mentor keystore, you must enter it when prompted. You
will also be prompted to trust this certificate, answer "y"

To set up EDX Library integration

To use the EDX Library integration,

1. Open a console window and enter the command eda_gateway.

2. On the Configuration dialog box, select mentorEDXLib.

Ensure that you have permission to create a file in the %TCEDAECAD_ROOT% folder. A file named
API.properties must be created there by EDA

Setting up EDX Library integration
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6. Upgrading to a newer version of
Teamcenter EDA
Taskflow to upgrade to a newer version of Teamcenter EDA

You can upgrade the Teamcenter EDA client installations on the ECAD workstations to a new version
of the client. For successful upgrade of the EDA client you may be required to perform updates on
the Teamcenter server as well. Siemens Digital Industries Software recommends that you first perform
the upgrade on a test system to verify the parameter values required for the installation on ECAD
workstations.

Taskflow to upgrade to newer version of Teamcenter EDA:

Tasks to be performed on the Teamcenter
server Tasks to be performed on the EDA client

Update Teamcenter server
to a compatible version Perform the pre-upgrade steps

Configure Teamcenter server for design
management or part library management Upgrade the EDA client to a newer version

Delete the cache and staging directories

Upgrade Teamcenter server

Verify whether the current Teamcenter server installation is compatible with the latest version of the
EDA client.

If you do not have compatible Teamcenter server version, you must upgrade the Teamcenter server to
a version compatible with the new EDA client version. For information on how to perform Teamcenter
upgrade, refer to the Teamcenter Upgrade Using TEM documentation.

If you want to install a patch on the existing installation using TEM, refer to the how to install patches on
a Teamcenter server topic in Teamcenter Upgrade Using TEM documentation.

If you want to install a patch on the existing installation using Deployment Center, refer to the how to
Upgrade or patch your environment topic in Deployment Center documentation.

You must also perform additional configurations on the Teamcenter server for the integration with the
EDA client to work properly for design management or part library management.

Xpedition and PADS Integration With Teamcenter, Teamcenter 2412  6-1
© 2025 Siemens



Configure Teamcenter for design management

Overview of configurations required for design management

You must perform the following server side configurations for the integrations to work properly for
design management.

Configuration Why is it required?

Modify the style sheet to include EDA derived
data relation in Active Workspace

To allow EDA derived datasets to be displayed as
item revision attachments in Active Workspace,
the Awp0ItemRevisionSummary style sheet
must be modified.

Add EDA relations and EDA objects in Active
Workspace Relation Browser

For Relation Browser to traverse EDA relations
and show EDA objects in Active Workspace,
EDA information must be included in the Active
Workspace Relation Browser configuration.

Modify the style sheet to include EDA derived data relation in Active
Workspace

The commercial-off-the-shelf (COTS) value of the EDA preferences used by Active Workspace to display
the EDA item revision types is defined in the Awp0ItemRevSummary style sheet.

To allow EDA derived datasets to be displayed as ItemRevision attachments in Active Workspace, you
must modify the Awp0ItemRevSummary style sheet on the Teamcenter server.

1. Log on to Teamcenter and start the rich client.

2. In the navigation pane, click My Teamcenter.

a. Search for the Awp0ItemRevSummary dataset.

b. Double-click the dataset.

The dataset is automatically checked out and the xml file is launched with the dataset.

3. In the Awp0ItemRevSummary style sheet, modify the XRT_files page by appending the
EDAHasDerivedDataset relation to the attachments page objectSet source attribute value as
follows. The modified line is marked with a plus (+) sign on the left most column.

   
           <page titleKey="attachments">
               <section titleKey="tc_xrt_Files">
                    <objectSet 
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source="IMAN_specification.Dataset,IMAN_reference.Dataset,
                    
IMAN_manifestation.Dataset,IMAN_Rendering.Dataset,TC_Attaches.Dataset
,
                    
IMAN_UG_altrep.Dataset,IMAN_UG_scenario.Dataset,IMAN_Simulation.Datas
et,
                    EDAHasDerivedDataset.Dataset" 
defaultdisplay="listDisplay"
                    sortby="object_string" 
sortdirection="ascending"><tableDisplay>
                           <property name="object_string"/>
                           <property name="object_type"/>
           

Add EDA relations and EDA objects in Active Workspace Relation Browser

To traverse EDA relations and show EDA objects from the Relations tab in Active Workspace, EDA
information must be included in the Relation Browser configuration. To do this, you must update the
RelationBrowserConf dataset in the RB_UIConfigure.xml file in the Teamcenter server configuration.

To enable the Relations tab to show relations between Teamcenter objects and objects in a remote
application, do the following:

1. In the Teamcenter rich client, search for the dataset RelationB*.

2. Right-click the RelationBrowserConf dataset and choose Check-InOut > Check-Out.

3. Right-click RelationBrowserConf dataset and choose Named References.

4. In the Named References dialog box, select RB_UIConfigure.xml and click Download.

5. Modify the RelationBrowserConf dataset in the locally downloaded RB_UIConfigure.xml file to
add EDA relations and EDA objects as follows.

=====================================================================
==
            Filename: RB_UIConfigure.xml
       
            File used to configure control panel of relation browser.
=====================================================================
==

 -->
        <RelationBrowser>

Add EDA relations and EDA objects in Active Workspace Relation Browser

Xpedition and PADS Integration With Teamcenter, Teamcenter 2412  6-3
© 2025 Siemens



          <OptionPanel>
            <view name="General">
              <ruleName>GenericRule</ruleName>
              <defaultLayout>IncrementalHierarchic</defaultLayout>
              <group name="relations">
                   
                <filter name="EDA" parameterSet="EDARelations" 
color="(204,51,0)"/>
              </group>
              <group name="objects">
                   
               <filter name="EDA" parameterSet="EDAObjects" 
color="(204,51,0)"/>
               <filter name="Other" parameterSet="WorkspaceObject" 
color="(238,236,225)"/>
              </group>
            </view>
            <view name="System"> 
                 
               <parameterSet name="EDAObjects">
                  <clipsfacts>
                    <fact>EDACCABase</fact>
                    <fact>EDACCABaseRevision</fact>
                    <fact>EDASchem</fact>
                    <fact>EDASchem Revision</fact>
                  </clipsfacts>
               </parameterSet>
                 <parameterSet name="EDARelations">
                   <clipsfacts>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasDerivedDataset,targetDirection=forward,inputTypes=ItemRevision
</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasDerivedItem,targetDirection=forward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasPWB,targetDirection=forward,inputTypes=ItemRevision</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSchematic,targetDirection=forward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSchematic,targetDirection=backward,inputTypes=ItemRevision</
fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasSublayout,targetDirection=forward,inputTypes=Dataset,outputTyp
es=Dataset</fact>
                     <fact>source=GRM,key=EDA,relationType-
=EDAHasVariant,targetDirection=forward,inputTypes=ItemRevision</fact>
                     </clipsfacts>                     </
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parameterSet> 
                 
            </view>
        </RelationBrowser>

6. Delete the original RB_UIConfigure.xml file from the Named References dialog box and import
the new RB_UIConfigure.xml file in Teamcenter.

7. Click Close.

8. Check in the RelationBrowserConf dataset.

Configure Teamcenter for part library management

Overview of configurations required for part library management

ECAD users should be able to synchronize and reuse ECAD library parts with multiple external sites.
You can create a query in the Query Builder application to support synchronization of ECAD library parts
with multiple external sites.

Synchronize ECAD library parts with multiple external sites

To enable ECAD users synchronize and reuse their part data across multiple external sites, you create a
query in the Query Builder application to support this synchronization. Consider an example where you
want to synchronize a part that is already synchronized with SiteB to a different site, SiteA.

1. Create a new query __EDALIB_find_parts_sync_multiple_sites_<site name> in the Query Builder
application using an existing query __EDALIB_find_parts_sync_multiple_sites where <site name>
is the name of the site to which you want to synchronize the parts.

In our example, this is __EDALIB_find_parts_sync_multiple_sites_SiteA, where SiteA is the site to
which you want to synchronize the parts.

Overview of configurations required for part library management
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2. Specify the site name (SiteB) in the query to which the part is already synchronized.

Criteria for creating the query:

• The query must search for parts that are not yet synchronized to any site (new parts) AND the
parts that are synchronized to a site (SiteB).

• The above condition to search new parts and existing parts for a site (SiteB) is separated by the
OR function.

• In each condition, the object type EDAComPart is specified with a different User Entry L10NKey
(ObjectType1) and User Entry Name (ObjectType2) name.

3. Save the query. By default, the type of the query is Local Query.

4. To change the above query to a User Query, from the Teamcenter command prompt, run the
following command:

%TC_BIN% \tc_set_query_where_run –u=Tc-admin-user –p=password –g=group
-query=__EDALIB_find_parts_sync_multiple_sites_SiteA" –run=query

6. Upgrading to a newer version of Teamcenter EDA
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5. Set the value of the preference EDALIB_Sync_FindNewParts with the new query name
(__EDALIB_find_parts_sync_multiple_sites_<site name>).

You can also specify this query name in the integration-specific preference. For
example, in the Xpedition EDX integration, the value can be set to the preference
EDALIB_Sync_FindNewParts_mentorEDX.

To modify a query in the Query Builder application, you must first change the query type to Local Query.
To do this, from the Teamcenter command prompt, run the following command:

%TC_BIN% \tc_set_query_where_run –u=Tc-admin-user –p=password –g=group
-query=__EDALIB_find_parts_sync_multiple_sites_SiteA" –run=iman

After making the required changes to the query, run the command specified in the Step 4 to change it to
User Query again.

Steps to perform before you upgrade the EDA client

Before upgrading the EDA client on your ECAD workstation:

• Download the Teamcenter software kit on your ECAD workstation to perform the upgrade of the EDA
client.

• Make note of the current EDA application directory. You may require it after the upgrade.

• During the patch install, the existing contents of the installation are zipped to the
<root>\install\install\patches\backup\<date>.zip file. After installation, you must extract the
TCEDAClient.properties file from this zip folder and copy it back to the <root>\eda to apply the
existing configurations after the update.

• Verify that the ECAD designers check in all ECAD designs.

Warning:

Failure to check in designs may result in loss of data.

• Ensure that the ECAD designers purge working files from their staging locations and back up design
files to a location where they can be accessed after the upgrade.

• Delete the cache and staging directories after taking backup.

• Close all the EDA client sessions and confirm that all users are logged off.

Before you upgrade the EDA client, you must collect Teamcenter server details required during the
upgrade process.

Steps to perform before you upgrade the EDA client
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Collect Teamcenter server details required during the EDA client
upgrade

Before you begin the upgrade, you must get the correct product distribution image as well as obtain the
following information from your Teamcenter installation administrator:

• The configuration ID.

The configuration ID identifies your Teamcenter configuration when you maintain, upgrade, uninstall,
or add features to the configuration. Installation log files are also named based on this ID.

• The application root directory.

• The FMS client cache (FCC). If one exists, use the existing FCC or use a new one.

• The FCC parent information for the EDA client. The minimum information required is the host name
and port.

• The four-tier and middle-tier Web application server URI and connection name for the EDA client.

• The EDA client staging location.

• The logon URL and the application ID in order to enable Teamcenter Security Services.

• The host name, port, and license server mode of the Siemens Digital Industries Software common
license server.

Upgrade to a newer version of the EDA client

You can upgrade the EDA client installations on the ECAD workstations to a new version of the client
using the Teamcenter software kit. Siemens Digital Industries Software recommends that you first
perform the upgrade on a test system to verify the parameter values required for the installation on
ECAD workstations.

Once you have completed the pre-upgrade steps and have all the Teamcenter server details required
for the upgrade, perform the following steps to begin the upgrade process:

Teamcenter EDA updates (major or minor releases and patches) are posted for download on Support
Center when available:

https://support.sw.siemens.com

For major or minor release upgrade:

1. Extract the Teamcenter software distribution image to a temporary location.

6. Upgrading to a newer version of Teamcenter EDA
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2. Verify that the JRE_HOME environment variable specifies the required Java Runtime Environment
(JRE) on the ECAD workstation.

3. Start TEM.

a. Browse to the root directory of the extracted Teamcenter software distribution image.

b. Right-click the tem.bat program icon and choose Run as administrator.

TEM launches and displays the Installer Language panel.

c. In the Installer Language panel, select a language and click OK.

TEM displays the Welcome to Teamcenter EDA panel.

Your language selection applies only to the TEM session and not the Teamcenter EDA
installation.

4. In the Welcome to Teamcenter EDA panel, click Upgrade.

Click Upgrade to upgrade Teamcenter EDA.

5. In the Old Application Root panel, verify that you are upgrading the correct Teamcenter EDA
installation.

Click Next.

6. In the Configuration panel, type the configuration ID and the description for the new Teamcenter
EDA configuration.

7. The New Application Root panel shows a list of features in your current EDA installation and the
status of each feature as follows:

a. Upgrade implies that the feature will be upgraded.

b. Deprecated implies that the feature will not be upgraded.

In the New Application Root Directory box, type the location where you want to upgrade your
Teamcenter EDA and click Next.

8. In the File Client Cache (FCC) panel, select one of the following options:

a. Use current FCC

Select this option if you want to reuse the existing FCC.

Upgrade to a newer version of the EDA client
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b. Use new FCC

Select this option if you want to use a new FCC.

Click Next.

9. In the FCC Parents panel, specify the settings for the parent FMS server caches (FSC) that are used
by the FMS client cache (FCC) and click Next.

The FSCs are used in the priority that you specify.

10. In the 4-tier Server Configurations panel, type the address for the SOA service running on the EDA
Web server in the SOA URL box. For example:

http://host:port/tc

Replace host with the server name and port with the server port and click Next.

11. In the EDA Client panel, verify the staging location and SSO settings.

The staging location and SSO settings may change during the upgrade. If the staging location
changes, you have to perform additional configurations following the upgrade.

Click Next.

12. In the Flex License Client panel, specify the license settings.

Click Next.

13. In the Confirmation panel, review your selections.

If you need to make a change, click Back.

When you are ready to upgrade, click Start.

The Upgrade Features panel displays the status of the upgrade.

14. If the installation is unsuccessful, review the upgrade log and take corrective action.

If the installation is successful, and if you have changed the staging location during upgrade,
perform the additional upgrade steps on each ECAD workstation where the EDA application is
upgraded.

6. Upgrading to a newer version of Teamcenter EDA
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For patch install:

If the patch you downloaded has a corresponding installer patch file (patch-id_install.zip), download
this installer patch and update Teamcenter Environment Manager (TEM) to the latest version using the
following steps.

1. Extract the patch-id_install.zip file to your install directory under TC_ROOT (the existing EDA
installation install folder that contains the tem.bat file), to overwrite existing files.

2. Extract the patch-id_win64.zip file to a temporary folder.

3. Run the tem.bat from the existing EDA installation folder using the updated tem.bat from step 1.

4. Select Updates Manager and click Next.

5. Enter the Update kit location using the temporary folder location from step 2.

6. Click Next and continue through the update process.

Delete the cache and staging directory

Inspect the USERPROFILE\Teamcenter\EDA directory of each ECAD user of upgraded ECAD workstation.
If this directory exists and contains a TCEDAClient.properties file, perform the following actions:

Note:

If the directory does not exist, or the TCEDAClient.properties file does not exist, you can skip the
following steps.

• Delete the cache directory of each ECAD designer on the ECAD workstation.

The default location of the cache directory is %USERPROFILE%
\Teamcenter\EDA\<TC_SERVER_SITE_ID>.

• Delete the staging directory of each ECAD designer on the ECAD workstation.

To find the location of the staging directory, look for the value of the StagingDir property in the
USERPROFILE\Teamcenter\EDA\TCEDAClient.properties file.

If the TCEDAClient.properties file does not exist, or the property is not specified, or the value of the
property is empty, skip this step.

• Delete the TCEDAClient.properties file of each ECAD designer on the ECAD workstation.

The TCEDAClient.properties files of the ECAD designers are located in the
USERPROFILE\Teamcenter\EDA directories.

Delete the cache and staging directory
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7. Uninstall the EDA client from the ECAD
workstation
1. Start TEM.

You can start TEM in Windows by clicking Start→Programs→EDA installation
name→Environment Manager.

2. In the Maintenance panel, select the Configuration Manager option.

Click Next.

3. In the Configuration Manager panel, select Remove Configuration (uninstall).

Click Next.

4. In the Configuration Display panel, verify the configuration to uninstall.

Click Next.

5. In the Complete Uninstall panel, select Remove all files including user files option.

Click Next.

6. In the Warning panel, select the I want to permanently remove these items option.

Click OK.

7. In the Confirmation panel, click Start.

Teamcenter EDA uninstalls the EDA application.

Note:

If necessary, manually remove the customization files that were copied into the ECAD tool folders
during installation and restore any files that were deleted.
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7. Uninstall the EDA client from the ECAD workstation
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8. Deploying Teamcenter EDA
documentation on your local drive or
network
You can deploy the Teamcenter EDA documentation on your local drive or network. See the Siemens
Help Server documentation for instructions to deploy the documentation on your local drive or
network.
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